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1 Infroduction

Thank you for choosing the QlAgility. We are confident it will become an integral part of your laboratory.

Before using the QlAgility, it is essential that you read this user manual carefully and pay particular attention to the safety
information. The instructions and safety information in the user manual must be followed to ensure safe operation of the instrument

and to maintain the instrument in a safe condition.
1.1 About this user manual

This user manual provides information about the QIAgility in the following sections:

Introduction

Safety Information

General Description

Installation Procedures

QlAgility Software

Operating Procedures
Instrument Setup and Calibration
Maintenance Procedures
Troubleshooting Guide
Technical Specifications

Appendices

Document Revision History

The appendices contain the following information:

e Appendix A

O ABI 7000/7500 SDS master mix naming conventions
O Advanced settings

O Description of the Generic XML Format

O Packing the QlAgility

e Appendix B

Declaration of Conformity

FCC declaration

O
O Waste Electrical and Electronic Equipment (WEEE)
O
O Liability clause

e Appendix C — Ordering Information
e Appendix D — Consignes de sécurité

Appendix E - Sicherheitshinweise
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Terms used in this manual

The following terms for controlling the mouse are used in this manual.

Leftclick Click with the left mouse button.

Right-click Click with the right mouse button.

Double-click Click twice with the left mouse button.

Select “XXX/xxx" In the toolbar, select the xxx submenu from the XXX menu. Examples are File/Exit and Options/New.

1.2 General information
1.2.1  Technical assistance
At QIAGEN®, we pride ourselves on the quality and availability of our technical support. Our Technical Service Departments are
staffed by experienced scientists with extensive practical and theoretical expertise in sample and assay technologies and the use
of QIAGEN products. If you have any questions or experience any difficulties regarding the QlAgility or QIAGEN products in
general, please do not hesitate to contact us.
QIAGEN customers are a major source of information regarding advanced or specialized uses of our products. This information
is helpful to other scientists as well as to the researchers at QIAGEN. We therefore encourage you to contact us if you have any
suggestions about product performance or new applications and techniques.
QIAGEN customers are a major source of information regarding advanced or specialized uses of our products. This information
is helpful to other scientists as well as to the researchers at QIAGEN. We therefore encourage you to contact us if you have any

suggestions about product performance or new applications and techniques.

For technical assistance and more information, please see our Technical Support Center at www.qiagen.com/TechSupportCenter

or call one of the QIAGEN Technical Service Departments or local distributors (see back cover or visit www.qiagen.com).
1.2.2  Policy statement

It is the policy of QIAGEN to improve products as new techniques and components become available. QIAGEN reserves the
right to change specifications at any time. In an effort to produce useful and appropriate documentation, we appreciate your
comments on this user manual. Please contact QIAGEN Technical Services.

1.2.3 Version management

This document is the QIAgility User Manual, version 4.18.
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1.3 Intended use of the QlAgility

The QlAgility is designed to perform automated PCR setup and liquid handling actions in molecular biology applications.

If used in combination with QIAGEN kits indicated for use with the QlAgility, the instrument is intended for the applications
described in the respective QIAGEN kit handbooks.

If the QlAgility is used with other than QIAGEN kits, it is the user’s responsibility to validate the performance of the product

combination for any particular application.

The QlAgility is intended for use by professional users trained in molecular biological techniques and the operation of the
QlAgility.

1.3.1 Requirements for QlAgility users

This table covers the general level of competence and training necessary for transportation, installation, use, maintenance, and
servicing of the QlAgility.

Task Personnel Training and experience
Delivery No special requirements No special requirements
Installation Laboratory technicians or equivalent Appropriately frained and experienced personnel familiar
with use of computers and automation in general
Routine use (running methods) Laboratory technicians Appropriately trained and experienced personnel familiar
or equivalent with use of computers and automation in general
Servicing and annual preventive QIAGEN Field Service Specialists only Regularly trained, certified, and authorized by QIAGEN

maintenance
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2 Safety Information

Before using the QlAgility, it is essential that you read this user manual carefully and pay particular attention to the safety
information. The instructions and safety information in the user manual must be followed to ensure safe operation of the instrument

and to maintain the instrument in a safe condition.

Note: Translations of the Safety Information are available in French in Appendix D - and German in Appendix E -

Sicherheitshinweise.

The following types of safety information appear throughout this manual.

WARNING The term WARNING is used to inform you about situations that could result in personal injury to you or
others.
A Details about these circumstances are given in a box like this one.
CAUTION The term CAUTION is used to inform you about situations that could result in damage to the TissueRuptor
Il or other equipment.
A Details about these circumstances are given in a box like this one.

The advice given in this manual is infended to supplement, not supersede, the normal safety requirements prevailing in the user’s

country.

2.1 Proper use

WARNING/ | Risk of personal injury and material damage
CAUTION Improper use of the QIAgility may cause personal injuries or damage fo the instrument.

A The QlAgility must only be operated by qualified personnel who have been appropriately trained.
Servicing of the QIAgility must only be performed by QIAGEN Field Service Specialists.

WARNING/ | Risk of overheating
CAUTION To ensure proper ventilation, maintain a minimum clearance of 10 c¢m at the sides and rear of the
’: QIAgility. Slits and openings that ensure the ventilation of the QIAgility must not be covered.

WARNING/ | Risk of personal injury and material damage
CAUTION The QlAgility is too heavy to be lifted by one person. To avoid personal injury or damage to the

f instrument, do not lift the instrument alone.
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WARNING/
CAUTION

>

Risk of personal injury and material damage
Do not attempt to move the QlAgility during operation.

WARNING

>

Explosive atmosphere
The QlAgility is not designed for use in an explosive atmosphere.

WARNING

>

Risk of explosion
The QlAgility is intended for use with reagents and substances supplied with QIAGEN kits. Use of other
reagents and substances may lead to fire or explosion.

CAUTION

>

Damage to the instrument
Direct sunlight may bleach parts of the instrument and cause damage to plastic parts.

The QlAgility must be located out of direct sunlight.

CAUTION

>

Damage to the instrument
Avoid spilling water or chemicals onto the QlAgility. Damage caused by water or chemical spillage will
void your warranty.

WARNING

>

Risk of personal injury
The robotic arm moves during position calibration while the instrument lid is raised. Never click any
buttons while parts of your body are within the instrument workspace.

In case of emergency, switch off the QlAgility at the power switch at the rear of the instrument and unplug the power cord from

the power outlet.

2.2 Electrical safety

Disconnect the line power cord from the power outlet before servicing.

WARNING

I\

Electrical hazard
Any interruption of the protective conductor (earth/ground lead) inside or outside the instrument or
disconnection of the protective conductor terminal is likely to make the instrument dangerous.

Intentional interruption is prohibited.

Lethal voltages inside the instrument
When the instrument is connected to line power, terminals may be live. Opening covers or removing
parts is likely to expose live parts.

QlAgility Version 4.18 User Manual
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WARNING

VAN

UV irradiation hazard
An electronic lid sensor ensures that the instrument lid must be closed for operation of the UV lamp. Under
no circumstances should this lid sensor be disabled during the decontamination.

To ensure satisfactory and safe operation of the QlAgility, follow the guidelines below:

Connect the line power cord to a line power outlet that has a protective conductor (earth/ground).
Do not adjust or replace internal parts of the instrument.
Do not operate the instrument with any covers or parts removed.

If liquid has spilled inside the instrument, switch off the instrument, disconnect it from the power outlet, and contact

QIAGEN Technical Services.

e If the instrument becomes electrically unsafe, prevent other personnel from operating it, and contact QIAGEN Technical

Services. The instrument may be electrically unsafe when:

O The line power cord appears to be damaged.

O It has been stored for a prolonged period of time in conditions outside of those outlined in Section 10.

O It has been subjected to severe transport stresses.

2.3 Biological safety

When handling biological material, use safe laboratory procedures as outlined in publications such as Biosafety in
Microbiological and Biomedical laboratories, HHS www.cdc.gov/od/ohs/biosfty/biosfty.htm.

2.3.1 Samples

Samples may contain infectious agents. You should be aware of the health hazard presented by such agents and should use,

store, and dispose of such samples according to the required safety regulations.

WARNING

Samples containing infectious agents
Some samples used with the instrument may contain infectious agents. Handle such samples with the
greatest of care and in accordance with the required safety regulations.

Always wear safety glasses, 2 pairs of gloves, and a lab coat.

The responsible body (e.g., laboratory manager) must take the necessary precautions to ensure that the
surrounding workplace is safe, and that TissueRuptor Il operators are suitably trained and not exposed
to hazardous levels of infectious agents as defined in the applicable Safety Data Sheets (SDSs) or

OSHA,* ACGIH!, or COSHH* documents.

Venting for fumes and disposal of wastes must be in accordance with all national, state, and local health
and safety regulations and laws.

* OSHA: Occupational Safety and Health Administration (United States of America).
T ACGIH: American Conference of Government Industrial Hygienists (United States of America).
# COSHH: Control of Substances Hazardous to Health (United Kingdom).
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2.4  Chemicals

WARNING Hazardous chemical

Some chemicals used with the instrument may be hazardous or may become hazardous after completion
A of the sample disruption process.

Always wear safety glasses, gloves, and a lab coat.

The responsible body (e.g., laboratory manager) must take the necessary precautions to ensure that the
surrounding workplace is safe and that TissueRuptor Il operators are not exposed to hazardous levels of
toxic substances (chemical or biological) as defined in the applicable Safety Data Sheets (SDSs) or
OSHA,* ACGIHt, or COSHH* documents.

Venting for fumes and disposal of wastes must be in accordance with all national, state, and local health
and safety regulations and laws.

* OSHA: Occupational Safety and Health Administration (United States of America).
T ACGIH: American Conference of Government Industrial Hygienists (United States of America).
# COSHH: Control of Substances Hazardous to Health (United Kingdom).

2.4.1 Toxic fumes

If working with volatile solvents, toxic substances, etc., you must provide an efficient laboratory ventilation system to remove

vapors that may be produced.
2.5 Waste disposal

Used plasticware and containers may contain hazardous chemicals, or contagious/biohazardous materials. Such wastes must

be collected and disposed of properly according to local safety regulations.
For information on use and disposal of the tip disposal box, please see Section 3.2.6, page 21.

For information about how to dispose of the QlAgility at the end of its economic life, see Section 10.

2.6  Mechanical hazards

WARNING Moving parts
Avoid contact with moving parts during operation of the QlAgility. Under no circumstances should you
A place your hands under the robotic arm when it is lowering. Do not attempt to move any plates or tubes
while the robotic arm is operating.

WARNING Damage to the instrument
f Do not apply any manual force to the Y-arm (i.e. the pipetting head).

We strongly recommend restarting the system if the Y arm was accidentally manually moved.
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To ensure satisfactory and safe operation of the QlAgility, follow the guidelines below:

keyboard when looking closely at plate calibrations. Wait until the robotic arm has completed its movements before moving

Only use recommended tips and tip racks.

Keep the instrument lid closed whenever possible.

Do not disable the lid interlock.

When calibrating plates with the lid open, always stand clear of the instrument when making adjustments.

The lid interlock is disabled during calibration mode. Therefore, do not click with the mouse or press any of the keys on the

any plates or tubes.

® Do not place any items on the robotic arm.

e Click on the Q‘ icon, located on the software toolbar, to pause the instrument before removing plates or tubes from the

worktable. Wait until the robotic arm has completed the current movement. This may take up to 10 seconds.

2.7  Maintenance safety

Perform the maintenance as described in Section 8. QIAGEN charges for repairs that are required due to incorrect maintenance.

WARNING/
CAUTION

>

Risk of personal injury and material damage
Only perform maintenance that is specifically described in this user manual.

WARNING/
CAUTION

>

Risk of electric shock
Do not open any panels on the QlAgility.

Risk of personal injury and material damage
Only perform maintenance that is specifically described in this user manual.

CAUTION

>

Damage to the instrument
Do not use solvents, or reagents containing acids, alkalis, or abrasives to clean the QlAgility.

CAUTION

>

Damage fo the QlAgility lid
Do not use alcohol, solvents, reagents containing acids, alkalis, or abrasives to clean the instrument lid.
Alcohol will damage the lid. To clean the lid, use distilled water only.

CAUTION

>

Damage to the QlAgility side panels
Never clean the instrument side panels with alcohol or alcohol-based solutions.
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2.8 Symbols on the QlAgility

Symbol

Location

Description

Worktable and near the type plate

Warning symbol

Worktable and near the tip chute

outlet

Biohazard symbol

Worktable

Squeezing warning symbol

Type plate on the back of the

instrument

CE Mark for European Conformity

Type plate on the back of the

instrument

UKCA mark for UK Conformity

Type plate on the back of the

instrument

CSA listing mark for Canada and the USA

Type plate attached to the cable of the

instrument

Legal Manufacturer

Type plate on the back of the

instrument

WEEE mark for Europe

Type plate on the back of the

instrument

FCC mark of the United States Federal Communications

Commission

Type plate on the back of the

instrument

C-Tick mark for Australia (supplier identification N17965)

Type plate on the back of the

instrument

RoHS mark for China (the restriction of the use of certain

hazardous substances in electrical and electronic equipment)

B o P 8L ®

Type plate on the back of the

instrument

Consult instructions for use
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3 General Description

The QlAgility System performs fully automated PCR setup. The QlAgility System comprises the QlAgility, a computer, and
QlAgility Software. These components have been optimized to work together across a wide variety of applications and provide

unmatched accuracy, precision, and speed for PCR setup. The instrument configuration is with HEPA filter/and UV lamp.
3.1 QlAgility principle

The QlAgility uses a single-channel pipet to automate PCR setup — up to 96 PCR reactions can be set up in approximately 30

minutes. Level sensing, facilitated by conductive tips, enables high-precision pipetting.

1. The QlAgility worktable is set up with a Master Mix Block, a Reagent Block, tips and plates/tubes. The instrument is then

calibrated.
Note: Tubes are placed into plates and are therefore treated as plates in the software.

2. Run files are created and modified using the easy-to-use QIAgility software. The user can download Q Protocols from
www.giagen.com/goto/QlAgility and modify them according to their needs. Wizards are also available to guide the user
step by step through developing new run files.

3. The progress of a run can be followed in realtime. The software highlights the position of the pipetting head on the screen
as it moves.

4. The QlAgility supports virtually all plate formats, including Rotor-Discs for the Rotor-Gene® Q, therefore PCR reactions can

be analyzed immediately using any PCR cycler.

QlAgility Version 4.18 User Manual  06/2023 18



3.2 The QlAgility

QlAgility

The QlAgility.
1 Lid
2 Feet
3 Tip chute
4 HEPA filter
5 UV lamp
3.2.1

Pipetting head (Robotic arm)
Tip Rack Holder and tips
Tip Rack Holder and tips

0 © N o

Master Mix Block and Reagent Block

Instrument lid (1)

CAUTION

VAN

Damage to the QlAgility lid

Do not use alcohal, solvents, reagents containing acids, alkalis, or abrasives to clean the instrument lid.

For more information, see Section 8.1.1.

The lid of the instrument provides both an isolated enclosure for performing purification and a safety mechanism.

The instrument lid incorporates a magnetic sensor to determine whether the lid is closed or not. Under no circumstances should

this sensor be bypassed.

The instrument lid must be closed for the software and hardware to initialize upon start-up and for a run to proceed.

Opening the instrument lid while the robotic arm is performing a run will cause the robotic arm to pause.

QlAgility Version 4.18 User Manual  06/2023 19




Extreme care should always be taken when opening the instrument lid during a run as the pause in robotic operation may take

several seconds to be completed.

The instrument lid may remain open when calibrating the position and height of plates. Do not interfere with robotic arm movement

during these calibrations and keep all body parts out of reach of the robotic arm while it is moving.

Important: Care should be taken when opening the lid during a run because it takes up to 10 seconds for the instrument to

complete the current movement and for the pause to take effect. Under no circumstances should this sensor be bypassed.
3.2.2 Feet(2)

The feet of the instrument have a nonslip silicone base to ensure that the QlAgility remains securely positioned on a laboratory
bench. Do not attempt to slide the instrument on a bench. Always lift the instrument to avoid damage to the silicone base of the

feet.

3.2.3 Tip chute (3)

Tip chute.

Tips used on the worktable are discarded through the tip chute. Located at the left hand side of the QIAgility, the tip chute is held

in place by a locating block, allowing easy placement and removal for cleaning.

Note: Details on removing and replacing the tip chute/tip ejector chute are described in Section 8.2.2.
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3.2.4 HEPA filter (4)

The HEPA filter system provides positive clean air pressure on the worktable beneath the hood. The HEPA filter system consists of
two HEPA filter cartridges.

HEPA filter.

3.2.5 UVlamp (5)

A UV lamp in the instrument lid provides efficient worktable decontamination and helps to prevent cross-contamination.
Note: Before using the UV lamp the tip chute must be placed info the instrument.
To operate the UV lamp:

1. Make sure that the UV lamp bulb is connected to the UV plug.
2. Make sure that the QlAgility instrument lid is securely closed.

For increased safety, an electronic interlock ensures that the UV lamp operates only when the instrument lid is closed. Under no

circumstances should the interlock be disabled.

During UV irradiation, the robotic arm moves between 2 locations at 5 second intervals. All items must be removed from the

instrument to ensure the worktable is fully exposed.
The UV lamp does not irradiate certain areas, including the pipetting head, due to construction constraints.
The UV lamp is enabled and time of exposure is set within the QlAgility Software. For more details, see Section 6.2.

3.2.6 Pipetting head (6) and robotic arm

Liquid-handling tasks are performed by the pipetting head, which provides a motor-driven, backlash-compensated pipetting
mechanism. Tips attach to the pipettor barrel of the pipetting head.
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The robotic arm controls the movement of the pipetting head in the X-, Y-, and Z-directions.

The Y-axis arm of the robotic arm provides support for the pipetting head. Under no circumstances should the user apply any

force to the Y-arm. This may misalign the arm and cause pipetting errors.

Note: To prevent accidental damage, the wooden Y-arm support should always be fixed or locked before the QlAgility is moved.
3.2.7 Worktable

The worktable is the instrument surface upon which items, such as plates, reagents, and tips are placed.

Worktable layout is specified for a protocol with a run file and is represented in the QlAgility Software as the workspace. For

more details, see Section 5.3.4.

3.2.8 Tip disposal box

Discarded tips are collected in a tip disposal box, located at the side of the QlAgility.

Each tip disposal box holds approximately 350 used tips.

Use of the tip disposal box is optional. Alternative boxes can be used at the user's discretion and may better suit the individual
situation. For example, positioning the instrument close to the left edge of a laboratory bench or table allows tips to be ejected

from the instrument directly into a biohazard waste bin or bag.

3.2.9 Accessory panel

QlAgility accessory panel.

1 Accessory 1 5 USB socket

2 Accessory 2 [ Accessory power outlet
3 Accessory 3 7 Main power input socket
4 Serial RS-232 socket 8 Power switch
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3.2.10 Internal features of the QlAgility

1 Worktable 7

2 Master Mix Block 8

3 Reagent Block 9

4 Tip Rack Holders and tips 10

5 Y-arm 11

[ Tip ejector 12
X-axis

The X-axis directs the left/right movement of the pipetting head.

Y-axis

The Y-axis directs the forwards/backwards movement of the pipetting head.

Z-axis

The Z-axis directs the upwards/downwards movement of the pipetting head.
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Tip ejector

The tip ejector facilitates tip removal from the pipetting head.

Pipetting head cover and pipetting head

The pipetting head is located under the protective pipetting head cover. The pipetting head consists of a motor driven backlash-

compensated pipetting mechanism. This mechanism is similar to most hand pipets.
Y-arm

The Y-arm supports the pipetting head. Under no circumstances should the user apply force to the Y-arm. This may misalign the

Y-arm and cause pipetting errors.
Worktable

The worktable has é SBS positions (127.76 mm x 85.48 mm) in which Tip Rack Holders and plates are located. In addition, the
worktable supports the Master Mix Block and Reagent Block. The silver paint is epoxy paint which is hard wearing and UV

resistant.

Master Mix Block
The master mix block is intended to hold diluent and master mix on the worktable. The QIAgility is supplied with 2 Master Mix
Blocks which can hold:

® 5 x5 ml freestanding tubes
® 1 x5 ml freestanding tubes, and 4 x 1.5 mL tapered tubes
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Reagent Block
The Reagent Block is intended to hold reagents and standards on the worktable. The Reagent Block can hold 8 x 1.5 mL tapered
tubes, 8 x 2 ml free-standing tubes, and 16 x 200 pL PCR tubes.

Adapters
The QlAgility is supplied with 3 SBS adapters:

e 2 x Adapter, 96 x 0.2 mL PCR Tubes
e 1 x Adapter, Flip-Cap 32 x 1.5 mL Tapered Base

The 96-well adapters are intended to hold strip tubes and unskirted and half-skirted PCR plates.

The 32-well adapter enables caps to be locked in position, preventing interference with the pipet tip.
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Sample tubes

A range of tube types can be used with the QlAgility. The following sample tubes are supplied with the instrument:

® 5 ml free-standing tubes
e 200 pL PCR tubes

Note: Supplied sample tubes are not guaranteed to be sterile.

Free-standing tubes (5 ml) are typically used to hold diluent and large volumes of master mix. These tubes are normally supported
in the Master Mix Block.

PCR tubes (200 pl) are typically used to hold samples and reactions, and are normally supported by the 96-well adapters.

Important: Tubes supplied by different manufacturers may have slightly different dimensions, despite a similar appearance. Such
differences can significantly affect the calibration settings, in particular the plate height calibration. We recommend that once a
particular tube type is chosen, the user always purchases that consumable from the same manufacturer to avoid frequent

recalibration.

Condouctive Filtered Tips and Tip Rack Holders
Tip Rack Holders can hold 200 pL or 50 plL Conductive Filtered Tips on the worktable. Supplied tips are carbon impregnated.

See Section 6.4.4 for details about how to insert tips into a Tip Rack Holder.
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3.3  liquid-level tracking
The QlAgility can track the liquid level using 1 of 2 methods: liquid-level sensing or liquid-level estimate.
Liquid-level sensing

For maximum accuracy and precision, the QlAgility is equipped with a liquid-level sensor. This feature enables the instrument to
automatically detect when the pipet tip makes contact with the liquid as the tip descends. When aspirating, the tip is placed
below the liquid surface, at the minimum insertion depth required to collect the aspirate volume. When dispensing, the tip is
placed at the liquid surface and retracted as liquid is ejected. This minimizes contact between the tip and the liquid, reducing

liquid carry-over.

The liquid-level sensor relies on conductive tips to detect the change in capacitance when the tip contacts the liquid inside a tube
— the smaller the volume of liquid inside the tube, the lower the change in capacitance. For correct functioning of the liquid-level
sensor, it is essential that the plates that are physically located on the instrument worktable are correctly assigned in the software.

See Section 5.7 for details about how to do this.
If a liquid is nonconductive (e.g., pure water, oil), the level sensor will not detect any change in capacitance.

Note: Addition of low concentrations of conductive substances (e.g., salts) to nonconductive liquids may enable liquid-level

sensing to be used.

Note: To pipet from wells that contain less liquid than the level sensor limit, it is necessary to switch the level sensor off, or reset
the error detection levels. It may also be necessary to manually calibrate the plate height closer to the base of the tube.
Alternatively, the liquid-level estimate mode can be used.

Liquid-level estimate

This feature enables the instrument to estimate the liquid level, using information from the run configuration. The software tracks the
movement of liquid between wells and estimates the liquid level during all liquid transfers. This information is used to determine the
optimal tip placement. Levels of accuracy and precision comparable to those obtained with liquidevel sensing are obtained. The

pipet tip moves to a calculated position so that, after aspiration, the pipet tip remains below the liquid level.
3.4 Computer
The QlAgility is operated via a computer.
A laptop with the correct specification for operation of the QlAgility and QlAgility Software is supplied as part of the QlAgility

System. However, if a different computer is used to operate the QlAgility or to run the QIAgility Software, then the following

laptop hosting systems are recommended.
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Laptop specifications

Windows® 10 (64-bit) with minimum required version 1607
At least 2.4 GHz CPU

At least 4 GB RAM

DVD/CD-ROM

Minimum 80 GB free hard drive capacity

At least 1360 x 768 screen resolution

Pointer device (mouse or similar)

The computer connects to the QlAgility by the USB.

Note: The software is tested by QIAGEN using the original image supplied with your laptop without connecting the laptop to the
internet. Updates on your operating system might lead to unexpected behavior of the QIAgility software.

Note: Some virus protection software might interfere with QlAgility Software and cause the software to run very slowly
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4

Installation Procedures

This section provides instructions on unpacking and installing the QlAgility.

Note: For your own safety and to prevent damage to the instrument, observe the safety instructions.

4.1 Instrument delivery and installation

The following items are delivered:

QlAgility instrument
Laptop
QlAgility Software and User Manual on CD

Accessories

Note: We recommend checking the packing list before installation.

4.2  Requirements

4.2.1 Site

Choose the position for the QIAgility carefully. A change in position necessitates a recalibration. Place the QlAgility in its final

position.

The requirements for the QlAgility location and position are given below:

The QlAgility must be located out of direct sunlight, away from heat sources, and away from sources of vibration and
electrical interference. Refer to Section 10 for the operating conditions (femperature and humidity).

The site of installation should be free of excessive drafts, excessive moisture, excessive dust, and should not be subject to
large temperature fluctuations.

Use a level workbench that is dry, clean, vibration-proof, and large enough to accommodate the QlAgility, computer, and
tip disposal box. Refer to Section 10 for the weight and dimensions of the QlAgility.

The QlAgility must be placed within approximately 1.5 m of a properly grounded (earthed) AC power outlet. The power
line to the instrument should be voltage regulated and surge protected.

Ensure that the switch and the main power input socket at the rear of the instrument are easily reachable. Maintain
sufficient clearance at the rear to unplug the power line from the main power input socket.

Ensure that the instrument lid can fully open upwards without obstruction.

The QlAgility must not be installed near generators of static electricity (e.g., ionizers, large-screen televisions).

The QlAgility should be installed in a laboratory environment that is free of excessive airborne dust.

Note: We recommend that the QlAgility does not share a wall socket with other laboratory equipment, and that the QlAgility is

plugged directly into its own wall socket.
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Important: The wall socket should be easily accessible.

Important: Position the QlAgility in a way that allows easy access to the power supply cable at the rear. Meeting these location
and position requirements will allow you to immediately disconnect the instrument from the power supply should a need or

emergency arise.

WARNING/ | Risk of overheating

CAUTION To ensure proper ventilation, maintain a minimum clearance of 10 c¢m at the sides and rear of the
’: QlAgility. Slits and openings that ensure the ventilation of the QIAgility must not be covered.

CAUTION Damage to the instrument
2 Direct sunlight may bleach parts of the instrument and cause damage fo plastic parts.

The QlAgility must be located out of direct sunlight.

4.2.2 Laptop

For operation of the QlAgility, the supplied laptop must be connected and placed near to the instrument.
4.3  AC power connection

Power requirements

The QlAgility operates at:

e 100-240V, 250 VA, 50-60 Hz, 5 A fuse

Make sure the voltage rating of the QlAgility and laptop are compatible with the AC voltage available at the installation site.

Main supply voltage fluctuations must not exceed 10% of nominal supply voltages.

Grounding requirements

To protect operating personnel, and for correct functioning of the liquid-level sensor, QIAGEN recommends that the QlAgility is
correctly grounded (earthed). The instrument is equipped with a 3-conductor AC power cord that, when connected to an

appropriate AC power outlet, grounds (earths) the instrument. To preserve this protection feature, do not operate the instrument

from an AC power outlet that has no ground (earth) connection.
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4.4 Unpacking the QlAgility

Before unpacking the QlAgility, move the package to the site of installation and check that the arrows on the package point

upwards. In addition, check whether the package is damaged. In case of damage, contact the transporter of the package.
See the underside of the lid of the box for a guide to removing the QlAgility from the box.

When lifting up the QlAgility, slide your fingers under both sides of the instrument and keep your back straight.

WARNING/ | Risk of personal injury and material damage
CAUTION The QlAgility is too heavy to be lifted by one person. To avoid personal injury or damage to the

2 instrument, do not lift the instrument alone.

After unpacking the QlAgility, check that the following documents are supplied:

® Packing list
e QlAgility Software CD

® Factory volume calibration report

Read the packing list to check that you have received all items. If anything is missing, contact QIAGEN Technical Services.

Check that the QlAgility is not damaged and that there are no loose parts. If anything is damaged, contact QIAGEN Technical

Services. Make sure that the QlAgility has equilibrated to ambient temperature before operating it.
Retain the packaging in case you need to transport or ship the QlAgility in the future. Instructions for packing the QIAgility are
outlined in Appendix A - Packing the QIAgility. Using the original package minimizes damage during transportation of the

QlAgility.

Carefully place the QlAgility onto the workbench where it will be used. For site requirements please refer to Section 4.2.
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4.5 Installing the QlAgility
Releasing the transport locks

Note: The procedure for removing the transport locks is also written on the transport locks on the instrument.
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3. Unscrew the Z-axis locking screw. When this screw is removed, the pipetting head will drop.

4. Store the transport lock and the Z-axis screw with the rest of the packaging.
4.5.1 UV lamp
The UV plug is integrated within the lid. To connect the UV lamp proceed as follows:

1. Open the lid.
2. Connect the delivered UV lamp bulb into the UV plug

Note: Hold the UV lamp bulb at both ends when fixing into the UV plug. Always wear safety gloves.

WARNING | UV irradiation
An electronic lid sensor indicates that the instrument lid must be closed for operation of the UV lamp.
A Under no circumstances should the lid sensor be disabled during the decontamination.

4.5.2 HEPA filter system

The HEPA filter system is installed and connected before shipping.

Note: Instructions for exchanging the HEPA filter system are given in Section 8.2.3.
4.5.3 Instrument calibration

Before the instrument is used, some calibrations are required: position and height calibrations, tip offset calibration, and volume

calibration. Please refer to Sections 7.1.2 to 7.1.6 for detailed descriptions.
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4.5.4 Computer setup and installation of software
For computer system requirements, please see Section 3.4.

1. Set up the computer as described in the computer installation instructions provided with the computer.

2. Before installing the QlAgility Software, shut down all other software and make sure that the instrument is not connected to

the computer.
3. Install the QlAgility Software. See Section 4.6 for detailed information about how fo install the software.

Note: Some virus protection software is known to interfere with QlAgility Software and will cause the software to run very

slowly.

4.6  Software installation
4.6.1 Installing the QlAgility Software
Install the QlAgility Software as follows:

1. Insert the QIAgility Software CD into the CD-ROM of the computer.

2. The installer splash screen will be displayed after a few seconds. If the splash screen is not automatically displayed, click
on Start Menu, select Run and then enter “CD/DVD-ROM drive”:\setup.exe (e.g., d:\setup.exe).

3. Select Install Operating Software on the splash screen. This will initiate the installation process.
4. If you are using Windows 10, the user account control (UAC) will appear.

5. Click Yes to continue.
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6. The "QlAgility Setup Wizard” will appear. This wizard will guide you through the installation. Instructions are displayed on

each screen of the wizard.

Note: We recommend using the default settings for all screens.

5! setup - QlAgility — X

Welcome to the QIAgility
Setup Wizard -

This will install QIAGEN QIAgility v4.18.1.01 on your
computer.

It is recommended that you close all other applications PC
before continuing.

Click Next to continue, or Cancel to exit Setup.

\

7. Click on the Next button to continue with the installation process. The “License Agreement” screen will appear.

5! setup - QlAgility —

License Agreement
Please read the following important information before continuing.

£

. Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

6=

Licence Agreement ~ P

1. In the following "QIAGEN" refers to QIAGEN GmbH and its affiliated companies
and "Software" means the programs and data supplied on this physical medium
(eg. CD-ROM) or over the Internet with these conditions. (If you are unsure of
any aspect of this agreement or have any questions they should be emailed to
Techservice-eu@qiagen.com) The Software and any accompanying
documentation have been developed entirely at private expense. They are
delivered and licensed as "commercial computer software".

2. Licence v

@1 accept the agreement
(D)1 do not accept the agreement

< Back Cancel

i—_ =)
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8. Accept the terms of agreement and click the Next button to continue.

% setup - QlAgility -

Select Destination Location
‘Where should QIAgility be installed?

=4

Setup will install QIAgility into the following folder.

EE

To continue, click Next. If you would like to select a different folder, click Browse. P

rogram Files (xi

TAgili Browse...

At least 8.4 MB of free disk space is required.

\ < Back | Next > | Cancel

Bl naciimnanes

9. To install the software under the default path, click the Next button. To install the software under a different directory,
browse for the directory and then click on the Next button.

Note: If a previous software version is already installed, the “Select Destination Location” screen will not appear. The
following message box will appear instead.
et S|

\ ? ) A previous installation of the Qlagility software has been found. Do you wish to upgrade?

Ho

10. To uninstall a previous software version, click on the Yes button. The calibration settings and run files will be retained. To

maintain the previous version of the software, click on the No button and browse for a different installation directory. Click

on the Next button to continue.

1 Setup - QIAgility =10l x|

Regional Settings

For comect customer service contact details to be provided, the Qlagility software
needs bo know the region of the world in which you are located.

Select Region:

Please select... j

< Back I Iext > I Cancel
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11. Use the drop-down menu to select your region. Click on the Next button to continue.

1B Setup - QIAgility - o] %]

Select Additional Tasks
Which additional tasks should be performed?

Select the additional tasks you would lke Setup to perform while instaling QlAgility, then
click Next.

Additional icons:
¥ Create a desklop icon

[ Create a Guick Launch izon

< Back I Next > I Canicel |

12. Select the additional tasks and then click on the Next button. Select Create a desktop icon to create a desktop icon to easily

launch the software. Select Create a Quick Launch icon to generate a quick launch icon.

5! Setup - QlAgility —

Ready to Install
Setup is now ready to begin installing QIAgility on your computer.

Click Install to continue with the installation, or click Back if you want to review or
change any settings.

-

Pro

Destination location: ~ P
C:\Program Files (x86)\QIAgility

Setup type:
QIAgility installation

Selected components:
Robotics Control Software
USB Drivers
QIAgility Plate Library Files
Plate Image Files

Additional tasks: v

< Back Install Cancel

|—_ = R
13. Review the displayed details. Click on the Install button.

{5 Setup - QIAgility

Installing
Flease wait while Setup installs Qlagility on your computer.

Ertracting filez
C:4Program Files\QlAgilityiHelphpdfzi Gl Agilitphd anual pef

]

Cancel
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14. The QlAgility Software will now be installed onto your computer. This could take a few minutes.

15. If you are using Windows 10, the following message will appear.

QIAGEN QiAgility Device Driver Installer

B The drvers are now installing

Manage

& T

application To
] PC » Desktop > Setup_QlAgility_vé-18-1-01_en

I 5! setup_ Qiagility v4-18-1-01 en
Please wat st This may take =

Would you like to install this device software?

Narme: QlAgility Device Driver
% publisher: QIAGEN GmbH

A Aiways trust software from "QIAGEN GmbH". Install Don't Install
= Documents
& Downloads @ You should only install driver software from publishers you trust. How can | decic
i fex

For correct installation of USB drivers, click on the Finish button.

QIAGEN QlAgility Device Driver Installer

Completing the Installation of the
QIAGEN QIAgility Device Driver

| ) I

The drivers were successfully installed on this computer.

You can now connect your device to this computer. if your device
came with instructions, please read them first.

Driver Name Status
v/ QIAGEN GmbH QlAgility... Ready to use

cel

Yy

i5 setup - QlAgility —

Information
Please read the following important information before continuing.

c When you are ready to continue with Setup, click Next.

laagility Software Release Notes A

[ )

This document describes successive releases of the QIAgility software, outlining
changes made since the previous release. The releases are listed in (inverse)
chronological order, most recent release first and least recent last. Each
description includes information about the reason for the release, a statement i
about compatibility and recommendations for use with available robotic
instruments, and details of major enhancements and defect fixes.

Please note: There is a more structured and readable description
linked in the start menu or in the About Box of the software.

QlAgility Version 4.18 User Manual  06/2023



16. Review the displayed information, and then click on the Next button to continue with the software installation.

‘ﬁj_.%! Setup - QlAgility —

Completing the QIAgility Setup
Wizard =

Setup has finished installing QIAgility on your computer. The
application may be launched by selecting the installed icons.

click Finish to exit Setup. Pl

[] Launch QIagility

=l Dacuments

\

17. To directly launch the QlAgility Software, select Launch QlAgility and then click on the Finish button. If you do not want to

launch the QlAgility software immediately, click on the Finish button to complete the installation process.
4.6.2 Uninstalling QlAgility software
Two methods can be used to uninstall the software. The recommended method is fo uninstall the software via the “Settings” menu.
To uninstall the software via the “Settings” menu:

1. Select Start > Settings > Control Panel. The “Control Panel” window will open.
2. Double-<click on the Add or Remove Programs icon.

3. Select QlAgility from the list of installed programs and then click on the Remove button.
To uninstall the software via the “Programs” menu:

1. Select Start > Programs > QlAgility > Uninstall.
2. Click on the Yes button to continue.

Note: When the software is uninstalled, calibration settings, run settings and run files will not be deleted.
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4.7  Folders

When the software is installed, a number of folders and subfolders are created.

@ C:\Program Files\QIAgility ] 4]
Datei Bearbeiten  Ansicht  Eavoriten  Extras 2 ‘ p?
ezw:k -0 - |p5u:hen I ondner ‘ [ 3 X ) | (it
Adresss [[) C:\Program Filesiolagiity | [ wechsin 2u
Ordner X e a e e =]
BN o1ty B L-J "J "I "J
1) AccDefs AccDefs Data Help HTML
1) Data [
13 Help - - - -
S HTML 1,] l,] 1/3 1,]
13 Tnkegration Integration Libs Patches PlateDefs
I3 Libs
I3 Patches —
23 PlateDefs 1__) ‘_J ‘__j 1__)
() PlateImg
) PresetMasteric Platelmg PresstMasteriix GProtocols Security
I3 GProtocals
1) Security e P o e
1) settings JJ LJ J/I JJ
I3 socketDefs Settings SocketDefs TableDefs TubeDefs
() TableDefs
I3 TubeDefs = —n
q g ) ) A .

Data Run files are saved in this folder.

Data — Logs Log files are saved in this subfolder.

Data — Reports Pre-run and post-run reports are saved in this subfolder.

Data — SupportPackages Diagnostic support packages are saved in this folder.

Help Contains a PDF of the QIAgility User Manual, version 4.18.

HTML Contains a HTML version of the release notes.

Integration Contains XSL transformation files for custom export

QProtocols Q Protocols are stored in this folder; see Sections 4.7.1 and 6.4.1 for more details about this
folder.

In addition, these folders are important for operating the instrument:

AccDefs
Libs
Patches
PlateDefs
Platelmg
PresetMasterMix
Security
Settings
SocketDefs
TableDefs
TubeDefs
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Note: Do not attempt to modify or delete these folders.
4.7.1  "QProtocols” folder

Storing Q Protocols in this folder enables access to the Protocols tab in the splash screen that opens when the software starts,

and also after clicking on the il ‘ i

QlAgility — Pure Precision  3s3s¢

New | Becent [ Broiposks |

ﬂ RotorGene SYBR Grsen PCA_V1 [ o= ]

Cancel

Note: If no Q Protocols are present in the QProtocols folder, the Protocols tab will not be available. If a specific Q Protocol is not
saved in the QProtocols folder, it will not be listed when the Protocols tab is selected.

4.7.2 Connecting the computer to the QlAgility

Note: Before connecting the QlAgility to the computer for the first time, ensure that the QlAgility Software has been installed (see
Section 4.5.4).

The QIAgility has the interface connection to the computer USB. The laptop which is supplied with the QlAgility should be installed

USB interface can be used, depending on the configuration of the computer.
Note: Connect the computer to the QlAgility only via the USB interface. Do not use the RS-232 with Win 10.
To connect via the USB interface:

® Connect the USB cable between the USB port on the instrument and the USB port on the computer.
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4.7.3 COM port configuration

The COM port used to connect the computer to the QlAgility must be correctly configured in the software to enable the software

to communicate with the QlAgility instrument.

Note: This COM port number might change depending on the use of other virtual COM ports on your computer. QlAgility
software will mark the correct virtual COM port number with an asterisk (*). You can check the COM port number in the hardware
manager of your computer.

4.7 .4 Installation of AC power cord

Important: The QlAgility Software must be installed on the computer before the QlAgility is switched on (see Section 4.5.4).

Connect the QlAgility to the power outlet as follows:

1. Ensure that the power switch of the QlAgility is set to the off position.
. Check that the voltage rating on the label at the back of the QIAgility matches the voltage available at the installation site.

. Plug the power cord into the main power input socket.

AN oW N

. Plug the power cord into a grounded power outlet.
Important: The wall socket should be easily accessible.

5. If the QlAgility Software has been installed on the computer, you can switch the instrument.

QlAgility Version 4.18 User Manual  06/2023 42



4.8 Hardware Wizard

Found New Hardware

Welcome to the Found New
Hardware Wizard

“indows will search for curent and updated software by
loaking on wour computer, on the hardware installation CD, or on
the YWindows Update Web site [with your permission).

Fead our priva H

CanWindows connect bo Windows Update to search for
software?

 Yes, this time orly
1 e, now and gvery time | connect 2 devics
Mo, not this lime

Click Next to continue.

< Back | Hest > | Cancel I

1. Select No, not this time, and click Next.

Found New Hardware Wizard

5

Thiz wizard helpz pou install software far:

GlAcube HT

I:;J If your hardware came with an installation CD
B2 or Hoppy disk. insert it now.

‘what do you want the wizard to do?

% {nstall the software automnatically [Fecammended]

= Install from a list or specific location [4dvanced)

Click MNext to continue.

< Back I Mest > I Canhcel |

2. We recommend that you select Install the software automatically.

3. Click on the Next button to continue.

Hardware Installation

L} The software you are installing for this hardware:
e
Dlagilty

has not passed Windows Logo testing to venify its compatibility

with Windows %P, [Tel me why this testing iz impartant. |

Continuing your i ion of this sofl may impair
or d ilize the correct op. ion of pour spstem
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

OF Installation I

LContinue Anpway
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4. Click on the Continue Anyway button.

Completing the Found New
Hardware Wizard

The wizard has finished instaling the software for

3 Olgiity

Click. Finish ta close the wizard,

T

< Back

Cancel |

5. Click Finish to complete connection of the laptop to the instrument.

The QlAgility Software and instrument have now been successfully installed.

4.9  Setting up the QlAgility

Note: If the “Hardware Wizard” appears when the computer is switched on, see Section 4.8 for more details.

1. Ensure that the instrument lid is closed.

2. Set the power switch of the QlAgility to the on position and switch the computer on. The pipetting head should move

upwards. If this does not happen, please consult the Troubleshooting section of this user manual.

3. Double<lick on the &8
Start > Programs > QlAgility > QlAgility.

icon on the desktop. This launches the QIAgility Software. Alternatively, select

Note: If the instrument is not switched on, the software will be operated in “Virtual Mode”. For more information, see

Section 5.2.

4. The following welcome screen will appear. Select the New tab.

QlAgility — Pure Precision  3s3ss

(Hiew ] fecent] Protocas |

[ Evot poiect festusedlagout) [ ]
T o |

igﬂ PCR Setup Wizard

730 Dpiirization Wizard

5. Select Empty Project (last used layout) or Empty Project (default layout) and then click the Open button. Alternatively,

double-click Empty Project (last used layout) or Empty Project (default layout).

6. The following message appears.
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oy

\ i You'll need ko configure the tip ejector location before continuing. Hit OF to
stark the procedure,

7. Click on the OK button to proceed o tip ejector calibration. See Section 7.1.1 for more details about how to do this.
Note: Tip ejector calibration must be performed before any other calibrations.

8. Perform the remaining calibrations in the order listed in Sections 7.1.2 to 7.1.6.
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5 QlAgility Software

The easy-to-use QlAgility Software has been specially developed for use with the QIAgility instrument. The software simulates the
instrument worktable and enables the user to follow the progress of a run in real time, by highlighting the position of the pipetting
head on the worktable. The software can also be run in “Virtual Mode”, which enables run files to be simulated before use in

“Normal Mode”. This allows fast, step-by-step setup of new run files, which can be tailored to the needs of the user.

The QlAgility Software is supplied without protocols. Q Protocols can be downloaded from www.qiagen.com/goto/QlAgility.
Select the User Support tab and look under the “Protocols” header. For convenience, the software automatically calculates the
required volume of each of the starting liquids (e.g., master mix and samples). In addition, the software generates pre-run and

post-run reports.
5.1  Starting the software
Note: Before starting the QlAgility Software, ensure that the instrument lid is closed and that the instrument is switched on.
1. Double<lick on the i icon on the desktop, or select Start > Programs > QlAgility > QlAgility. If the instrument is switched

on, and is connected to the computer, the software will proceed automatically to “Normal Mode” operation. If the

instrument is not connected to the computer, or if the instrument is switched off, the software will operate in “Virtual Mode”.

QlAgility — Pure Precision

QlAgility Version 4.18.1
Build 03 (1.6.77)

Please wait - Enumerating tables

Updates and additional resources available at

http: /v, giagen. com
rony

Waming: This computer program is protected
by copyright law and international treaties.
Unauthorized reproduction of this program, or
any portion of it, may result in severe civil and
criminal penalties, and will be prosecuted to
the maximum extent possible under the law.

Force Virtual Mode

2. To force “Virtual Mode” operation, click on the Force Virtual Mode button. See Section 5.2 for more detailed information

about “Virtual Mode” operation.
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5.2 Virtual Mode

“Virtual Mode” enables run files to be developed and simulated, without actually performing the pipetting operations on the
instrument. This is particularly useful for checking new run files. In “Virtual Mode” all software functions are enabled. Run files

which are developed in “Virtual Mode” can be saved and then run in “Normal Mode”.
Note: Any modifications made to calibrations in “Virtual Mode” will not affect calibrations on the actual instrument.

When the instrument is running in “Virtual Mode”, the following message will be displayed at the top of the main software

window, indicating that the software is running in “Virtual Mode”.

Untitled.QAS - QIAgility [VIRTUAL MODE]
File Control “Wizards Options Help

IR TP YN

5.3 Main software window
The main software window provides an interface for the creation of run files. The main features are as follows:
Menu bar

Toolbar
Mode indicator

Software workspace

000000000000
i 000000000000
"o 000000000000
o @ @ 000000000000
i £ 000000000000
000000000000
w0 @ 000000000000
=0 000000000000
o O @
=0
2 0 O EERRH TS T o 5 u O
wo
00000000
w0
© @ 00000000
© 00000000
w0 @ 00000000
=0 coococo0o000
=0 QO @ ' €00000000000
"o © 900000000000
w0 O @ * ©08000000000
iy vi126 fox [y o [Gidtovt Tosorer [Torowetimes  [aan
1 Menu bar 3 Mode indicator
2 Toolbar 4 Software workspace
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5.3.1 Menu bar

The menu bar contains 5 menus - File, Control, Wizards, Options, and Help. All software functions can be controlled from these

menus. This section outlines the options that are available from these menus.

In addition, when the righthand pane is open, the following icon is available from the menu bar. See Section 5.3.4 for more

details about the options that are available from this icon.

EI Righthand pane icon

File menu

The File menu provides access to file related functions.

File Control ‘Wizards Options Help

Mew Chrl+-M
Open... Chr+O
Save As... Chrl+3

Lab notebook, ..

Protocol description. ..
Unlack pratocal...

1 HotStarTanl _signeds. Qas

2 HotStarTagl_signed3__2008-11-20_10-11-55.045
3 HotStarTagl_signed3. QAs

4 HotStarTagl_signed3_2008-11-19_13-01-26.045
S HobStarTaql_signed3_ 2008-11-19_09-03-05.045
& HotStarTaql. QAas

7 QuantiFast MP-PCR-2-GDLQAS

& RT-PCR-4.045

Exit Chrl+Q
New Opens a splash screen, which displays options to create a new run file, open a recently used run

file, or to open a Q Protocol.

Open Enables an existing run file to be opened. Select the run file and then click on the Open button. This

file can be used as it is, or modified to create a new run file.

Save As Saves the run file under the current file name, or under a new file name selected by the user. Any

previous version will be replaced. All parameters except tip availability are saved.

Lab notebook Allows the user to enter and save comments for a run file in plain text. Any comments will be displayed

in a message box when the run file is opened and will be shown in the pre-run and postrun report.

Protocol description Opens a description of the Q Protocol template which is currently loaded. This option is only available

when a Q Protocol or User-Developed Protocol is loaded.

Unlock protocol Unlocks the protocol which is currently loaded. This option is only available when a Q Protocol or User-

Developed Protocol is loaded.
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1-8 Lists the 8 run files that have been used most recently. Leftclick to select and open one of these run files.

Exit Closes the QlAgility Software.

Control menu

The Control menu provides options to send the instrument to its home position, start a run, or pause/abort a run.

Conkrol  “Wizards  Option:

[ Send robok home

i Start...
Fausejfbork
Send robot home Initiates the instrument homing routine including tip ejection. After this routine the Y-arm will return to
its resting position.
Start Select this option to start a run. See Section 6.4.5 for more details about starting a run.
Pause/Abort Pauses the instrument during a run. A dialog box will appear. Click on the Continue Run button to

continue the run, or click on the Abort Run button to abort the run. See Section 6.5 for more details.

Wizards menu

The Wizards menu provides access to the PCR setup wizard... and Optimisation wizard.... It also enables the user to import

sample names, export reaction data, or generate pre-run reports.

|'u'u'izards Options  Help

PCR setup wizard. ..
Cptimisation wizard. ..

Impark well data.. . Ckrl4+1
Export reaction data... Ckrl+E

GEnerate report Ckrl+R

PCR setup wizard Launches the “PCR Setup Wizard”. This wizard can be used to create new run files. See
Section 5.10.1 for further details.

Optimisation wizard Launches the “Optimisation Wizard”. This wizard enables specialized PCR functions to be set up.

For example this wizard can be used for optimization of a PCR run (e.g., primer concentration).
See Section 5.10.2 for further details.
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Import well data

Export reaction data

Generate report

Options menu

Opens the “Import Well Data” dialog box, which enables sample and reaction data to be imported

from a file to a selected sample or reaction plate. See Section 5.9.7 for further details.

Opens the “Export reaction Info” dialog box, which enables information about the contents of
reaction wells from a selected reaction plate to be exported to another file. See Section 5.9.7 for

further details.

Opens a window which contains the pre-run report for the loaded run file. See Section 6.7.1 for

further details.

The Options menu includes options to manage user groups, manage calibration settings, and to configure pipetting and plate

options.

Options  Help

I User Management 3
! Calibration Management
Robaot Setup 3
Fun Settings 3
Advanced Settings 3

Change plate type
Change accessary
Change plate function  #

User management

User management —

Enable Access Control

User management —

Users & Groups

User management —

Change current user

Provides options fo create user groups, and to enforce access restrictions on certain user groups. See

Section 5.4 for further details.

Enables or disables access control. If access control is enabled, a tick is displayed. Access control

can only be enabled by an “Administrator”. See Section 5.4.3 for further details.

Enables creation of user groups. See Section 5.4.4 for further details.

Enables the current user to be temporarily changed. A dialog box will appear, which enables an

administrator to temporarily log-in. See Section 5.4.5 for further details.

Calibration management  Enables the transfer of calibrations and other software settings from one computer to another. This is

useful when the instrument is connected to a new computer. See Section 5.5.

Calibration management  Enables calibration seftings to be saved using a range of storage devices (e.g., USB stick). See

— Save calibrations on

setup disk

Section 5.5.1.
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Calibration management
— load calibrations from

setup disk

Calibration management
— Delete multiple
calibrations

Robot setup

Robot setup —

Calibrate plate heights

Robot setup —

Calibrate volumes

Robot setup —

Calibrate plate positions

Robot setup —
Calibrate tip offsets

Robot setup —
Setup tip ejector

Robot setup —
Select COM port

Robot setup —
Enable UV light

Robot setup —

Service register

QlAgility Version 4.18 User Manual

Enables calibration settings to be loaded from a setup disk onto a computer. See Section 5.5.2.

Enables deletion of multiple calibration settings. See Section 5.5.3.

Provides options to calibrate the instrument. These seftings are maintained locally and are not

associated with run files.

Defines the Z-axis location (i.e., height] of the inside base of the tube or wells of a plate. See
Section 7.1.3.

Calibrates the volume that is pipetted. Ensures that the correct volume is accurately and precisely

pipetted. See Section 7.1.6.

Enables calibration of the position of each plate. Ensures that the pipefting head moves to the correct

location for every well on a plate. See Section 7.1.2.

Enables calibration of length variation between different tip types. This calibration is optional. See
Section 7.1.4.

Calibrates the pipetting head to the tip ejector. Enables correct tip ejection and ensures that the

vacuum hub is not damaged. See Section 7.1.1.

Enables selection of the COM port which is used for communication with the QlAgility. See
Section 5.11.

In “Virtual Mode”, this option enables or disables a “virtual” UV lamp. When enabled, a tick will

appear, and the UV lamp bulb icon will be activated in the toolbar.

In “Normal Mode” this option is disabled. If a UV lamp is physically detected by the instrument
hardware, this option will be ticked and the UV lamp bulb icon in the toolbar will be activated. If no
UV lamp is detected, this option will not be ticked, and the UV lamp bulb icon in the toolbar will be

inactive. See Section 6.2.

Opens the “Service Register” dialog box. This outlines the instrument service history. The service
history is updated by QIAGEN Technical Services. See Section 5.12.
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Run settings

Run settings —

Configure tip air intake

Run settings —

Configure pipette speed

Run settings —

Use liquid level when

pipetting?

Run settings —

Ignore errors during run?

Run settings —
Set master mix

extra volume

Run settings —

Set standard extra volume

Run settings —

Set tip usage options

Run settings —

Set concentration unit

Run settings —
Allow use of multiple

reagent volumes

Run settings —

Set default file location

Run settings —
Save current seftings as
default

Enables a number of run settings, including pipetting options (e.g., pipetting speed, tip reuse), extra
volumes and level sensor settings to be adjusted. These settings are stored with the run file and allow

the application to be reproduced on another instrument. See Section 5.6.

Enables the volume of air that the pipetting head takes up before aspirating liquid to be configured.

The air is blown out upon ejection, ensuring that all liquid is ejected. See Section 5.6.1.

Enables adjustment of the pipetting speed (i.e., the aspirate/eject speed). See Section 5.6.2.

Enables the method of tracking liquid level to be selected. There are 3 options — Do not use, Detect

liquid level using sensor, and Use Liquid Level estimate. See Section 5.6.9.

Enables the software error level to be selected. There are 3 options — Interrupt run on all errors,

Interrupt run on serious errors, and Ignore all errors. See Section 5.6.10.

Enables the additional volume of master mix to be defined. See Section 5.6.3.

Enables the additional volume of standard to be defined. See Section 5.6.4.

Enables configuration of tip usage. See Section 5.6.11.

Opens the “Set concentration unit” dialog, where a (physical) unit for concentrations to be displayed

can be selected.

Enables or disables the usage of different reagent volumes per reaction. A tick will appear when the

option is enabled. See Sections 5.6.6 and 5.9.6.

Enables the user to change the default file location for all saved files. See Section 5.6.5.

Saves current software run settings as the new default settings. This does not include calibration

settings.
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Run settings —

Reset settings to factory
default

Run settings —

System colour

configuration

Run settings —

shutdown beep?

Run settings —

Allow screensaver?

Run settings —
Generate file names for
reaction export
Advanced settings
Change plate type

Change accessory

Change plate function

Help menu

Resets software settings to the factory defaults. Click on the Yes button to continue.

Provides options to change the default colors which are used for all liquid groups on the software
worktable. See Section 5.6.8.

Enables or disables the shutdown beep. A tick will appear when the shutdown beep is enabled.
Allows or inhibits operation of the separately configured Windows screensaver. A tick indicates that
the screensaver is not inhibited.

Enables or disables automatic generation of unique file names for reaction exports. Unique file names
are based on the run file name, time, and date. A tick will appear when this function is enabled.
Provides additional options for use in specialist applications. Only change these settings under direct
instructions from QIAGEN. See Section 10 for more detailed information about these settings.

Launches the “Plate Configuration” dialog box, which enables the user to change the plate type in a

selected position on the software worktable. See Section 5.7.1.

Launches the “Select Accessory” window, which enables the user to add or remove an accessory from

a selected position on the software worktable. See Section 5.7.1.

Enables selection of plate function. A tick will appear next to the plate function that has been selected.
See Section 5.7.1.

Help

I onkents

& Save support package...
Choose support package. ..
Self-diagrostic tools

Enable serial communications logging

Wiew axis usage counters, .,

Explore save directory. ..
Display log file. ..

F3
F11

Abaout QIAgiliey. ..

F12
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Contents Opens a pdf file of the QIAgility User Manual.
Save support package Creates a zipped support package. Select a file location and then click on the OK button. This
package contains information about run seftings, calibration data and log information. See

Section 6.7.3.

Choose support package  Enables the user to view recent support packages. Support packages can be sorted based on name of

run file, time of completion and type of error which occurred during the run. See Section 6.7.3.

Self-diagnostic tools See Section 9.4 for more details.

Enable serial This option should only be enabled under specific instruction from QIAGEN.

communications |ogging

View axis usage counters  Allows the user to browse the number of movements each axis has performed since the last instrument

service.
Explore save directory Launches a file Explorer window with the default file directory where run files are saved.
Display log file Displays the log file. This file contains information about the run setup and all commands sent to the

instrument from the computer. The log file is updated as new runs are carried out, with the oldest
data being deleted. See Section 6.7.3.

About QlAgility Displays information about the QlAgility, including the version number, serial number and firmware

number. QIAGEN contact details, which may be required to place orders or to request technical

support, are also displayed.

5.3.2 Toolbar

This section outlines functions that are available from the toolbar menu.

D‘ Opens the start-up splash screen, which displays options to create a new run file, to open a recently

............

used run file, or to open a Q Protocol.

= Enables an existing run file to be opened. Select the run file and then click on the Open button. This

file can be used as it is, or modified to create a new run file. See Section 6.4.2.

H Saves the run file under the current file name, or under a new file name selected by the user. Any

previous version will be replaced. All parameters except tip availability are saved.
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Select this option to start a run. See Section 6.4.5.

Pauses the instrument during a run. A dialog box will appear. Click on the Continue Run button to

continue the run, or click on the Abort Run button to abort the run. See Section 6.5.

Initiates the instrument homing routine. After this routine the instrument arm will return to its resting

position.

Allows the user to enter and save comments for a run file in plain text. Any comments will be displayed

in a message box when the run file is opened. This icon is not enabled when a Q Protocol is loaded.
Generates a pre-run report to assist with workspace setup for the current run.

Opens a PDF file of the QIAgility User Manual.

Enable the user to highlight the source and destination wells on the software worktable.

Opens the “UV Lamp Control” dialog box. If a UV lamp is not installed and enabled in the software,

this icon is shown in gray. See Section 6.2.

Switches the HEPA filter on and off. The fan color alternates between green (on) and red (off). If a

HEPA filter is not installed, this icon will be shown in gray. See Section 6.3.

Indicates a problem with the run. Errors must be resolved and acknowledged before the run can

continue.

Opens the “Service Register”. See Section 5.12 for more details.
Unlocks a protocol.

Opens a protocol description for a Q Protocol.

Indicates that the run file which is currently open is a locked Q Protocol.

Indicates that the run file which is currently open is a locked User-Developed Protocol.
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5.3.3 Mode indicator

When the software is operating in “Virtual Mode”, the following indicator is displayed.

EUntitled.QAS - QIAgility [WIRTUAL MODE]

Flle  Control wizards Options  Help

RETSIIEY-_ Y

When the software is operating in “Normal Mode”, the following indicator is displayed.

it Untitled.QAS - QIAgility [S/N: 30305]

File | Control Wizards Options Help

rwl =l al | o | | a | e |

5.3.4 Software workspace

The software workspace supports the following features:

Worktable

Status bar

Software version
Instrument

Liquid-level sensing option
Tip reuse option

User logged-in (Windows)

Plate buttons

Righthand pane
Software worktable

The software worktable visually simulates the instrument worktable. The 6 SBS positions for plates are labeled A1, A2, B1, B2,
C1, and C2. Positions for the Master Mix Block and Reagent Block are labeled M1 and R1.

Status bar

The status bar displays the current status of the instrument during a run.

ok

Software version

This bar displays the current software version.

Gl gility- w4.121
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Instrument

This bar indicates whether the instrument is operating in “Virtual Mode” or “Normal Mode”.

| Glagiity (simulated) |
QlAgility (simulated) Indicates that the instrument is operating in “Virtual Mode”.

QlAgility Indicates that the instrument is operating in “Normal Mode”.

Liquid-level tracking option

This bar indicates whether the liquid-level sensor is enabled. Double<lick on this bar to change between Tip Sensor, Estimate, and
Not Used.

Liquid Lesvel: Tip Sengor

Tip sensor Indicates that liquid-level sensing is enabled.
Estimate Indicates that the liquid-level estimate function is enabled.
Not Used Indicates that both liquid-level sensing and liquid-level estimate functions are disabled.

Tip reuse option

This bar indicates the tip reuse mode. Double<lick on the bar to open the “Tip Usage” dialog box. See Section 5.6.11 for more

details about sefting tip usage options.

Tip re-uze: 8 times

User logged-in

This bar displays the user that is currently logged-in to the software.

Plate buttons

Plate buttons are located in the top right corner of the schematic plates on the main software window. They provide information

about the plates and appear when the cursor is moved over a plate.
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The warning button is an exception, it will appear if the plate has not been position or height calibrated, and will remain visible

until all of the calibrations for that plate have been completed.

neri
12 E

TI =
o
ol Prompts the user to proceed to plate calibration. Opens the “Set Alignment” dialog box if plate

Warning position calibration has not been completed, and opens the “Configure Plate Heights” dialog box

if plate height calibration has not been completed.

(= Enlarges the view of the plate. Click again to return to the normal view.
Zoom
Displays details about the current plate. Click on the OK button to return to the main software
Info window.
IE' Toggles between an image of the current plate and the plate schematic.
Toggle
Right-hand pane

The right-hand pane refers to the area at the right side of the software workspace. It provides access to options which relate to
different plate functions (i.e., tip, reaction, master mix, reagent, and sample). There is no righthand pane for diluents, because
the diluent does not have a definable function. In addition, when a run is in progress, a progress report is displayed in the right-

hand pane.

The EI icon is available at the top left of the righthand pane when “Minimize” or “Restore” has been selected from the same

icon in the menu bar. Leftclick on the EI icon to access the following options.

Restore Reduces the size of the right-hand pane.
Move Enables the righthand pane to be moved.
Size Click on the righthand pane and then drag to increase or decrease the size of the right-hand pane

in a vertical or horizontal direction.

Minimize Minimizes the righthand pane.

Maximize Maximizes the righthand pane.
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Close Closes the righthand pane.

Next No function.

Tip

Please refer to Section 5.9.1 for detailed information about the “Tip” right-hand pane.

Standard

Please refer to Section 5.9.2 for detailed information about the “Standard” righthand pane.

Reagent

Please refer to Section 5.9.3 for detailed information about the “Reagent” righthand pane.

Master mix

Please refer to Section 5.9.4 for detailed information about the “Mix” right-hand pane.

Sample

Please refer to Section 5.9.5 for detailed information about the “Sample” righthand pane.

Reactions

Please refer to Section 5.9.6 for detailed information about the “Reaction” right-hand pane.

Progress report

Please refer to Section 5.9.8 for more detailed information about the “Progress report” righthand pane.
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5.4 User management
User management allows the definition of different access rights to various data and functions within the QlAgility Software.
User management functions are accessed from the menu bar (Options > User Management).
5.4.1  User identification

Unlike software that requires separate login authentication, the QlAgility Software user is defined as the current Windows user

logged on the laptop on which the software is installed.

The user identification function is always active and the user’s identification is reported in all pre and post run reports as well as

diagnostic logs produced by the software during normal operation.

Note that access privileges are included only to support a particular use policy for the software and are not intended to prevent

accidental or intentional circumvention of the policy or misuse of the software.

All users are able to edit and save modified run files (Section 5.10). If the run file is not saved with a new name, the previous
run file data will be lost. If required, standard Windows file system write-protection mechanisms may be used to protect runile
data.

5.4.2 User classes
The QlAgility Software supports the following user groups:

QlAgility Operator
QlAgility Designer
QlAgility Manager
Windows Administrator

In the following we will speak of Operator, Designer, Manager, and Administrator.

Operator

An “Operator” user can navigate and view table layouts, run settings, and reaction list data with “view/read only” access.
Operators have “edit” access to perform the following:

Update “lab notebook” text information for a run file

Set tip availability

Assign identifiers and bar codes to plates, identifiers to wells, and bar codes to samples or reaction wells for a protocol run

Modify the set of wells associated with sample banks used in the protocol run
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An Operator cannot modify reaction properties.
Designer

A “Designer” user has all access rights as an Operator and, in addition, has “read/write” access to all functions of the software

including the ability to:

Design table layouts
Calibrate the instrument
Define run settings

Setup the reaction list

Import and export data

Designers are expected to define template run files (Section 6.4.3) and specify calibration data (Section 5.5 and Section 7) to

be used by Operators.
Manager
A “Manager” has all access rights as a Designer. In addition, Managers can:

® Enable and disable the access control function in the software (Enable User Access option, see Section 5.4.3, page 62)

e Update group membership for each of the QlAgility groups (if the Manager is also an Administrator)
Administrator
An Administrator has all access rights as a Manager.

An Administrator user is a member of the standard local Windows administrator group and has full administrative access on the

computer. This is necessary to update the QlAgility group membership.

A Manager enables the user access control, a Manager/Administrator assigns users to groups (see the following sections).
Upon restarting the software, only Administrators and users assigned to the “Manager”, “Designer” and “Operator” groups can
operate the software. When attempting to start the QlAgility Software, users that are not assigned to a user groups are denied
access to the software.

When user access control is disabled, all users are given “Manager” access.

Upgrading the software does not affect user access control.
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5.4.3 Enabling access control

Upon installation, the QlAgility Software user access control features are disabled and all users have “Manager” access. (See

the previous section for user group descriptions.)

A Manager enables the user access control with Options > User management > Enable access control.

You can toggle between enabled and disabled states. A tick appears next to Enable access control when this option is enabled.
If the access control is enabled it is directly active. Be careful to enable the access control only if you are a Manager.

5.4.4 Managing user groups

If your computer belongs to a domain, the user groups have to be created and used in the domain. If you are working with a
stand alone computer, the user groups are created and used locally. In both cases, local Administrators have full access to the

software.

If you are a Manager, you can use the management functions on the menu bar Options > User Management > Users & Groups

to change the groups membership. You must be an Administrator to save your changes.
To set the groups membership of users on the laptop computer:

1. Open the Options menu, and select User management > Users & Groups.
2. The “Users & Groups” window appears.

3. Select the user from the Users panel.

F¥ Users & Groups x|
Current User: azchwarz
Usgers

Ef aschwarz 5 Qldop
2 desktopmanagsr
Liest
=1
3 Ol aadrmir
L # (lAdesigner

 Groups :

“Windows Groups © Guest's Groups:

Adrninistrators

B4 Qlagility Manager ;l
= Clagility Designer

E¥ Qlagility Operator ;l

Close | @ Save |

4. Select the group to which the selected user should be assigned (i.e., “Administrators”, “QIAgility Manager”, “QlAgility

Designer”, or “QlAgility Operator”) in the Windows Groups panel.
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5. Click the “*" button to move the selected group into the Guest's Groups: panel.

F¥ Users & Groups x|

Current User: aschwarz

rUsers:

aschwarz H0laap
desktopmanager

Guest

=1

B O &admin
[#E4 Oladesigner

 Groups
“windows Groups : Guest's Groups:
Adrriniztratars QlAgility D esigner
=4 Ol agility Manager

b
E¥ Olagility Dperator
4 |

Cancel | ()

6. To assign the user to more than one group, repeat steps 4 and 5.

7. Click Save to save your changes. To do this you must be an Administrator. If you are not an Administrator, a pop-up of the

operating system will appear to ask for elevation.

5.4.5 Change current user

To change users, the current user must shut down the software and log out of Windows. The new user must subsequently log in

to Windows and restart the software.

Alternatively, select Options > User management > Change Current User. The “Change User” window appears. The new user

must enter their username and password, and click OK to log on.

r'ou can uze thiz window to log on temporarily az a
different user:

zermname I
FPazsword I

Ok I Cancel |

If the login was successful the new rights will take effect immediately.
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5.4.6 Revert to first user
If you want to become again the user who started the software, select Options > User Management > Revert o First User.
5.5 Manage calibration data

The Calibration Management menu provides options to transfer calibration settings and other software settings from one computer
to another, using a “Setup Disk”. This is useful when the instrument is connected to a new computer. The “Setup Disk” can be

any storage device (e.g., USB stick).

Note: It is not necessary to use a “Setup Disk” when the software is updated to a new version. Calibration settings will be

retained.

Warning: A “Setup Disk” that is created for one instrument should never be used with another instrument, as this may result in

damage to the instrument.
5.5.1 Save calibrations on setup disk
To create a “Setup Disk”:

1. Select Options > Calibration Management > Save calibrations on setup disk.

Select the robat far which you
wish to expart calibration

QlAgility

Save Cancal |
Select Connected Robat |

2. The “Calibration Settings” dialog box will appear. Ensure that the displayed serial number matches the serial number of the

|

instrument that is connected. Click on the Save button to continue.
T

Save Calibration Settings as

Save i [ Data ] e@ekmE-

|Logs
|ZiReports

|CsupportPackages

File name: [Caliration Settings [Q1agiiy] (20.10.2008125 = | Save |
Saveastype:  [Robotics Calirations (“mi] | Cancel

4

3. A default filename and location will be supplied. If desired, these can be changed.

4. Click on the Save button. The current calibration settings are now saved on the “Setup Disk” and can be transferred to

another computer.
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5.5.2 load calibrations from setup disk
To transfer calibration settings from a “Setup Disk” to a different computer:

1. Select Options > Calibration management > Load calibrations from setup disk.
Select Calibration Settings File 2lx|
Loskin; [ Data =« ® e E-

|)Logs
| Reports
|0 SupportPackages

File name: [ | Open |
Fies ol e [Fiobatics Calbations (*smi] = Cancel

™ Open &5 read-only

4

2. Select the file that contains the saved calibration settings. Click on the Open button.

3. If the instrument has existing calibration settings, the following dialog box will appear.
aracen

2 A calbration already exists For this robot (Qlagiity), Do yvou wish to
\‘/ avermrite k7

I

4. Click on the Yes button to overwrite the existing calibration settings.

5.5.3 Delete multiple calibrations
To delete existing calibration settings:

1. Select Options > Calibration management > Delete multiple calibrations.

2. The “Delete Multiple Calibrations” dialog box will appear.

B Delete Multiple Calibrations 3

NOTE
calib

Select Calibrations tobe Deleted ———————————————

I Flte Heinht Calbrations
™ Flate Pasition Calibrations
™| Tip Ejector Cafibration

™ Wolume Calibrations (R esst Defaults)

Cancel | Delete |

3. Select the calibration settings to be deleted.

4. Click on the Delete button. The selected calibrations will now be deleted.
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5.6  Configure run settings

The Run settings menu provides options to configure a range of pipetting functions. The default run settings are the recommended

settings. However, in some circumstances it is useful to adjust the run settings.

The default run settings are as follows:

Level Sensor On

Error Mode Interrupt run on all errors

Pipetting speeds 150 pL/second for all liquid groups, except 70 pL/second for viscous reagents
Standard extra volume 50 pL

Master mix extra volume 30 pL minimum extra volume, plus 1 plL extra volume per reaction
Air volumes 7 pL

Tip re-use Use each tip for one operation only

5.6.1 Configure tip air intake
To configure the tip air intake:

1. Select Options > Run Settings > Configure tip air intake.

2. The “Air” dialog box will appear.
[Mai
— Air Yolume oK

These values contral the: amaount of air that
iz taken up by the pipetting head before Cancel
taking liquid from the plate specified:

Samples: I?—EI ul
Fieagent: l?—E pl
Standards: |7—E| ul
Diluent and master mix: l?—E ul
Intermediate reactions: |7—E| ul

Restore Defaults |

3. Enter the air volume in the boxes next to Samples, Reagents, Standards, Diluent and master mix, and Intermediate

reactions. Alternatively, to return to the default air volume settings, click on the “Restore Defaults” button.

Note: Larger air volumes may be beneficial when pipetting viscous liquids. Smaller air volumes may be beneficial when

pipetting smaller volumes, or when dispensing into small tubes.

4. Click on the OK button to return to the main software window.
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5.6.2 Configure pipet speed

To configure the pipetting speeds:

1. Select Options > Run settings > Configure pipette speed.

2. The “Configure Pipetting Options” dialog box will open.

B Configure Pipetting Options E x|
~ Sample speed ~Diluent and master mi sp ok
20 W/sec Cunent speed: 150 plésec 150plisee | | 20plisec Current speed: 150 pl/zec 150 pl/sec =
J Cancel
 Rieagent speed (nomal) teaction spesd
20 plisec Curtent speed; 150 plésec 160 fsec | | 20plsec Current speed: 150 pl/sec 150 pl/sec
~Rieagent speed [: )
20 plfsec Cunent speed: 70 ul/sec 150 ulfsec
L
/J
- Standards speed Miing speed * .
20 /sec Curtent speed: 150 plésec: 150plisec | | 20plsec Current spesc: 150 pl/sec 150 pl/sec

possible miking.

ensure that the
J miging speed is set
to maKimun.

3. Leftclick on the sliders and drag to adjust the pipetting speed for a given liquid group. Adjust the mixing speed in the same

way.

Note: When pipetting a viscous liquid it is recommended to select a slower pipetting speed than the default value.

Sample speed

Reagent speed

(normal)

Reagent speed

(viscous)
Standards speed

Diluent and master

mix speed

Intermediate reaction

speed
Mixing speed

Defines the aspirate/eject speed when pipetting samples.

Defines the aspirate/eject speed when pipetting normal reagents.
Defines the aspirate/eject speed when pipetting reagents which have been defined as
viscous.

Defines the aspirate/eject speed when pipetting standards.

Defines the aspirate/eject speed when pipetting diluent and master mix.

Defines the aspirate/eject speed when pipetting to and from reaction wells.

Defines the speed of all mixing operations.

4. Click on the OK button to return to the main software window.

5.6.3 Set master mix extra volume

Extra master mix is required to account for evaporation and pipet loss during reaction setup. The master mix extra volume is

defined by a minimum volume, plus an additional volume per reaction. The total volume is calculated by the software and

rounded up to the next whole reaction.

Adjusting the minimum extra volume and per-reaction volume from their default settings can be useful when preparing master

mix for manual PCR setup, or when preparing master mix for PCR setup at a later time.
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To change the master mix extra volume settings:

1. Select Options > Run Settings > Set master mix extra volume.

2. The “Master Mix Extra Volume” dialog box will appear.

@Master Mix Extra ¥olume

Extra b aster Mix iz required to account for evaporation and tip
lnszes during construction and aliquotting. The master mix extra

wolume iz specified az a minimum amount pluzs an additional

amount per reaction. The total master mix extra volume prepared Cancel |
depends on the number of reactions, and iz rounded up to be an

integral multiple of the per-reaction master mix volume.

Minimum extra volume requined. ISD E pl
Recommend at least 30pl.

Per-reaction extra valume required. |-| E ul
Recommend at least 10l per reaction.

Minimum extra Defines the additional volume of master mix which is prepared.

volume required
Per-reaction volume Defines the additional volume of master mix which is added for each reaction.
3. Adjust the minimum exira volume and per-reaction volume.

4. Click on the OK button to return to the main software window.
5.6.4 Set standard extra volume

When preparing standard dilutions, extra volume is required to account for evaporation and pipet loss. Changing the standard
extra volume from the default sefting can be useful when preparing standard dilutions for manual PCR setup or for PCR setup at

a later time.
To change the standard extra volume:

1. Select Set standard extra volume from Options > Run settings.

2. The “Standards Extra Volume” dialog box will open.

Standards Extra ¥Yolume x|

Enter new standards ‘extra’ volume [pl]. Thiz determines oK.
the additional volume made for each standard dilution -

concentration prepared by the robot. |t does nat affect e |
volurnes for premade standards or the initial undiluted
standard in & robot prepared standard series.

3. Enter a new extra volume.

Minimum extra Defines the additional volume which is prepared for each concentration of the standard

volume required dilution.

4. Click on the OK button to return to the main software window.
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5.6.5 Set concentration unit

A concentration unit can be assigned to make concentration values in the run more meaningful when presented in forms and in

reports. The assigned unit does not change the way in which concentrations are handled or constructed.

et Concentration Unit

— Settings
Concentration describes a ratio of some quantity of interest per unit volume in a

well containing zample, standard or reaction liquid.
® " H Cancel |

The zelected concentration unit is min-specific and will appear in well content
detailz and reports [both pre and post-n).

Concentration [product amount per unit): Idefault [nore] j

Cuztomn unit test: I

The available concentration units are:

Default (none) — no concentration unit
Copies/ pl (copies per microliter)
Copies/mL (copies per milliter)

% (percentage)

IU/pL (international unit/microliter)
IU/pL (international unit/milliliter)
ng/plL (nanogram/microliter)
pg/pL (microgram/microliter)
mg/mlL (milligram/milliliter)

pg/ml (picogram/microliter)

$/pL (dollars/microliter)

Custom (user-defined)

5.6.6 Allow use of multiple reagent volumes
When activated a tick is visible.

If activated, the user sees the advanced reagents table in the reaction configuration form. This allows the user to configure the

volume of a reagent for each reaction separately (instead of using the default volumes).
If deactivated, the user sees the simple reagents table in the reaction configuration form.

If multiple volumes for at least one reagent are used, and the user tries to deactivate the option, a message box appears:

oeen E

2 At least one reagent is used with non default volume, Do you want ta reset al

reagents ko their default volume?
Mo
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Click Yes to reset all used volumes of all used reagents in the current protocol to the reagent’s default.
Click No to keep the option activated. No volumes will be changed.

5.6.7 Set default file location

The default file location for all saved files is C:\Program Files\QIAgility\Data. Run files are stored in this directory. This directory

contains three subdirectories — Logs, Reports, and SupportPackages. See Section 4.7 for more details about these subfolders.

To create a new default file location:

1. Select Options > Run settings > Set default file location.
21|

Please select a default Folder location For storage of runfiles,
reparks, logs and other user data,

B3 qlAgiity |

-

{L3) PresetMasterMix

P2 MPratarcols =
4] | ¥

cocel_|

2. Browse for a new folder location.

3. Click on the OK button to continue. The subdirectories will automatically be generated in the new file location.

5.6.8 Configure system color
To configure the system colors:

1. Select System color configuration from Options > Run settings.

2. The “System Color Configuration” dialog box will open. There are 3 tabs — Sample Colours, Liquid Colours, and Selection

Colours.
Sample Colours Enables configuration of sample colors.
Liquid Colours Enables configuration of liquid/reagent colors.
Selection Colours Enables configuration of colors that represent a liquid function and that represent members

of a sample bank. In addition, colors used for selection and highlight indications can be

configured.
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Sample Colours

lor Configuration

Liquid Colars: I Selection Colars |

e

=lo |

Liquid Colours

Selection Colors |

Sample Colors ¢ Liquid Calars

Empty Sample
Empty Tip

B0 ul Tip

200 Tip
Diluent

Master Mix

Prremix Master Mix

Reagent
Standard 1
Standard 2
Preload Liquid

[ ] wiaste troughswell

Color Liguid ¢ |
Mo Liquid

=10l |
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Selection Colours

Esystem Color Configuration - |EI 5[

Sample Colars | Liquid Calars @ !

Color [Selection #3
[ ] Selection
[ ] Howvering
Indicate Target
® Indicate Source
[ ] Fieaction Liguid
[ ] Reaction Sample Bank

Reaction Target |

e || 2]

Enables selection of a color.

L")

i &
5
e

Adds selected color.

Deletes selected colors.

Resets all sample colors. Click on the “Yes” button to continue.

Refreshes the colors displayed on the software worktable according fo the current seftings.

Opens color theme.

v 2 © a8 8

Saves color theme.

<

Cloze Closes and applies updated colors.
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5.6.9 Adjust liquid leveltracking options
To adjust liquid leveltracking options:
3. Select Options > Run settings > Use liquid level when pipetting?.

Configure tip air inkake, ..
Configure pipette speed... =

Use liquid level when pipetting? Do not use liquid level

Tip Info
To modify tip availabilit,

Ignore errors during run? by Detect liguid level using sensor
Set master mix extra volume. . Use liquid level estimate
Set standard extra volume... [

Set kip usage options...

L
L .
=t defanlk File Incakion. . - Tip Type Ay

4. Select 1 of the 3 options — Do not use liquid level, Detect liquid level using sensor, or Use liquid level estimate. The Use
liquid level estimate function is intended for use when the level sensing function cannot be used (i.e., if the liquid is covered

with foil, or if the liquid is non-conductive).

Detect liquid level using  Instructs the instrument to use the liquid-level sensor to track the liquid level. See Section 3.3.

sensor

Use liquid level Instructs the instrument to use liquid-level estimate to track the liquid level. See Section 3.3.

estimate

Do not use liquid level The instrument performs pipetting operations at the height calibration position for the
plate/tube.

Note: These options are disabled if a Q Protocol is loaded and locked.

Warning: Do not use liquid level is not recommended for general use because liquid is more likely to be retained on the tip
exterior. Pipetting accuracy and precision may therefore be compromised when using this option. This option is intended

for use only in exceptional circumstances.

Note: For correct function of the liquid-level sensor, it is essential that the plates that are physically located on the instrument

worktable are correctly assigned in the software.

Note: The Use liquid level estimate function relies on the assumption that source wells are initially supplied with the volume
of liquid that has been calculated by the software. Overfilling the source wells can cause excess liquid to be retained on the

tip exterior. Underfilling the source wells causes insufficient volumes to be aspirated and then pipetted.
5. Atick will appear next to the option that has been selected.

Note: The global liquid level tracking options defined here can be overwritten locally per plate segment. (See also “Set liquid

level mode for segment” in Section 5.7.1.)
5.6.10 Set liquid-level tracking error level

If a tube contains insufficient liquid to complete a reaction setup, an error message will appear. User intervention will be required

to continue with the run.

However, if sample availability is limited, it may be desirable for a tube to contain less liquid than the detection limit. If the default
setting is enabled (i.e., “Do not ignore errors”), an error message will appear every time an aliquot is taken from the tube. To

avoid the need for user intervention every time an aliquot is taken, a different error level can be selected.
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To set the liquid-level tracking error level:

1. Select Options > Run Settings > Ignore errors during run?.

Configure tip air intake. ..
Configure pipette speed. ..
Use liguid level when pipetting? 3

Ignore errors during run? ]

Set master mix extra volume...

Set standard extra volume. ..

Tip Info
12 To modify tip availability
right-click menu to alter

Y LI R T

w Interrupt run on all errors
Inberrupk run on serious errors
Ignore all errors

Set tip usage options. ..
l L ] .
Sk defanlt File lnrakinn. .. - Tip Type Ay

2. Select 1 of the 3 options — Interrupt run on all errors, Interrupt run on serious error, or Ignore all errors.

Interrupt run on all

errors

Interrupt run on

serious error

Ignore all errors

This is the default error level. All liquid-level tracking errors are reported during a run and

user infervention is required every time an error occurs.
User intervention will be required for system errors, but not for errors caused by insufficient
liquid.

All level sensing errors will be ignored.

Note: These options are disabled if a Q Protocol is loaded and locked.

3. A tick will appear next to the option that has been selected.

Note: All errors are reported in

disabled.
5.6.11 Set tip usage options
Tip reuse can provide a significant
To configure tip usage:

1. Select Options > Run Settings >

the postrun report, regardless of which liquid-level tracking error is selected. This cannot be

reduction in the number of tips which are used during a run.

Set tip usage options.

2. The “Tip Usage” dialog box will appear.

=¥ Tip Usage

— Setting:

bt will uze large numbers of tips for all operations increasing
cost and run completion time:

Maximurn number of bmes to re-use tips? il El
W Allow multiple ejections from a single liquid pickup?

wells]?

Multi-Eject Settings |

Allow multi-dispensing to non-emply wells by tips contaminated
[~ with existing target well contents [without contaminating source

e e o - Cancel
Will use one tip for each take/eject cycle, Gives highest precision,

un

Use each tip for one One tip will be used for each aspirate/eject cycle. This option gives the highest accuracy

operation only and precision, but requires a large number of tips. Run duration will be increased.
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Re-use tips where Tips will be reused where possible. More than one aspirate/eject cycle will be performed
possible using the same tip. Run duration will be decreased, but accuracy and precision will be

compromised.
Maximum number of Defines the maximum number of times tips are reused. This option is only available when tip
times to re-use tips reuse has been selected.
Allow multiple ejections  Select to allow multiple liquid ejections from a single aspirate.

from a single liquid

pick up?
Allow multi-dispensing Allows multi-ejection into wells which already contain liquid. This is only allowed where
to non-empty wells by cross-contamination would not occur.

tips contaminated with
existing target well
contents (without
contaminating source

wells)?

Multi-Eject Settings Opens the “MULTI-EJECT options for Application Settings” dialog box, which enables multi-

eject options fo be configured.
Note: These options are disabled if a Q Protocol is loaded and locked.
3. Select Use each tip for one operation only, or select Re-use tips where possible from the drop-down menu.
4. If tip reuse has been selected, define the Maximum times to re-use tips.

Note: Tip reuse lowers accuracy and precision due to retention of liquid on the tip interior and exterior. It is therefore

recommended that a fip is reused a maximum of 8 times.

5. If desired, select the multi-ejections and multi-dispensing options. If Allow multi-ejections from a single liquid pickup? is
selected, the Multi-Eject Settings button becomes an option. Click on this button to configure multi-eject options. See

Section 5.6.12 for more details.

6. Click on the OK button to return to the main software window.
5.6.12 Configure multi-eject options

1. Select “Options/Run Settings/Set tip usage options”.
2. The "Tip Usage” dialog box will appear. See Section 5.6.11 for more details about configuring tip usage options.

3. Select “Re-use tips where possible”, or “Use each tip for one operation only”, and then click on the “Multi-Eject Settings”
button.

QlAgility Version 4.18 User Manual  06/2023 75



4. The “MULTI-EJECT” dialog box will open.

gMULTI—EJEET options for Application Settings ﬂ

— Multi-Eject Dptions

o

LCancel

Initial E jection Yolume
& Apply Detault |nitial Ejection Yolumes

™ Specify Initial Ejection Yolume

Default Initial Ejection Yolume using a 50 pl Tip: 1 pl
Default Initial Ejection Volume using a 200 pl Tip: 4 pl

Additional Extra Volume: |1 E u

to zero may reduce precision.

MOTE: Select the amount of additional extra liquid to aspirate. Setting this

Use air on multi-eject

Apply Default Initial
Ejection Volumes
Specify Initial Ejection
Volume

Additional Extra

Volume

Select to blow out air on the final ejection. This limits accumulation of liquid on the tip interior.
This is a default sefting when tip reuse is selected, but is an optional setting when single tip
usage has been selected.

Select to apply default initial ejection volumes (i.e., 1 pL for 50 pL tips, and 4 pL for 200 plL
tips).

Select to specify initial ejection volumes. The initial ejection volume is the volume that is

aspirated and ejected into the source well before ejecting into target wells starts.

Use this option to specify the extra volume to aspirate.

5. If tip reuse is disabled (i.e., each tip will be used only once), deselect Use air on multi-eject.

6. Select either Apply Default Initial Ejection Volumes, or select Specify Initial Ejection Volume. If Specify Initial Ejection Volume

is selected, define the initial ejection volume.

7. Define the Additional Extra Volume.

Note: Setting this value to zero may reduce precision. It is recommended to set this volume to half the volume of the aliquot.

5.7  Define worktable setup

5.7.1 Plate operations

The plate operations menu provides options to change plate type, change plate function, manage tip availability, and manage

sample banks.

{no options available)

Set liquid level mode For segment  k

Toggle Image
Toggle Zoom

Delete Calibration Data

“hange plate tvpe
Change accessory
Change plate Function »
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(no options available)

Set liquid level mode for

segment

Toggle Image

Toggle Zoom

Delete Calibration data

Change plate type

Change accessory

Change plate function

When the selected plate or segment has Tip, Reaction, Mix, or Sample function, further options will

be available in this panel. See Sections 5.7.2, 5.8.1, and 5.9.4 for further details about these options.

Enables the method of tracking liquid level to be selected for a specific plate/segment. All other
plates/segments, unless otherwise defined using this function, will use the method that is defined in
the Options menu. See Section 5.6.9 for details about how to configure the liquid-level tracking

options from the Options menu.

Click to toggle between an image and a schematic of the current plate type. This option has the

same function as the Switch plate button.

Click to toggle between an enlarged view and a normal view of the current plate type. This option

has the same function as the Zoom plate button.
Deletes all calibration settings associated with the plate.

Opens the “Plate configuration” dialog box, which enables the plate type and the tubes associated

with a plate to be changed. See “Changing the plate type” in this section.

Opens the “Select Accessory” dialog box, which enables addition or removal of a special accessory

from the worktable. See “Adding/removing an accessory” in this section.

Enables the plate function to be changed. A tick will appear next to the plate function that has been

selected. See “Changing the plate function” in this section.
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“Plate configuration” dialog

= 2
¥ Plate Configuration

Select Flate Type: [

box

Xl

ok

~Plat Usage Option:
Pielte Oider: [1/erica

Select the item that most closely matches the plate to be used:

Cancel

Segmentalion: [4 ., 8wel Segmerts

16 % Gieneric 20041, 16 % Generic 1.5ml Tapered Tubes
16 1 Gienerio 2004, 16 % Generic 2l Free Standing Tubes

16 % Generic 20041, 16 % Roche COBAS AnplPrep 1.5ml Scie
16 » Gieneric 20041, 4 « fuygen 1 6mi Free Standing, 2 500
16 % Gieneric 200414 1 Aupgen 1 5mi Free Standing. ¢ » 500
16 % Generic 200ul, 4 x Generic 2l Free Standng, 4 5004 |
16 « Gieneric 200ul, & w 5004 Intemal Vial Free Standing, & (
16 % Gieneric 2001, 8 1 Aupgen 1.5m Free Standing, B x Gene
16 # Gienerio 2004, &  Asygen 2mi Fres Standing, & » Generi
16 % Gieneric 2001, 8 y Generic 2l Free Standing, & Generi

DIAGEN 2ml Free Standing,
ding 8

200 AGEN 2ml [
200y, 8 # QIAGEN 2ml Free Standing, 8 Root
16 % QIAGEN 200p!, 8 % QIAGEN 500yl Intemal Vial Free Star

16 % Generic 1.5ml Tapered, & x Generic 2ml Free Standing Tra

16 « QIAGEN 200y, 8 = QIAGEN 500y Internal Vial Free SIarLI

Labeling and Well Display Order
Defaul, Ordered by Character Label

|
]
|

~Selected Plate

Desciption: 16 x QIAGEN 200yl, 8 x QIAGEN 2ml Free
Standing, 8 x QIAGEN 1.5ml Tapered
Tubes - Pipette: Vertical; Segmentation: 4
* 8 Well Segments: Labelling: Default.

£

|

Plat= ID: StdReagent_new
Segment Set ID: 16
RGNT_16_200_GENERIC_8_2ML_QIAGEN_8_1500_QIA
GEN_9018951

Manufactrer: QIAGEN

Consumable Part Number:

Fequired Adaptor: Reagent Block, 16x0.2ml PCR
8x2ml/1.5ml Flat/Tapered

Adaptar Part Number. 9018951 [Corbett: 0004) Filter to:

¥ OIAGEN
¥ Other
I~ Tips

Reagent bloc{ 7}

™ Favoites
[~ Calibated

AddFavarte
Remove Favorite:
Mors Info

.
.
.
.
.
.
.
0
.
.
.
.
.
.
.

2o

Select Plate Type

Plate

Pipette Order

Segmentation

Labelling and Well
Display Order
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Enables the plate type to be selected from the drop-down menu (e.g., Rotor-Gene, Standard 96 Well).

Plates which match the selection will be listed in the “Plate” panel.

Lists plates that match the plate type selection in the Select Plate Type drop-down menu. Select a plate

from this list to view an image of the plate, a plate schematic and Selected Plate Information.

Enables the pipet order to be selected from a drop-down menu. Available options vary depending on

the selected plate type.

Enables the number of segments on the plate to be selected from a drop-down menu. Available options

vary depending on the plate type.

The segmentation groupings are displayed in the plate well layout diagram according to the selection

made.

This determines the sequence in which wells are displayed in the sample data grid (i.e., “Label
Sequence” or “Pipetting Sequence”). Each plate type has a specific ‘pipetting’ order and specific
“label” order. Where these are different (e.g., vertical pipetting order and horizontal label order), the
sequence in which wells are listed in the grid changes according to the well display order selection.
This function is useful, for example, when it is convenient to dispense liquids by column (vertical

pipetting order), but fo export the data by row (horizontal label order).
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Filter to: Enables the list of plates in the Plate panel to be filtered. Select QIAGEN, Other, Tips, Favorites, and/or
Calibrated. If QIAGEN is selected, only QIAGEN plate types will be displayed in the “Plate” list.

Add Favorite Adds a selected plate type to a list of favorite plate types.

Remove Favorite Removes a selected plate type from a list of favorite plate types.

More Info Opens the “Plate Information” dialog box, which displays more information about a selected plate type.
Changing the plate type

Before starting a run the correct plate type must be selected in the software. The physical plate type in use at a given location on
the worktable must match the plate type selected for this location in the software. This ensures that the software uses the correct

calibration settings for that plate.
To change the plate type in the software, proceed as follows:

1. Position the cursor above the plate that is to be changed. Right<click on the mouse. The plate operations menu will appear.
. Select Change plate type from the plate operations menu.
. The “Plate Configuration” dialog box will appear.

. Select a plate type from the “Select Plate Type” drop-down menu. The “Plate” list will be automatically updated.

o N O N

. Select a plate from the “Plate” list.

Note: If you cannot find a plate type that matches, or is very similar to the plate that you are using, please contact QIAGEN

Technical Services.

6. Click on the OK button to continue.

Changing the plate function

Before starting a run the correct plate function must be selected for each plate on the worktable. Some plates (e.g., Reagent
Blocks) have more than 1 segment. Different plate functions can be selected for different segments of the same plate. There are

7 plate functions — Sample, Reagent, Mix, Reaction, Standard, Diluent, and Tip.

Sample A sample is always added to a reaction last. Samples must be assigned to a sample bank before

they can be used in a reaction setup.

Reagent A reagent can be combined with other reagents to make a master mix, or added individually to a

reaction. Reagents are always dispensed to reaction wells before samples.
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Mix A master mix is a pooled group of reagents that can be added to a reaction plate. Master mix is

always added to a reaction first because it normally constitutes the largest volume of the reaction.
Reaction A reaction is the destination for the samples, master mixes, and reagents. Reactions can be
assigned to a sample bank — this enables a reaction to be a component of a different reaction. A
reaction that is a component of another reaction is called an ‘Intermediate’ reaction.
Standard A standard is a dilution series with known concentrations. Standards are treated like samples.
Diluent Diluent is used to dilute the master mix, dilute samples, and create standard dilution series. It is

assumed to be PCR-grade water. A diluent can only be assigned to a single well segment. Only 1

diluent tube can be assigned in a run file.
Tip The plate contains a Tip Rack Holder and tips. Tips must be set to available or unavailable.

To change the plate function:

1. Rightclick on the plate, or the segment of a plate, that is to be changed. The plate operations menu will appear.
2. Select Change plate function. The available plate functions will appear as a submenu.
3. Select a plate function. A tick will appear next to the function that has been selected.

Note: If the selected plate type is a Tip Rack Holder, the only available function for the plate will be Tip.
Adding/removing an accessory
If required, an accessory (e.g., cooling block) can be added under a plate.

Note: Use of an accessory affects the plate height. Plate height calibration must therefore be performed with the plate and

accessory together.
To add or remove an accessory:

1. Right<click on the plate where the accessory is to be added/removed. The plate operations menu will appear.

2. Select Change accessory. The “Select Accessory” dialog box will appear.

B Select Accessory x|
Plates vith acosssories have diferent calbralion values (o standard i
plates =
Cancel

Manutacturer QIAGEN
Part Number: S020284/3020286 (CR 0302/0306]

QlAgility Version 4.18 User Manual  06/2023 80



3. Select the required accessory from the drop-down menu. An image of the accessory will appear. Alternatively, to remove

an accessory, select No accessory from the drop-down menu.

4. Click on the OK button to return to the main software window. A plate which is associated with an accessory will now have

a colored background in the main software window.

Set liquid level mode for segment

1. Right<click on a plate or segment with Sample or Reaction function.
2. Select Set liquid level mode for segment. A submenu will appear.

Do not use liquid level The instrument performs pipetting operations at the height calibration position for the

plate/segment.

Detect liquid level using  The instrument performs pipetting operations for the plate/segment using the liquid-level

sensor sensor. See Section 3.3.

Use liquid level The instrument performs pipetting operations for the plate/segment using the liquid-level
estimate estimate function. See Section 3.3.

Use default liquid level The instrument performs pipetting operations for the plate/segment using the method that has
mode (Tip Sensor) been defined in the Options menu. See Section 5.6.9 for more details about how to configure

liquid-level tracking options from the Options menu.

3. Select 1 of the 4 options for detecting the liquid level from the submenu. A tick will appear next to the method which has

been selected.

Note: All other plates/segments, unless otherwise defined using this function, will use the method that is defined in the
Options menu. See Section 5.6.9 for more details about how to configure liquid-level tracking options from the Options

menu.
5.7.2 Setting tip availability

Tip availability must be set for every plate which has Tip function. This enables the software to determine exactly where tips are
available on the instrument worktable. If this information is incorrect, the run will not proceed correctly because the instrument

may attempt to pick up a tip from a location where no tip is available.
To change tip availability:

1. Leftclick on a plate that has Tip function to select all the tips within that plate. Alternatively, to select a group of tips, left-

click on the plate and then drag. Selected tips will be highlighted red.
Note: To select individual tips, leftclick on an individual tip and proceed as for a group, or use the tip availability short cut.

Tip availability short cut Hold down “Alt” and lefi-click on individual tips to switch the tip between available and

unavailable.
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2. Right<click on the plate. Tip availability options will appear in the upper panel of the plate operations menu.
Fa e e aa I Il o coocooooa
| ' get selected tips ko ‘Available’

| Set selected tips to 'Unavailable’

v Setallkips on current plate to ‘Available’
- all tips on current: plate to 'Unavailable'

Set all tips on all plates to ‘Available'

Set all tips on all plates to 'Unavailable'

Toggle Image
Toggle Zoom

Delete Calibration Data

Change plate bype
Change accessory

Change plate Function 3
Set selected tips to Sets a group of tips to “Available” or “Unavailable”. Before using this option, tips must be
“Available” /- selected.

“Unavailable”

Set all tips on current Sets all of the tips to “Available” or “Unavailable”.

plates to “Available” /-

“Unavailable”

Set all tips on all plates  Sets all tips to “Available” or “Unavailable”.

to “Available” /-

“Unavailable”
3. Select one of the options to make the selected tips “Available” or “Unavailable”. “Available” 200 pl tips are shown in dark

red on the software worktable, “Available” 50 pl tips are shown in dark blue, and “Unavailable” tips are shown in white.

4. Only 1 group of tips can be selected at a time. To make more than one group of tips “Available” or “Unavailable”, repeat

steps 1-3 for each group of tips.

5.8 Managing samples
5.8.1 Managing sample banks

A sample bank is a collection of wells on a given plate or plate segment that is grouped and treated as a single unit for liquid

handling operations.

Individual “Sample” wells must be assigned to a sample bank before they are available for use in a reaction setup. “Reaction”

wells can also be assigned to a sample bank — this enables a reaction to be used as a component of a second reaction.

Sample banks are managed using the “Update Sample Bank” dialog box. The “Update Sample Bank” dialog box can be
accessed from the plate operations menu, or from the “Sample” right-hand pane. See Section 5.9.5 for more detailed information

about managing sample banks using the “Sample” righthand pane.
Rightclick on a “Sample” or “Reaction” plate to view sample bank options in the upper panel of the plate operations menu.

Select any of these options, apart from Toggle sample bank list and Set preload volume, to directly display the “Update Sample
Bank” dialog box.
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Add selected wells to sample bank. ..

Add First 'n' wells on plate ta sample bank...
Add all wells on plate ko sample bank, ..
Add list of wells on plate bo sample bank. ..
Remove selected wells from sample bank...
Toggle sample bank list

Set preload volume. .,

Set liquid level mode For segment

Toagle image
Toggle zoom

Delete calibration data

Change plate type
Change accessory
Change plate function

Add selected wells to

sample bank

Add first ‘'n” wells on

plate to sample bank

Add all wells on plate to

sample bank

Add list of wells on plate

to sample bank

Remove selected wells

from sample bank

Toggle sample bank list

Set preload volume

Opens the “Update Sample Bank” dialog box and enables selected wells to be added to a new or existing

sample bank.

Opens the “Update Sample Bank” dialog box and enables consecutive wells on a plate to be added to a new

or existing sample bank.

Opens the “Update Sample Bank” dialog box and enables all wells of the selected plate segment to be added

to a new or existing sample bank.

Opens the “Update Sample Bank” dialog box and enables a list of wells to be defined and added to a new or

existing sample bank.

Opens the “Update Sample Bank” dialog box and enables selected wells to be removed from an existing

sample bank.

Opens the “Sample Banks” panel of the “Sample” righthand pane. This option is only available when a
“Reaction” plate is selected. See Section 5.9.5 for more information on managing sample banks using the

“Sample Banks” panel.

Enables the user to enter the volume of liquids which have been preloaded into reaction tubes. This option is

only available when a “Reaction” plate is selected. Click on the OK button to continue.
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“Update Sample Bank” dialog box

N =8 update 5ample Bank

Filter Selection

x|
| |@ et Select Al Clear Al o R
T 3 o —— || ST
ket D’WEHSlﬂ—E % Use selected wells INSIDE ranas LCancel
Barks defined elsswhere Q)L clwele £ Use selected wells BUISTIDE range
— il lierla szl
(C1: Sample (200pl PCR tube, ic) (]
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IONONORORORONONCRORCRONY]
(CHONORONONCNONCRONCRONG]
(CHONORONORCNONCRONCRONG)]
(CHONORORONCHNONCRORCRONO)]

New Bank

Existing Bank

Banks defined elsewhere
Select all
Clear all

Range of wells

List of wells

Bank wells

Specify concentration

range
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Select to create a new sample bank. Insert a sample bank name. Sample bank names must be unique

within the run.

Select to modify an existing sample bank. Current sample banks that are defined for the selected

plate/segment are listed.

Lists all sample banks that are defined in the run file.
Selects all of the wells within the plate.

Deselects all of the wells within the plate.

Select to define a consecutive range of wells. Specify the “First well” and then specify the “Number of

wells”.

Lists the range of wells (e.g., A1-B1) that is selected. This list is automatically updated when the well
selection is changed. In addition, a list can be directly entered into this field to select wells. A list can

consist of more than one description (e.g., A1-B2, C2-C¢).
Click to view the existing wells in the sample bank. Wells are highlighted red.
Select to define a concentration range for the filler. Specify the “Min Concentration”, “Max

Concentration”, and whether to use selected wells “INSIDE” or “OUTSIDE” the defined concentration

range.
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Apply filter to selected Adds or removes samples from a sample bank, based on a defined concentration range. The filter is

wells immediately applied to the current selection.

Add Selection and Close  Adds selected wells to the sample bank. The “Update Sample Bank” dialog box will then be closed.

Delete Selection and Deletes selected wells from the sample bank. The “Update Sample Bank” dialog box will then be closed.

Close

Cancel Closes the “Update Sample Bank” dialog box.

More Opens the “Sample selection” and “Filter selection” panels, in addition to the “Sample Bank Name”
panel.

Less Closes the “Sample selection” and “Filter selection” panels.

Create a new sample bank

1. To select all of the wells within a plate, leftclick on a plate with Sample or Reaction function. To select a group of wells

within a plate, leftclick on the plate and then drag. Selected positions will be highlighted red.

2. Rightclick on the plate to view the plate operations menu. Select Add selected wells to sample bank. The “Update Sample

Bank” dialog box will open.
3. Select New Bank and enter a name for the new sample bank.

4. If desired, leftclick and drag on the plate schematic in the lower portion of the dialog box to modify the original well

selection. Alternatively, options in the “Sample Selection” panel and “Filter Selection” panel can be used to select wells.
5. Click on the Add Selection and Close button. The selected wells will now appear in color on the software worktable.

6. To add another group of wells to this sample bank, proceed as for “Modifying an existing sample bank”.

Modifying an existing sample bank

1. To select all of the wells within a plate, leftclick on a plate with Sample or Reaction function. To select a group of wells

within a plate, leftclick on the plate and then drag. Selected positions will be highlighted red.

2. Right-click on the plate to view the plate operations menu. Select Remove selected wells from sample bank. The “Update

Sample Bank” dialog box will open.
3. Select Existing Bank and then select a sample bank from the list.

4. If desired, leftclick and drag on the plate schematic in the lower portion of the dialog box to modify the original well

selection. Alternatively, options in the “Sample Selection” panel and “Filter Selection” panel can be used to select wells.

5. To add selected wells to the existing sample bank, click on the Add Selection and Close button. To remove selected wells

from the existing sample bank, click on the Delete Selection and Close button.
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5.9  View and edit information using the right-hand pane

Before setting up a reaction list, all plate functions must be configured. This can be done using the righthand pane. The right-
hand pane refers to the area on the righthand side of the software workspace. Leftclick on a plate in the main software window

to view information relating to plate function in the righthand pane.

A plate, segment, or well can have 1 of 7 functions — Tip, Standard, Reagent, Mix, Sample, Reaction, or Diluent. All functions,
except Diluent, have an associated righthand pane. See Sections 5.9.1 to 5.9.6 for more detailed information about these right-
hand panes.

When a run is in progress, a progress report is displayed in the righthand pane. See Section 5.9.8.

59.1 Tip

Tip availability is updated in real time while the software is operating, and is recorded when software is shut down. Tip availability
should therefore be correct when the software is restarted. However, correct tip availability should always be checked before

starting a run.

Two tip types can be used with the QlAgility — 50 plL and 200 pL. In the software worktable, 50 pl tips are colored blue, and
200 plL tips are colored red.

To view information about current tip availability, tip requirements, tip location and tip type, leftclick on a plate with “Tip”

function in the software worktable. The “Tip” righthand pane will appear.

“Tip" right-hand pane

il
To mody tip availabilly. select fips on tip plates in the main window and use the
right-click men to alter the status of the selected graup of tips. Select tips by
Ielt-cick-dragging the mouse: over a tip region. and shift: or chieft-clicking to
include non-adiacent tios in the selected roup. Atematively, alt+left-click a speciic
tip to toggle the avalabilty stalus of the individual ip

Tip Type Available Requied Enough Tips?
50y 83 0 Yes
2001 59 0 Yes

Location Capaciy Tips Remaining

Flate @ A1 2004 59
Plate (8 42 501 i
Plate @ B1 501 El

5.9.2  Standards
Standard dilutions can be prepared using the QlAgility, or a premade dilution series can be used. The default location for
standards is at the left of the Reagent Block. There may be more than one location for a standard dilution series, each of these

locations operates independently of other dilution series.

Standard dilutions are set up using the “Standard” right-hand pane. To view the “Standard” righthand pane, leftclick on any

plate or well with Standard function.
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“Standard” right-hand pane

[~ Standard Opi

ilise standard # v
Use pre-mised standard series? r

Standardname: [Starded1
Standard Series
tratng et i onimsr P [
[~ Standard Dilution Opt

Coneentration of first standard: 1 Set Custom Conc.

Enable miting duiing diutior? [V

No.dftines tomis dertand [
standard: El

Change tips after each diution? [V

Miimum volume required C— El
unused in reactions:

[ Standard D
Robot prepared standard is ot used in reactions. All wells are empiy.
[ [oi rate [ Concentration [water |Sample | Total

w [ | \ [0
a2 Tin 10 o1 opl
53 i 10 oo ol
a6 1 10 oom ol
85 Tin 10 00001 0l

Use standard? Select to use a standard. This makes other options in the “Standard” righthand pane available.

Use pre-mixed standard  Select if using a premade standard dilution series. The Set Custom Conc. button will become available.
series?

Standard name Displays the default name of the standard dilution series. If desired, click in the box and enter a

different name.

No. of dilution Defines the number of dilution concentrations.
concentrations

Concentrations of first Defines the concentration of the first standard.

standard

Enable mixing during Enables mixing during dilution.

dilution

No. of times to mix Defines the number of times to mix diluent and standard.

diluent and standard

Change tips after each Instructs the instrument to change tips after each dilution.
dilution?
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Minimum volume to Sets the minimum volume of standards to create if the standards are not used in any reactions. This
prepare (if unused) allows the user to create one set of standards that can be used for multiple subsequent runs. The
minimum volume will be the volume entered, plus the volume that is defined in the “Standard extra
volume” field in the Run settings menu. This value is ignored when the standard is used in at least

one reaction configured in the run.

Set Custom Conc. Opens the “Custom Concentration” dialog box, which enables the concentration of dilutions to be
defined. Click on a cell in the table to directly enter a concentration. Alternatively, click on the Restore

Defaults button to return to the default concentration values. Click on the OK button to continue.

Using a premade standard dilution series

1. Leftclick on a plate or well with Standard function. The “Standard” right-hand pane will appear.
. Select Use standard? and Use pre-mixed standard series?.

. If desired, click in the “Standard name” field and enter a different name for the premade standard dilution series.

AN W N

. Enter the number of dilution concentrations. The “Standard Data” table will automatically be updated with default dilution

ratios and concentrations.

(@]

. Enter the concentration of the first standard. Press Enter to update the “Standard Data” table.

6. Individually click on cells in the “Standard Data” table in the “Concentration” column to enter the concentrations of the

premade standard dilution series.

7. After entering each concentration, click on the OK tab to automatically update the dilution ratios. Concentrations can also

be entered using the “Custom Concentration” dialog box, see below.

Note: Concentration values are assumed to be entered in a single unit common to all values in the run. The unit itself can be

defined as needed for the application. See Section 5.6.5.
Entering concentrations using the “Custom Concentration” dialog box

1. Click on the Set Custom Conc. button in the “Standard” right-hand pane. The “Custom Concentration” dialog box will

appear.

8 Custom Concentration:

Cancentration

i Ee

Restore Defaults

2. Individually click on cells in the table in the “Concentration” column and enter the concentrations of the premade standard

dilution series.

3. After entering each concentration, click on the OK tab to update the table. If desired, click on the Restore Defaults button to

return to the original default concentrations.

4. Click on the OK button.
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Preparing a standard dilution series using the QlAgility
Note: This function is only available if a diluent well is placed on the worktable.

1. Leftclick on a plate or well with Standard function in the main software window. The “Standard” righthand pane will

appear.
2. Select Use standard?. If desired, click in the Standard name field and enter a different name for the standard dilution.

3. Enter the desired number of dilution concentrations. The “Standard Data” table will automatically be updated with default

dilution ratios and concentrations.
4. Enter the concentration of the first standard. Press Enter to update the “Standard Data” table.

5. If a dilution series with varying ratios is required, the dilution ratios can be modified. To do this, click on a cell in the
“Standard Data” table and enter a different dilution ratio. Click on the OK tab to automatically update the concentration.
The diluent volume, sample volume and total volume columns are automatically updated when the standard is used in @

reaction.

6. Select Enable mixing during dilution? and enter a value for the No. of times to mix diluent and standard. It is recommended

that a minimum of 5 mixes is entered.

7. Standards are typically prepared using the same tip. If desired, each dilution can be prepared using a new tip. To select

this option, select Change tips after each dilution?.

8. Specify the “Minimum volume to prepare if unused”.
Alternatively, the dilution series can be set up from a list of concentrations. To do this:

1. Select Use standard? and Use pre-mixed standard series?.

2. Enter the list of concentrations, either using the “Custom Concentration” dialog box, or by entering the values directly into
the “Standard Data” list.

3. Dilution ratios will be automatically calculated.

4. Deselect Use pre-mixed standard series?.
See Section 5.6.4 for more details about setting the standards extra volume.

5.9.3 Reagents

The default location for reagents is on the right side of the Reagent Block. Some plates have several segments and therefore have

more than one option for the location of reagents.

Reagents can be added directly into reaction tubes, or can be used to make up a master mix, which can then be added to
reaction tubes. To improve precision and accuracy, it is recommended that reagents are added to a master mix, rather than
pipetted individually. When the per-reaction volume of reagent is <1 pL (i.e., outside the QlAgility pipetting range), the reagent

must be added to a master mix.
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Reagents are set up using the “Reagent” right-hand pane. To view the “Reagent” righthand pane, leftclick on any plate or well

that has Reagent function.

“Reagent” right-hand pane

Rieagent Op
(u‘se = v
 Reagen €
Oearomes | SetAlyokmes | e 2
Name [Det ol [visoous? _[is Count
I 10 Buffer 25 No )
) MgTi2 15 Ne 0
K TR 2 No 0
L Primer(fnd) 1 No 0
M Pimeres) 1 No 0
N Probe 1 05 No )
0 Prabe 2 05 Ne 0
3 Tag 025 e 0

Use reagents? Select to use reagents. Other options in the “Reagent” righthand pane will become available.
Clear Names Removes all reagent names from the “Reagent Configuration” table.

Set All Volumes Click to enter a new default volume for all reagents. Click on the OK button to continue.

Name Defines the name of the reagent. Names of reagents must be unique within the run.

Def. Vol. Defines the volume of reagent to be added directly to the final reaction. If the reagent is used in a

master mix, this per-reaction volume can be changed in the master mix component selection.

Viscous? Enables a reagent to be defined as viscous. If a reagent is defined as viscous, a lower pipetting speed
will be used.
Mix count Defines the number of times the reagent will be mixed at the start of the run. This ensures that reagents

are homogeneous.
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Setting up reagents

1. Leftclick on a plate or well with Reagent function in the main software window. The “Reagent” righthand pane will appear.
2. Select Use Reagents?. A default reagent setup will appear in the “Reagent Configuration” table.

3. Enter information into the “Name”, “Def. Vol.”, “Viscous2” and “Mix Count” columns. To do this, left-click on the individual
cells and enter the new information. For the “Viscous2” column, check the box to toggle between Yes and No. Then click on
the OK tab to update the table.

Note: If the default volume for a reagent is O pL, the reagent can still be used in the master mix component selection, but it
will not be shown in the reaction configuration.

4. When a reagent name is entered, the associated well will appear orange on the plate on the software worktable. If the
reagent name remains blank, the associated well will appear gray, and it will not be possible to use this reagent in a

master mix or reaction. If a reagent is used in a master mix or reaction, it becomes more strongly colored.
5.9.4 Master Mix
Master mixes can be prepared using the QIAgility, or a premade master mix can be used. Master mixes can be added to
reaction wells. By default, master mix is pipetted into a reaction well first, because it normally constitutes the greatest volume of
the reaction.
To prepare a master mix using the QlAgility, individual reagents and their volume per reaction must be defined. The order in
which the reagents are added to the master mix can also be defined. The software calculates the volume of reagent and diluent
required to make the correct volume of master mix.
If premade master mix is used, the user only needs to define the volume of master mix per reaction.
Note: Preset master mixes can only be loaded if they consist of maximal 16 ingredients.
Note: Commercially available master mixes are not premade master mixes because they require addition of primers. A
commercial master mix, and the individual primers, must be defined as reagents in the software and then combined into a master

mix by the QlAgility.

By default, master mixes are located on the Master Mix Block, but they can also be located on other plates. Master mixes are

set up using the “Mix” righthand pane. To view the “Mix” righthand pane, leftclick on any well with Mix function.
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“Mix” right-hand pane

M
Use Master bis? I
Uss pre-mised Master Min? [~

Master Mis name e
Mo. of times to mix before dispensing: [0 El

’r Fre-mived Master

\olume per sample: 0 El tl

Master

Configure Master Mix reagent names and default volumes from reagent’ sereen.
Val. of Master Mix per sample: 20 I
Tatal val. of Master Mix to make: 0 pl [unaiiquotted)

Totaleactians to prepare i unused) [0 Bl ewaiiwusesr

Waitfor confimalion afer adding finalingredient? [~

/it for confiimation after perfarming findl mix?— I

Mo of times to mik ech reagent ,—

P B
Ho. of times to mix at end:

° Load
(T TarguebE ] AdvstInseition Order Save

Source, [well [name [valume
1 Waler 07
Reogent block [standar & | 10K Bufer 25
Fieogent block [stander B | MaC2 15
Fieogent block [stander © | dNTP 2
Fieagent block fstandar D | Frimerlfwel 1
Fieagent block [stander £ | Primer(ev) 1
Fieagent block fstandar F | Frobe 1 05
Fieagen block fstandar G | Frabe 2 05
Fieagen block fstandar H | Tan [viscaus) 025

Use Master Mix? Select to set up a master mix. Options in the “Machine-mixed Master Mix” panel will be enabled.
Use pre-mixed Master Select to use a premade master mix. Options in the “Pre-mixed Master Mix” panel will be enabled.
Mixe

Master mix name Defines the master mix name.

Volume per sample Defines the volume of master mix per reaction.

No. of times to mix before Defines the number of times to mix before dispensing to each affected reaction plate segment.

dispensing:

Total reactions to prepare  Sets the minimum volume of master mix to create if the master mix is not used in any reactions in
(if unused) the run. This allows the user to create a master mix without assigning it to reactions. It can be used
as a premade master mix for multiple subsequent runs. Defines the volume in terms of the total
number of reactions. This value is ignored when the mix is used in at least one reaction configured in

the run.

Extra (if unused)? Indicates that when master mix is made without aliquoting to reactions, the total volume should
include the additional amount which is defined in the determined Master mix extra volume option
in the Run settings menu. This setting is ignored when the mix is used in af least one reaction

configured in the run.
Wait for confirmation Select to wait for confirmation after adding the final component of the master mix.

after adding final
ingredient?
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Wait for confirmation
after performing final

mix?
No. of times to mix each

reagent

No. of times to mix at end

Configure Mix

Adjust Insertion Order

Load

Save

Select to wait for confirmation after performing the final mix.

Defines the number of times that the master mix will be mixed after addition of each reagent. Mixing
maximizes recovery of reagent from the tip interior and equalizes the concentration of liquid

remaining on the tip interior with the liquid in the mixture.
Defines the number of times to mix after addition of the last reagent.

Opens the “Master Mix Component Selection” dialog box, which enables the master mix to be

configured.

Opens the “Master Mix Reagent Insertion Order” dialog box, which enables the order in which

reagents and diluent are added to the master mix to be adjusted.

Enables a user to select a saved master mix setup. Select the correct file and then click on the Open

button to continue.

Select to save the master mix setup. Enter a file name and a location, then click on the Save button.
This option is useful when the master mix is used regularly, but the sample and reaction configuration

changes.
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“Master Mix Component Selection” dialog box

®BMaster Mix Component Selection E x|
bhzke mi up to this volume (not including sample/NTC vohmel:  [29.25 m
Detault sample volume for this i 0 ul
Hoiw much reagent to manually inssit per reaction? ,U— ul # Pause robot o marialy |oad reagents sfter fnalinrediznt add=d
€ Additionlingredients are preloaded befare the run
Default reaction volume: e
- Component vol
Select reagents (and their volumes) to use in this mis. [vater volume is automaticaly calculated] Uss Al Use None
Flate Tuba Localion | Mame Juse?  [vol par Reaction
ater Yes 20

Reagent black [standa 1.5l tapered hinged 105 Buffer
Reagent block [standa, 1.6l tapered hinged MoClz
Reagent biock (standa 1 Gl tapered hinged dNTP
Reagent block standa 1.6l tapered hinged Primeffid)
Reagent block [standa, 1.5l tapered hinged Primerlrev)
Reagent black [standa 1.6l tapered hinged Probe 1
Reagent block [standa 1.6l tapered hinged Probe 2

Fleagent block (standa 1.5 tapered hinged Taq

Make mix up to this Defines the volume that the mix will be made up to.

volume

Default sample volume for Defines the default sample volume for this mix.

this mix

How much reagent to Defines the volume of reagent that will be manually inserted into each reaction.
manually insert per

reaction?

Default reaction volume  Defines the default reaction volume.

Pause robot to manually  Instructs the instrument to pause after the final component of the master mix has been added. This
load reagents after final  allows the user time to manually add more reagents to the master mix.

ingredient added

Additional ingredients are Defines whether additional reagents are added to the master mix before starting the run file.

preloaded before the run

Use all Selects all of the reagents for use in the master mix. All cells in the “Use2” column will be populated
with Yes.

Use None Deselects all of the reagents for use in the master mix. All cells in the “Use2” column will be populated
with No.

Plate Defines the plate type that the reagent is located in.
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Tube Defines the tube type that the reagent is located in.

Location Defines the location of the reagent on the plate.

Name Defines the name of the reagent.

Use? Defines whether the reagent will be used in the master mix.

Vol. per Reaction Defines the volume of reagent that will be used in each reaction.

Preparing a master mix for reaction setup

AN oW N

. Leftclick on the well in the Master Mix Block that will contain the master mix. The “Mix” righthand pane will appear.
. Select Use Master Mix?. Enter a name for the master mix in the Master Mix name field.
. Define the “No. of times to mix each reagent”, and the “No. of times to mix at end”.

. If desired, select Wait for confirmation after adding final ingredient? and Wait for confirmation after performing final mix?.

These options are useful if extra reagents need to be manually added to the master mix, or if the master mix needs to be

vortexed.

5. Click on the Configure Mix button. The “Master Mix Component Selection” window will appear.

6. Enter the master mix volume per reaction.

10.

11.
12.

. Enter the default sample volume. The total reaction volume will then be calculated and displayed. The total reaction volume

cannot be edited.

. Reagents are listed in the “Component volumes” panel. To add reagents, leftclick in a cell in the “Use2” column, then check

the box to select Yes, and then click on the OK tab. Alternatively, click on the Use all or Use none buttons to select all of the

reagents or to deselect all of the reagents.

. The default volumes in the “Vol. per Reaction” column are the volumes that have been defined in the “Reagent” righthand

pane. To change these volumes, leftclick on the corresponding cell in the Vol. per Reaction and enter a new volume. Click
on the OK tab. The diluent volume is automatically adjusted to make up the difference between the combined reagent

volume and the volume of master mix per reaction.
Note: Diluent will always be added, unless the reagent volumes add up to the desired master mix volume.

Click on the OK button to continue. Added reagents will be listed in the “Machine-mixed Master Mix” panel, in the order in
which they will be added to the master mix.

Click on the Close button. The corresponding well in the Master Mix Block will now be colored yellow.

To prepare another master mix, leftclick on a different well in the Master Mix Block and repeat the above procedure.
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Changing the reagent insertion order

Diluent is usually the component with the largest volume and is therefore, by default, added to the master mix first. However, the

insertion order can be adjusted.

Note: It is recommended that any reagents that contain detergent are added last. This limits the risk of froth forming on the surface

of the master mix.
To change the reagent insertion order:

1. Click on the Adjust Insertion Order button in the “Mix” righthand pane.

2. The “Master Mix Reagent Insertion Order” dialog box will appear.

&Master Mix Reagent Insertion Order LI

Use the up and down controls to adjust the order that

reagents will be ingerted inta the k aster Mix:

20 pl Diluent

2.5 pl 10 Buffer
1.5 pl MgCiz

2 dHTR

1 pl Primer(fud)
1 pl Primer(rev]
0.5 pl Probe 1
0.5 pl Probe 2
0.25pl Tag

Dn Moves the selected reagent down the list.
Up Moves the selected reagent up the list.
Close Closes the “Master Mix Reagent Insertion Order” dialog box.

3. Leftclick on a reagent in the list. Use the Dn and Up buttons to adjust the order of the reagents.

4. Click on the Close button.
Preparing master mix without reaction setup
Master mixes can be prepared without being assigned to a reaction. To do this:

1. Set up a master mix, as described in the “Preparing a master mix for reaction setup” section.
2. Define the total number of reactions to prepare, using the Total reactions to prepare (if unused) option.

3. If extra volume is required, select Extra (if unused)?.
Setting up a premade master mix

1. Leftclick on a well in the Master Mix Block. The “Mix” right-hand pane will appear.

2. Select Use Master Mix?, and then select “Use pre-mixed Master Mix?".
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3. Enter a name for the master mix in the Master Mix name field.

4. Enter the Volume per sample and the Number of times to mix before use. The corresponding well in the Master Mix Block

will now be colored green.
Loading a saved master mix setup

1. Click on the Load button in the “Machine-mixed Master Mix” panel.

Open... g 2]
Lookin [ PreselMasterbin ~| @k E-

2x Buffer (Dual Labsled Probe)
2K Buffer (Dye)

Labelled Dual Probes

ltime PCR (Dye)

|5 Realtime PCR Dual-labelled Probe
Standard PCR

File name: [ | Open

Flesoftpe | Master mis preset = Cancel

2. Select a file and then click on the Open button.

3. The “Reagent Selector” window will appear. The reagents are listed in the “Reagents” panel in white boxes.

‘ Please select the location of these reagents

double-click to reset:

10X Buf

MalCl2
M1 (5ml taperes

7

Pimer 2

Gener (B2 Tip (500l Conductive tp, QIAGEN) | T
oo
Foxe)
oo
e
oo
@ @
o

4. To assign a reagent to a location, leftclick on a reagent and drag it to the desired well on a reagent plate. Do this for all
the reagents. The process of assigning reagents fo locations can be intermitted and continued later. If the reagent locations
do not matter, click and drag the “Auto” white box to the desired reagent segment. Reagents will automatically be
assigned to a location. Selected wells will be highlighted red.

Note: Some reagent locations may already be in use by previously defined reagents. If the name of the reagent used in the
saved master mix setup is identical fo reagents already set up, these will automatically be allocated to those positions.

5. To reset the location of any reagent, double-click on a reagent in the list, then leftclick and drag again. Alternatively, click

on the Reset All button to clear all reagent locations, other than those that were defined upon entering the screen.

6. Click the OK button to continue.
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Copying a master mix

When a master mix has been setup using the right-hand pane, the master mix can be copied to a different well which also has

Mix function.
To copy a master mix:

1. Right<click on a well which contains a master mix.

2. The plate operations menu will appear.

I

Copy mix setup...

Set liquid level mode for segment »

Toggle image [
Toggle zoom

Delete calibration data

A Change plate bype
As¢  Change accessory
as  Change plate function 3

3. Select Copy mix setup. The “Copy Mix Setup” dialog box will open.

Etupy Mix Setup ll
Setup oK. |
Copy mix setup from:

[Hin D Twell D @ M1 Active | Eones] |

4. The Into field lists wells which have Mix function. Select the well into which the master mix will be copied.

5. Click on the OK button. The master mix will now be copied into the selected well.

5.9.5 Samples

To be used in reactions, samples must be organized into groups called “Sample Banks”. Each sample can be assigned a name,
an ID (e.g., a barcode) and a starting concentration. This information can be imported from an external file (e.g., an Excel®
spreadsheet).

Samples in the same “Sample Bank” are treated identically during a reaction. A sample may be present in more than one sample
bank. Sample banks can be continuous groups of wells, or a combination of individual wells, but they cannot span multiple
plates or plate segments.

See Section 5.9.7 for more detailed information about importing and exporting data into the “Sample” right-hand pane.

Diluent can be used as a sample for nontemplate controls. Standards are treated in the same way as samples.

Sample banks can be modified or created using the “Sample” righthand pane. To view the “Sample” righthand pane, leftclick

on a “Sample” well.

QlAgility Version 4.18 User Manual  06/2023 98



“Sample” right-hand pane

[~ Sample Barks (select a sample bark to highliaht those samples)

ater

Bank S ample Bark 1,16 wells]
Bank Sample Bank 2, 18 wells]
Bank S ample Bank 3. & wells)

Dol 8ark | BenamcBark | Newdank | EdiBark

Well Display Order

- Sample Data for [36 wel plate fvenical) @ C1}——————————————————
e Samples must be part of a group before they can
late: be used. Samples not in groups are greyed out

T | mpert Expart Clear select sample barl

 Label Sequence

% Pipetting Sequence

wel[wel __[SampleNane [samplen Jcone, =
® A1 Sampienl @1 0
® Bl SampieBlGCT 0
® O SampkCiel 0
® D1 SampkDiact 0
® E SamplzE1@C1 i
e F Sample F1 @ C1 0
@ &l Sample G1 @C1 0
o H Sample H1 @C1 0
® sz Gampkezerl 0
® B2 SampkB2oCl 0
® 2 SampkCzeC 0
® D2 SamikD2EDN 0
® Ez  SamkE2GC 0
& [ le £ fnil 0 -
Delete Bank

Rename Bank

New Bank

Edit Bank

Plate ID

Import

Export

Clear

<select sample bank>
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Deletes the selected sample bank. Deleting a sample bank will not affect sample names, sample

IDs, or concentrations.

Opens a dialog box in which the sample bank name can be changed. Click on the OK button to

continue.

Displays the “Update Sample Bank” dialog box, which enables a new sample bank to be created.
See Section 5.8.1.

Displays the “Update Sample Bank” dialog box, which enables an existing sample bank to be
modified. See Section 5.8.1.

Enables a plate ID to be entered. This can be entered manually or using a bar code reader.

Opens the “Barcode Entry” dialog box, which enables interactive input of sample ID bar codes.

Opens the “Import Well Data” dialog box, which enables sample data to be imported from a file.

Opens the “Export Samples” dialog box, which enables sample data to be exported to another

file.

Deletes any user-assigned sample names, sample IDs and concentration values. Sample IDs are

reset to “blank”, and concentrations are reset to “0”.

A sample bank can be selected from the drop-down menu.
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Well Display Order This determines the sequence in which wells are displayed in the sample data grid (i.e. “Label
Sequence” or “Pipetting Sequence”). Each plate type has a specific pipetting’ rder and specific
label” rder. Where these are different (e.g. vertical pipetting order and horizontal label order), the
sequence in which wells are listed in the grid changes according to the well display order selection.
This function is useful, for example, when it is convenient to dispense liquids by column (vertical

pipette order), but fo export the data by row (horizontal label order).

Copy all Select to copy the “Sample Data” list. The data can be pasted into an Excel file.
Paste to current cell Pastes a list of “Yes”/"No” values from a spreadsheet into the “Sample Data” column.
Row height Enables row height to be adjusted. A submenu will appear. Select “Grow” to increase the row

height, or select “Shrink” to decrease the row height.
Export Select to export the “Sample Data” list to another file. A submenu will appear. Select either Export
to CSV or Export to Excel.
Managing sample banks via the “Sample Banks” panel
The “Sample Banks” panel, located at the top of the “Sample” righthand pane, displays a list of current “Sample Banks”.
Click on the New Bank or Edit Bank button to open the “Update Sample Bank” dialog box. Sample banks can be managed via
this dialog box. See Section 5.8.1 for more detailed information about how to do this. Alternatively, doublelick on a sample
bank to view the “Update Sample Bank” dialog box.
Left<lick on a sample bank to view the associated sample list in the “Sample Data” panel.

Modifying sample banks via the “Sample Data” panel

1. Select the sample bank to be edited from the “<select sample bank>" drop-down menu in the “Sample Data” panel.
. An additional column will appear in the sample list.

. To add or remove a sample from a sample bank, leftclick on a cell within this column. A checkbox will appear in the cell.

AN w0 N

. To add a sample to the sample bank list, check the box to change the contents of the cell to Yes. To remove a sample from

the sample bank list, check the box to change the contents of the cell to No.

Note: Samples that are assigned to the selected sample bank are highlighted white, and samples that are not assigned to

the selected sample bank are displayed in gray.

Alternatively, it is possible to copy and paste a column of “Yes”/”No” values from a spreadsheet. Rightclick in the cell of the

desired starting row, then select Paste to current cell.
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Samples are given default sample names, based on their position in the sample plate. To change the sample name, to input a
sample ID, or to input a starting concentration, left-click on a cell in the “Sample Name”, “Sample ID”, or “Conc.” column.

Directly enter the desired information.

5.9.6 Reactions

Pipetting operations in a given run are defined by a “Reaction List”. Reaction lists can be created and modified using the

“Reaction” righthand pane.

To view the “Reaction” righthand pane, leftclick on a reaction plate. The buttons located below the “Reaction List” can be used
to configure the list. The “Reaction Data” panel lists the wells and contents of the selected reaction plate. It also enables reaction

data to be imported from a spreadsheet and exported to another file.

See Section 5.9.7 for more detailed information about importing and exporting information into the “Reaction” right-hand pane.

“Reaction” right-hand pane

"~ Reaction L

M Pipstte 5 il of Sample Bank 1+ Min C to 36 wel plate (vertical] @ C2. FreM
T Pipete 5 il of Sample Bk 2 + Mix C to 36 wel plate (vertical] & C2. PreM

T 1 e Coy || Delere | Betaget j ﬂ
Special Select &l (eRE- REe] M

~ Reaction D,

FltelD Wel 1D comprises tubs D and constituent
B sample IDs feg. 51 +52in 13 =5 351 |52).

| ot | Espor Clest

Well Dsplay Oider " LabelSequence. & Pipstting Sequence

wiel [ Final Cortents [io [Cone
A1 29,25 ) Mix C; 5 pl Sample 41 @ C1
BY | 23,26 4l Mix C.5 ul Sample B1 @ C1
1| 23,254l Mix C; 5 ul Sample C1 @ C1
D1 | 23,25 4l Mix C:5 l Sample D1 @ C1
ET | 29,25 4l Mix C; 5 ol Sample E1 @ C1
F1 | 2325 Mix ;5 pl Sample F1 @C1
B1 29,96 4l Mix C; 5 ul Sample 61 @ C1
H1 | 23,25 l Mix C; 5yl Sample H1 @ C1
42| 2935 pl Mix C: 6yl Sample A2 ©C1

Add Opens the “Reaction Configuration” dialog box. Enables setup of a new PCR reaction.

Edit Opens the “Reaction Configuration” dialog box. Enables a reaction to be edited. Alternatively,

double-lick on a reaction to open the “Reaction Configuration” dialog box.
Copy Copies selected reaction. Leftclick on a reaction in the “Reaction List” and then click on the Copy
button. If there is more than one reaction in the list, a submenu will appear. Select Copy in-place?,

Copy to end of list?, or Cancel.

Delete Deletes selected reactions. To delete more than one reaction, hold down the “Shift” or “Ctrl” key,

left-click on reactions in the “Reaction List” to select them, and then click on the Delete button.
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Retarget

Up/Dn

Special

Select All

@

Plate ID

Import
Export
Clear

Well Display Order

Copy all

Enables a reaction to be retargeted to a different reaction plate. Left<lick on the new reaction plate
to select it, then left-click on a reaction in the “Reaction List”, and then click on the Retarget button.
A message box will appear, click on the “Yes” button to continue.

Displays a summary of the selected reaction.

Modifies the reaction order. Left-click on the reaction to be changed in the “Reaction List”. Hold
down the “Shift” key to select multiple reactions. Click on the Up or Down buttons to move the
selected reaction(s) up or down in the “Reaction List”.

Enables a “Special” reaction to be set up and added to the “Reaction List”.

Selects all of the reactions in the “Reaction List”.

Highlights master mixes and reagents, which are involved in a selected reaction, in green. Click

on the icon again to remove the highlights.

Highlights diluent, standards and sample banks, which are involved in a selected reaction, in

orange. Click on the icon again to remove the highlights.

Highlights destination reaction wells, which are involved in a selected reaction, in blue. Click on

the icon again to remove the highlights.
Enables a plate ID to be entered. This can be entered manually or using a bar code reader.

Enables interactive input of reaction ID bar codes. Click to open the “Barcode Entry” dialog box.

Enables reaction data to be imported. Click to open the “Import Well Data” dialog box.
Enables reaction data to be exported. Click to open the “Export Reaction Info” dialog box.
Clears any user-assigned reaction IDs and concentration values.

This determines the sequence in which wells are displayed in the sample data grid (i.e., “Label
Sequence” or “Pipetting Sequence”). Each plate type has a specific ‘pipetting’ order and specific
‘label’ order. Where these are different (e.g., vertical pipetting order and horizontal label order),
the sequence in which wells are listed in the grid changes according to the well display order
selection. This function is useful, for example, when it is convenient to dispense liquids by column

(vertical pipetting order), but to export the data by row (horizontal label order).

Select to copy the “Reaction Data” list. The data can be pasted into an Excel file.
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Paste to current cell Pastes data from the system clipboard (e.g., a list of “Yes”/”No” values from a spreadsheet) into the

“Reaction Data” column.

Row height Select to adjust row height. A submenu will appear. Select Grow to increase the row height, and

select Shrink to decrease the row height.

Export Select to export the “Reaction Data” list. A submenu will appear. Select either Export to CSV or

“Export to Excel.

Assign ID's Enables groups of reactions to be assigned the same value in the “ID” column. Leftclick and drag to

select a group of cells. Rightclick on the selection and select Assign ID’s.

Set Concentrations Enables groups of reactions to be assigned the same value in the “Conc” column. Leftclick and drag

to select a group of cells. Rightclick on the selection and select Set Concentrations.

Well
The “Well” column indicates the label of the reaction well, as determined by the plate type.
Final Contents

The “Final Contents” column describes the final composition of the liquid in the well, as determined by a complete simulation of

the run.

Note: When pipetting operations add liquids to a well and later remove them, the final well contents may be empty. This is
different to the data presented when hovering the cursor over a reaction well on the software worktable. In this case, only liquids

added to the well are shown.
ID

The “ID" column shows a combination of identifiers associated with each reaction well. This includes a “Reaction ID” which can
be assigned as a fixed attribute of the well. It also includes a list of the IDs of samples present in the well on completion of the
run, as determined by simulation of the pipetting operations. The “label” ID and “contents” IDs are combined together as a “full

ID"” using a “|” character as separator, with the user-assigned “label” ID listed first.

Concentration

The “Concentration” column displays a concentration value associated with a reaction well. When a reaction contains just one
sample (or standard) and the starting concentration of that sample has been defined, the final concentration of that sample in the

reaction well is displayed. When a reaction contains more than one sample, no final concentration value can be calculated, so

no value is displayed. If desired, the user can assign a concentration value to the reaction well.
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User-assigned concentrations are shown in blue. This is useful for dilution of samples, or stock wells, which are supplied initially
in reaction plates. If a user-assigned concentration is entered for a well which also has a valid calculated concentration, the user-

assigned value is shown in red, to indicate that it is overriding the software-calculated value.

Note: Concentration values are assumed to be entered in a single unit common to all values in the run. The unit itself can be

defined as needed for the application (see Section 5.6.5).
Creating sample banks from target wells

Selecting a liquid handling operation in the “Reaction List” region of the righthand pane highlights the destination wells
associated with the operation when the blue button below the list is activated. Where the selected liquid handling operation
supports the action, the highlighted wells can be directly entered into a sample bank as follows. Rightclick the liquid handling
operation to show the Create Sample Bank from Target wells menu item. Select this item to present the “Update Sample Bank”

form. Now enter a bank name as described in Section 5.8.1 and save the updated sample bank.

Reaction Ligt

BB N

( : Sample Bank from Target wells |
l]]] Fipette 20 pl of Controlz + kb1 b 96 well plate [vertical] @ C2 (2 wels)

Lok Skip wells in 96 well plate [vertical] 2 C2. (5 wellz)
l]]] Fipette 20 pl of Standards + M 1 to 36 well plate [vertical] (@ C2. (18 welz)

This function increases convenience when making a series of liquid handling operations in which the source wells for a given

operation correspond to the target wells constructed by a predecessor operation.
“Reaction Configuration” dialog box

To open the “Reaction Configuration” dialog box, click on the Add button from the “Reaction” right-hand pane.

B Reaction Configuration E =

Select OME of these sets: Made up to this volume: ok |

o B ~ Sample vohime P El 4l r—
i
Premis before taking sample? [ |' El il Total wolume ln—El o

Which will be combined with ALL of these:
- Mises and reagents in mix wells
O No items

Mo sany

Into this configuration of reaction wells:
Tagetwels——————————————

Mumber of wells |—1
=]

Aliemate samplewells witiwater? T

i Setling
[ Urmived reagents—————————————————— e e ,—5 Elnmes
DN tems

- Hormalize samples™
Use rioymalzation?.

Ao adjst smell volumes?,

r
r
MNomalize b conc: |—1 El

Into THIS reaction plate:

Target reaction plate
[ 96 well plate (horizontal) @ C2
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When the option Allow multiple reagent volumes is activated in the Run Settings menu (see Section 5.6.6) the “Reaction

Configuration” dialog box is displayed with the advanced reagents view:

[ Reaction Configuration X

Select ONE of these sets: Made up to this volume: ax
o

[0 samples (empty wels) | Sample valume o Elv‘ Cancel
Pre-mis before taking sample? [~ |_| Elmes Total valume: I—A Elm

Which will be combined with ALL of these: Into this configuration of reaction wells:
~Targat

CTRET E

Humber of wells |_1 El

Alernate sample velswik divert? [
Freserve sotre wellindioes?.

o E
Reogert [use? [volume To Use [Defauitvolume Micon cition? o[£ []imes

10% Bulfer Ves |1 25
e . 3 5 [ Nomsiize samples?

Use romalizztiar?. 0
NP He 0 2 At st smell volumes? N
Prinelfwe) Ma 0 1 Normalize to canc —

1

Primerfiev) o 0 1 El
Probe 1 No o 05
Probe 2 No o 05
Ten Mo 0 025

Into THIS reaction plate:

(&‘in plate [v:mca\] @c2 _I ‘

Samples Allows selection of a sample bank from the drop-down menu.

Pre-mix before taking Select to premix samples, and then define the number of mixes. This function instructs the instrument
sample? to mix each sample of the sample bank as it is aspirated for transfer to the reaction well.

Mixes and reagents in Defines the master mixes that will be added to the reaction. All wells that have Mix function, and
mix wells that have been assigned a per-reaction volume, will be listed. Selected master mixes will be added

to the reaction.

Unmixed reagents (Simple Defines the unmixed reagents that will be added to the reaction. All named reagents which have
reagents view) been assigned a per-reaction volume will be listed. The default volume of selected reagents will be

added to the reaction.

Reagents (Advanced Shows a table of all available reagents on the worktable. By entering a volume in the column
reagents View) “Volume to use” the given volume of the selected reagent is added to the reaction.
Target reaction plate Click on the "= button to open the “Plate/well Selector” screen. This screen allows the user to

select the target reaction plate and well.

Sample volume Defines the volume of sample to be added fo the reactions. When Use normalization? is selected,
this option defines the target volume for normalized samples in the reactions. An initial value is
automatically set when the operation includes a master mix configured with default sample volume.

A sample volume of zero is permitted.
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Total volume

Replicates

Number of wells

Alternate sample wells
with diluente

Preserve source well

indices?

Mix on ejection?

Use normalization?

Auto Adjust small

Volumes

Normalize to conc.

Setting up a reaction list

Defines the per-reaction total volume. The “Total volume” is automatically calculated, based on the

sample, reagent, and master mix volumes.
Defines the number of replicates to be performed for each sample bank.

Defines the total number of wells. This number is automatically calculated, based on the number of

samples in the sample bank and the number of replicates.

When constructing reactions, this option instructs the instrument to alternate sample wells with
diluent. When selected, the operation prepares successive reactions using a sample from the bank,

then diluent, then the next sample from the bank, and so on.

This function is visible only when enabled in the Advanced Settings menu in the Options menu.
When selected, the reaction constructed for each sample is placed into the same relative location
from the start of the reaction plate as the sample from the start of the sample plate, determined

according fo pipetting order.

Instructs the instrument to perform a mix cycle upon ejecting the sample and defines the number of
mix cycles to perform. Mixing is only performed when the final reaction component is added, and

only when there is more than 1 component in the reaction.
Instructs the instrument to normalize sample concentrations.

Instructs the instrument to round up sample volumes that are less than the minimum volume that can
be pipetted [i.e., 1 pl), to the minimum volume (i.e., 1 pL). Where the operation would require less
than the pipettable volume of diluent, no diluent is transferred, only sample is moved. In all such

cases, the final volume is preserved, but the desired final concentration is not achieved.

Defines the concentration to which samples will be normalized. This excludes the contribution that

other reagents and master mix make to the reaction.

Note: If the total number of reactions configured on one plate exceeds the number of reaction wells a warning will appear. This

warning must be resolved before the run can be started.

1. Leftclick on a plate with Reaction function.

2. The “Reaction” righthand pane will appear.
3. Click on the Add button.

4. Select a sample bank from the drop-down menu in the “Samples” panel.

Note: Only one sample bank can be selected per reaction.
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5. If desired, select Pre-mix before taking sample? and enter the number of times to mix.

6. Select the components of the reaction. Available master mixes are listed in the “Mixes and reagents in mix wells” panel,
and available unmixed reagents are listed in the “Unmixed reagents” panel. Leftclick in the boxes next to the required

components to select them. A tick will appear next to the components which have been selected.

7. Click on the "= button to select the target reaction plate. The “Plate/well Selector” window, which displays a schematic of

the worktable setup, will appear.

‘ Please select a plate

A:Tip o tip, QIAGEN) A2 T ive {ip, QIAGEN) &

/M1 (5mi tapered tube

B1: Sample (2004l PCR tube, Generic) BZ: Tip (50p1 Conductive tip, QIAGEN)

R1 (Reagent block (w

€12 Sample (200p1 PCR tube, cz PCRtube, )

8. Leftclick on a reaction plate to select it. The “Reaction Configuration” dialog box will reappear.

Note: If there is only one “Reaction” plate, this plate will be selected by default. To return to the “Reaction Configuration”

dialog box, leftclick on the selected plate.
9. Define the options in the “Volume”, “Target wells”, “Mix Settings”, and “Normalize samples2” panels as required.
10. Click on the OK button to return to the main software window.

Note: See Section 5.10.5 for details about how to check the reaction setup.
Using “Special” options in the reaction setup

A number of “Special” options are available from the “Reaction” righthand pane. To view these options, leftclick on the Special

button.

Note: It is recommended that reactions that include “Special” options are simulated in “Virtual Mode” before starting an actual

run.

Many of the “Special” operations allow the user to select the starting well. In these cases, there is a risk of mixing samples. A

warning will be displayed at the start of the run if sample will be added to a well that already contains another sample.
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1 oot sl
Add pause (30 sec.}

Fleaction Add pause (arbitrary),..
Add 'reset eject position’
Plate 1D 4dd 'pause until confirmation'
dd fan on
o |~
I I| Add Fan off
el

C1 |2

=31

Add sample bank pooling step. ..
Wwell |Fi add sample bank duplication step. ..
A1 28 Add sample dilution step...
g1 o Add serial dilution step...
Add sample bank normalisation. ..
Add remove waste {poal bank members). ..

Add pause (30 sec.)
Add pause (arbitrary)

Add ‘reset eject

position’

Add ‘pause until

confirmation’

Add fan on
Add fan off

Add sample bank
pooling step

Add sample bank

duplication step

Add sample dilution
step

Add serial dilution
step

Add sample bank

normalization

Adds a 30 second pause to the reaction list.
Adds a pause of defined length to the reaction list.

Configures the instrument to start pipetting into a reaction plate from its first well, typically well A1. This

can be useful for pooling sample banks. There is no contamination of source sample banks.

Pauses the instrument for an unlimited period of time. A dialog box will appear. If desired, enter a message
that will appear on the screen when the instrument pauses. Then click on OK to add the command to the

reaction list.

When the instrument pauses, user intervention is required to continue the reaction setup. Click on the OK

button to continue.
Turns the HEPA filter on.

Turns the HEPA filter off.

Opens the “Sample Bank Pooling” dialog box, which enables sample banks to be pooled. The user can

control tip usage during the pipetting operation.

Opens the “Bank Duplication” dialog box, which enables copying of sample banks. The user can control

tip usage.

Opens the “Sample Dilution” dialog box, which enables a sample bank to be diluted by addition of

varying quantities of diluent and sample.

Enables the user to perform a serial dilution. The user can select which dilutions to add to reactions.

Enables the user to prepare a stock plate of normalized samples and a working plate using a minimal

number of tips. If a minimal number of tips is used, the sample plate will be contaminated with diluent.
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Add remove waste  Enables a reaction plate to be specified as a waste receptacle. All samples in a sample bank can be

(pool bank members) moved to a single well.

Adding a pause into the reaction list

It can be useful to introduce a pause into the reaction list if an incubation time is required between pipetting operations.
Note: Pauses are processed during sample processing only after master mix and reagents have been aliquoted to reactions.
To introduce a 30 second pause:

1. Leftclick on a “Reaction” plate.

2. The “Reaction” righthand pane will appear.
3. Click on the Special button.

4. Select Add pause (30 sec.).

5. The reaction list will be updated.
To introduce a pause of defined length:

1. Leftclick on a “Reaction” plate.

2. The “Reaction” righthand pane will appear.
3. Click on the Special button.

4. Select Add pause (arbitrary).

5. The “Configure Pause” dialog box will appear.

Etonﬁgure Pause ! x|

Pau:

Pauze time: IUU;UD;BD E

6. Adjust the pause time using the arrows (h:min:s).
Note: The “Pause time” can be between 1 s and 96 h.
7. Click on the OK button. The reaction list will be updated.
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To introduce a pause during which a message is displayed that waits for user confirmation:

1. Leftclick on a “Reaction” plate.

2. The “Reaction” righthand pane will appear.
3. Click on the Special button.

4. Select Add ‘pause until confirmation’.

5. The “Configure Pause” dialog box will appear.

ERQIAGEN X
Please enter message to display to user: T
Cancel
Fobot paused, waiting on user interachion =]

6. Enter the text to be confirmed by the user.

7. Click on the OK button. The reaction list will be updated.
Resetting the ejection position
To reset the ejection position, proceed as follows:

1. Leftclick on a “Reaction” plate.

2. The “Reaction” righthand pane will appear.
3. Click on the Special button.

4. Select Add ‘reset ejection position’.

5. The pipetting head will move to the first position of the current plate segment when performing this step.
Add sample bank pooling step

This function combines different sample banks, pooling them into reactions. This can generate significant tip savings, but may

result in contamination of sample banks, depending on the tip usage configured for the operation.

Just 96 tips can be used to pool 3 x 96-well sample plates, each defined as separate sample banks. In comparison, 288 tips

would be used for the same operation when using Add ‘reset eject position’.

When using the Add sample bank pooling step option with the default tip usage setting, the instrument picks up a tip, takes an
aliquot from the first plate, takes an aliquot from the second plate, and then takes an aliquot from the third plate. The three
samples are then pipetted into the reaction plate. The second and third sample plates are therefore contaminated. In contrast,

there is no sample plate contamination when using Add “reset eject position’.
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To set up sample bank pooling using the Add sample bank pooling step option:

1. Leftclick on a “Reaction” plate.

. The “Reaction” righthand pane will appear.
. Click on the Special button.

. Select Add sample bank pooling step.

o N O N

. The “Sample Pooling” dialog box will open.
T y

[THs feature pocks samples (o corman output welks by overaying barks

5 arnples must be part of a bank ta be avalable for pooling and sach pocled bank must have the same

o fpumber of wells.
E-ach bank may have its own volume. Maximun total volume is 200 4 Lancel

[ Tip Ejection Mod:
= Multi-pickup. Using 1 tip per sample to mult-aspirate all pooling liquids and eect all
" Re-use tips. Using 1 tip per sample to aspirate and eject each pooling liquid separately.
© Use new tips. Using a new tip for each pooled liquid per sample in the sample bank.

Premis count [0 E| [0to disable)

- Taiget reaction pl

[36 wel plote (verticall @ C2 _|
| First wen a1 ~ Replicates: IW—E
| Pl
Sample bank: | gap =
Vlume: [ ackd Hemove

Samples:

Post Mix b=
[ Misoourt |3 i volume: [0 [ oo use sutomstc vaey

NOTES: =1
T otel posl velume: 01y, inc. aif gaps
Tips Rrequired: none: (Largest available tip size = 200 ul)
=
Multi-pickup Instructs the instrument to use a single tip to multi-aspirate and to eject all pooling liquids.

This allows a total volume up to the volume of the largest tip size on the worktable to be

pooled. Sample contamination may occur.
Re-use tips Instructs the instrument to use a single tip to aspirate and eject each pooling liquid
separately. This allows pooling of component volumes, each up to the largest tip size on the

worktable. Sample contamination may occur.

Use new tips Instructs the instrument to use a new tip for each pooled liquid per sample in the sample
bank. This option avoids contamination of sample wells, but tip consumption is higher than

with other options.

Premix count Defines the number of mixes to be performed when aspirating samples to be pooled. This

option is only available when individual samples are moved separately.

Opens the “Plate/well Selector” screen, which enables the target reaction plate to be

selected.
First well Defines the first well of the reaction plate into which the sample bank will be pooled.
Replicates Defines the number of replicates.
Sample bank Defines a component sample bank to be added to the target reaction wells in a pooling
step.
Volume Defines the volume of each sample in the sample bank to be added during a pooling step.
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Add Adds the defined pooling step to the “Samples” list.

Remove Removes the defined pooling step from the “Samples” list.
Samples Defines the list of pooling steps.
Mix count Defines the number of mix operations to be performed when the final component is added

to each pooled reaction.

Mix volume Specifies the volume to be aspirated and ejected during the final mixing, when the mix
count is greater than 0. A value of O indicates that the software should choose an

appropriate, recommended value.
6. Select Tip Ejection Mode > Multi-pickup, Re-use tips, or Use new fips.
7. If Re-use tips or Use new tips were selected, define the “Premix” count.
8. Click on the "= button to select the target reaction plate. The “Plate/well Selector” window will appear.
9. Leftclick on a reaction plate to select it. The “Sample Pooling” dialog box will reappear.

Note: If there is only one “Reaction” plate, this plate will be selected by default. Leftclick on the selected plate to return to

the “Sample Pooling” dialog box.
10. Define the “First well” and the number of “Replicates”.
11. Select a sample bank to be pooled from the “Sample bank” drop-down menu.
12. Define the “Volume” to be added and then click on the Add button.
13. When Multi-pickup is selected, it is recommended to select Air gap from the drop-down menu in the “Samples” panel.
14. Define the “Volume” to be added and then click on the Add button.
15. Repeat steps 11-14 for the remaining sample banks that will be pooled.
16. Define the “Mix count:” and the “Mix volume:”

17. Click on the OK button to return to the main software window. The “Reaction List” will be updated with the sample bank
pooling step.

Add sample bank duplication step

If a sample bank of 8 samples was copied 5 times using standard reaction steps, 40 tips would be required. When the Add

sample bank duplication step option is used, only 8 tips are required for this operation.
To copy a sample bank:

1. Leftclick on a “Reaction” plate.

2. The “Reaction” righthand pane will appear.

3. Click on the Special button.

4. Select Add sample bank duplication step.

5. The “Bank Duplication” dialog box will appear.

QlAgility Version 4.18 User Manual  06/2023 112



B8 Bank Duplication

|
[This Feature duplicates 2 bank of samples nta muliple (eachon pates
Ml eaction wels used must be clean before the star of this step.

[~ Select a Tip Setting opfion

& Bulli-siest, Using 1 tip per sample to aspirate total valume and mult-sject all duplications,

MultiEject Setings

€ Re-use tips. Using 1 tip per sample to aspirate and siect sach dupliation volume separately.

" Use riew tips, Using a new tp for each sample and for each duplication valume

Cancel

| [ Selsct the sample bank to be duplicated

Sample bark  [Sample Bark 1, 16 wells)

~ Salect the reaction plates to duplicat nto

|95 well plate [vertical] @ C2

First well 41 -
Volume: 5 E|u

Fieaction plates

Totalvokme:  [04

incl 2 pl extia per tip for Multi-Eject Femove

NOTES:

Tatal Sample valume required; 0 pl

Maimum total ssmple volume per tip = 198 200 pl Tip - 2l Extra Yolume )

Tips Fequired: none [Laigest available fip size = 200 W) - IMPOSSIELE DPERATION.

|

El

Multi-eject

Multi-Eject Settings

Re-use tips

Use new tips

Sample bank

First well
Volume

Add

Remove
Reaction plates

Total volume

Instructs the instrument to use a single tip per sample to aspirate the total volume and to multi-

eject all duplications.

Opens the “MULTI-EJECT” dialog box, which enables configuration of multi-eject options.

See Section 5.6.12 for more details about how to configure these options.

Instructs the instrument to use a single tip per sample to aspirate and eject each duplication

volume separately.
Instructs the instrument to use a new tip for each sample and each duplication volume.
Defines the sample bank to be copied.

Opens the “Plate/well Selector” screen, which enables the target reaction plate to be

selected.

Defines the first well of the reaction plate into which the sample bank will be copied.
Defines the volume of the sample bank that will be taken.

Adds the duplication step to the “Reaction plates” list.

Removes a duplication step from the “Reaction plates” list.

Lists the duplication steps.

Defines the total volume, which includes an extra volume if Multi-eject was selected. The

extra volume is dependent on the seftings.

6. Select the Tip Ejection Mode > Multi-pickup, Re-use tips, or Use new tips.

7. If “Multi-eject” was selected, the “Multi-Eject Settings” option will be available. See Section 5.6.12 for more details about

how to configure multi-eject options.

8. Select the sample bank to be copied from the drop-down menu.

9. Click on the

10. Leftclick on a reaction plate to

button to select the target reaction plate. The “Plate/well Selector” window will appear.

select it. The “Bank Duplication” dialog box will reappear.

Note: If there is only one “Reaction” plate, this plate will be selected by default. Left-click on the selected plate to return to

the “Bank Duplication” dialog box.
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11. Define the “First well” and the “Volume”.

12. Click on the Add button to configure the first sample bank copy.

13. If required, repeat steps 9-12 to configure more copies. The software will automatically calculate the “Total Volume”.
14. Note: To remove a copy, leftclick on a copy in the “Reaction plates” list, and then click on the Remove button.

15. Click on the OK button to return to the main software window. The “Reaction List” will be updated with the sample bank

duplication step.

Add sample dilution step

This function performs dilutions of a bank of samples with a diluent reagent. Each dilution in the series is specified by a pair of
volumes that describe the amount of sample and amount of diluent to be combined in the reaction. By default, dilutions of the

sample are performed with a single tip, to transfer the sample to target reactions. A different tip is used for transferring the diluent

to target reactions, thereby minimizing tip usage.

1. Leftclick on a “Reaction” plate.
. The “Reaction” righthand pane will appear.
. Click on the “Special” button.

. Select “Add sample dilution step”.

g N W N

. The “Sample Dilution” dialog box will appear.
=

[This Feature performs one or mare diuiians of 2 bark of samples, for example mix samplerdiuent in the
olowing velumes: Sul#45ul 1041730, 15u1/36). 25,1251

- Select Tip Usage oplians: Cancel

& Multisject. Using 1 tip o aspirate total valume: (pe fiquid) and muli-sjzct 2l ditians.

Diuer Muli-sieet Settings Sample Mulicist Setings |

" Re-use lips. Re-use tip far all diltions per sample.
" Use new tips. Using a new tip for each dilution,

[For Fe-Lse tps and New fis: ANl dient wil be lnaded frst using the Global Tip G =ting then
Jeach sample wil be Inarled using the selected tip optian

" Hix Settings:

IV Encble miving during diion? Mo of finesto i[5 E| |

r~ Select the sample bank and the diuent:

Diluent [Dient |

Sample bank:  [Sample Bark 1, 16 wells) = |

Selest the Reaction Plate o dilte into
’Vﬁs well plale (vertical] @ C2 Fistwell [1 | ‘
(- Select the Diluton Ratios to use:

Sampe valume: 1 u‘ add Remove

Dilsent volume: |1 E‘u\

Dilations:
NOTES: =]

Total Sample: 2 l. Total Diuent 2 !
Tin capaciy: TOTAL sample volume < 135 ul, and TOTAL dient voiume < 155 ul

Tips Requiredt: none (Largest available tip size = 200 ] - IMPOSSIBLE OPERATION.

|

Multi-eject Instructs the instrument o use 1 tip to aspirate the total volume of sample and to use a different tip
to aspirate the total volume of diluent. The instrument will then multi-eject to the target wells to

construct all dilutions.

Diluent Multi- Opens the “MULTI-EJECT” dialog box, which enables configuration of diluent multi-eject options.
eject Settings See Section 5.6.12 for more details about how to configure multi-eject settings.
Sample Multi- Opens the “MULTI-EJECT” dialog box, which enables configuration of sample multieject options.
eject Settings See Section 5.6.12 for more details about how to configure multi-eject options.
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Re-use tips
Use new tips

Enable mixing

during dilution?

No. times to

Instructs the instrument fo reuse a single tip for all dilutions per sample.
Instructs the instrument to use a new tip for each dilution.

Enables mixing during dilution.

Defines the number of times to mix.

mix
Diluent Defines the diluent to be used for dilution.
Sample bank Defines the sample bank to be used in the dilution.
Opens the “Plate/well Selector” screen, which enables the target reaction plate to be selected.
First well Defines the first well of the reaction plate into which the dilution will be targeted.

Sample volume Defines the volume of the sample bank that will be used in a dilution.

Diluent volume Defines the volume of diluent that will be used in a dilution.

Add Adds the dilution step to the “Dilutions” list.
Remove Removes a dilution step from the “Reaction plates” list.
6. Select the Tip Ejection Mode > Multi-pickup, Re-use tips, or Use new tips.
Note: If Multi-eject was selected, the Diluent Multi-eject Settings and Sample Multi-eject Settings options will be available.
These options can be used to configure the multi-eject options of the sample and diluent. See Section 5.6.12 for more
details about how to configure multi-eject options.
7. Select the diluent and the sample bank that will be used in the dilution from the drop-down menus.
8. Click on the button to select the target reaction plate. The “Plate/well Selector” window will appear.
9. Leftclick on a reaction plate to select it. The “Sample Dilution” dialog box will reappear.
Note: If there is only one “Reaction” plate, this plate will be selected by default. Left-click on the selected plate to return to
the “Sample Dilution” dialog box.
10. Define the First well.
11. Define the Sample volume and the Diluent volume, and then click on the Add button.
12. If required, repeat steps 8-12 to configure more dilutions.
Note: To remove a copy, leftclick on a copy in the “Reaction plates” list, and then click on the Remove button.
13. Click on the OK button to return to the main software window. The “Reaction List” will be updated with the sample dilution

step.

Add serial dilution step

1.
2.
3.
4.
5.
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Create a sample bank that contains 1 well. See Section 5.8.1 for details about how to do this.
Left-click on a “Reaction” plate.

The “Reaction” righthand pane will appear.

Click on the Special button.

Select Add serial dilution step.

06/2023 115



6. The “Serial Dilution” dialog box will appear.

B8 Serial Dilution

This featiz peifams a custom seial diltion. The diition ratio at each step can be customized oK
The source sample bark needs o have the same number of samples as there are eiector heads on the =

rabat.

Cancel

~ Select the sample bank and the: diluent:

Diuent [Diuert

Samplebank:  [Sample Bank 2, T wellz)

|
|

~ Select the Reaction Plate to dilute intor

96 wellplate [vertical @ C2

First wel D& =

— Spasial settings for Dilutions:

Min. volume:  [50 Elul

Change tps after each didtion? @

Enabls mixing duing diuion? & No. of tines tomix. |5

~ Select the dilution ratios to use:

Riatia ik |5—E|

Bemove

Dilutions: Ratic: 1:2
Ratic: 1°31:6 from iritial)

Ratio: 1:4 [1:24 from initial]
Ratio: 1:5[1:120 from iritial)

MOTES!

Dilutions: 4
Total Diluent volume required: 164,17
Total Sample volume required 35,53 i

Tips Fieuired: & 50 i (Largest availabls tp size = 200 )

|

Diluent

Sample bank

First well
Min. volume

Enable mixing during
dilution?

Change tips after

each dilution?

No. of times to mix
Ratio

Add

Remove

Defines the diluent to be used in the serial dilution. This sample bank must contain only one

sample.
Defines the sample bank to be used in the serial dilution

Opens the “Plate/well Selector” screen, which enables the target reaction plate to be

selected.
Defines the first well of the reaction plate into which the serial dilution will be targeted.
Defines the minimum fotal volume for each dilution in the series.

Instructs the instrument to mix during dilution.

Instructs the instrument to change tips affer each dilution. When selected, a new tip is used
for aliquoting each diluent volume and each dilution sample. When not selected, a single

tip is used to aliquot diluent, and a new tip is used to aliquot the dilution samples.
Defines the number of times to mix.

Defines the sample:diluent ratio for a given dilution.

Adds a given dilution to the “Dilutions” ist.

Removes a selected dilution from the “Dilutions” list.

7. Select the diluent and the sample bank to be used in the serial dilution from the drop-down menus.

8. Click on the I button to

select the target reaction plate. The “Plate/well Selector” window will appear.

9. Leftclick on a reaction plate to select it. The “Serial Dilution” dialog box will re-appear.

Note: If there is only one “Reaction” plate, this plate will be selected by default. To return to the “Serial Dilution” dialog

box, leftclick on the selected plate.

10. Define the options as required in the “Special settings for Dilutions” panel.
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11. Define a series of dilution ratios. To do this, enter a ratio and then click on the Add button. Repeat this for every dilution

ratio of the series.
12. Note: To remove a dilution, leftclick on a copy in the “Dilutions” list, and then click on the Remove button.

13. Click on the OK button to return to the main software window. The dilutions will be added to the “Reaction List”.

Add sample bank normalization

This function equalizes the concentrations of the wells of a sample bank by dilution with a specified diluent. The normalized

samples are prepared in separate reaction wells.

1. Leftclick on a “Reaction” plate.

2. The “Reaction” righthand pane will appear.
3. Click on the “Special” button.
4. Select “Add sample bank normalization”.
5. The “Sample Normalization” dialog box will appear.
BT 5ample Normalization x|
This tool performs sample by sample nomalizalion o a reaction piate. T
Select the sample bank and the diuent Cancel
Diluert: [Diluent |
Sample bank: [samples. & wells) =l

Select the reaction plate ta diute inta
Lssweup\ate[vemcan@cz | Fistwel [0 hd

[~ Select the diution parameters b use:

Final volume: [50

Desired concentratior: |1 Lowest norezero sample cone = 2,00

iz count: 5

[ARanan

- Pipette product to 2 secondary pla

Use secondary target? [

<no selection> First wedl: K

Secondar volume: 0 = ul
Ml court 5 =
[~ Advanced optior
I~ Allow contamination (uses less tips. contaminates sample with diluent)
I~ Auto adjust small volumes to enable robot to move liquid
I~ Preserve source well indices?
MOTES: =
|
Diluent Defines the diluent to be used for the sample normalization.
Sample bank Defines the sample bank to be used for the sample normalization.
Opens the “Plate/well Selector” screen, which enables the target reaction plate and the
secondary farget reaction plate to be selected.
First well Defines the first well of the reaction plate into which the sample normalization will be
targeted.
Final volume Defines the final volume.
Desired concentration Defines the concentration fo normalize to.
Mix count Defines the number of times to mix.
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Use secondary target@

First well

Secondary volume

Allow contamination

Auto adjust small
volumes to enable

robot to move liquid

Instructs the software to prepare a copy of the normalized samples in a second target

plate.

Defines the first well of the secondary target plate, into which the first normalized sample will

be pipetted.
Specifies the volume of normalized samples to be prepared in the secondary target plate.

Specifies that the tip used to pipet diluent will also be used to pipet source sample. The tip

will collect diluent, then sample, and will then eject the liquid into the target well.

Instructs the instrument to round up sample volumes that are less than the minimum volume
that can be pipetted (i.e. 1 pL), to the minimum volume (i.e. 1 pl). In cases where the
operation requires less than the pipettable volume of diluent, no diluent is transferred, only
sample is moved. In all such cases, the final volume is preserved, but the desired final

concentration is not achieved.

6. Select the diluent and the sample bank which will be used for the sample normalization from the drop-down menus.

7. Click on the "= button to select the target reaction plate. The “Plate/well Selector” window will appear.

8. Leftclick on a reaction plate to

select it. The “Sample Normalization” dialog box will reappear.

Note: If there is only one “Reaction” plate, this plate will be selected by default. To return to the “Sample Normalization”

dialog box, leftclick on the selected plate.

9. Define the “First well”.

10. Define the “Final volume”, the

‘Desired Concentration”, and the “Mix count”.

11. Define the remaining options in the “Sample Normalization” dialog box as required.

12. Click on the OK button to return to the main software workspace. The sample normalization will be added to the “Reaction

List”.

Add remove waste (pool bank members...)

This function enables liquids from multiple sources to be moved into a waste well (i.e., enabling pooling).

1. Leftclick on a “Reaction” plate.

2. The “Reaction” righthand pane will appear.

3. Click on the Special button.

4. Select Add remove waste (pool

bank members...).

5. The “Remove Waste” dialog box will open.
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ERemove Waste _I- _ID ll
This feature combines the members of a sample bank into a single oK |
vessel Thiz can be uzed for removal of waste or pooling. =

— Select the zample bank:

Driluent j
Sample volume: |5 EM'

— Select the Waste vessel on a Reaction Plate: ——————

ISB well plate [vertical) @ C2 |

vessel: Al =

— Tip Settings:
* Usze a new tip for each sample
~ Re-use tips

— Past Mix Setting

Mix count: ID E

NOTES: =]

Tips Required: 1 = 50 pl [Largest available tip size = 200 pl)

|

Sample volume Defines the sample volume to be moved to waste.
Opens the “Plate/well Selector” screen, which enables selection of the target reaction plate.
Vessel Defines the vessel in the selected reaction plate to which waste will be moved.

Use a new tip for Instructs the instrument to use a new tip to move each sample.

each sample
Re-use tips Instructs the instrument to reuse tips when moving samples to the waste well.

Mix count Defines the number of times to mix the pooled liquids after the final member of the sample

bank is added to the waste well /tub.

6. Select a sample bank to be moved to waste from the drop-down menu.
7. Click on the "= button to select the target reaction plate. The “Plate/well Selector” window will appear.
8. Leftclick on a reaction plate to select it. The “Remove Waste” dialog box will reappear.

Note: If there is only one “Reaction” plate, this plate will be selected by default. To return to the “Remove Waste” dialog

box, leftclick on the selected plate.
9. Define the “well/tub”.
10. Select Use a new tip for each sample or Re-use fips.
11. Click on the OK button to return to the main software window. The remove waste command will be added to the “Reaction
List”.
Note: With this function, more than one sample will be added to one well. Therefore, a warning is displayed at the start of the

run.
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5.9.7 Importing and exporting reaction and sample data

Import IDs using a bar code reader

Bar code sample IDs can be imported using bar code readers that can connect to a computer via a USB or keyboard wedge. A
keyboard wedge is an input device that is inserted between the keyboard plug and the computer keyboard socket. For the best
results, the bar code reader system should be able to simulate user tabs or carriage returns appended to the bar code. These
simulated tabs or carriage returns automatically move the data input point (cursor) on the data table to the next input cell each

time a bar code is read.

1. Leftclick on a “Sample” or “Reaction” plate to view the “Sample” or “Reaction” righthand pane.

2. Click on the icon. The “Barcode Entry” dialog box will open.
i
rBarcode Data r~Sample Bank Name——————————————

ket [Brcade I~ Add to sample bark, named
A1 I W& e Bank
B1 l—
1
o € Evisting Bank
Sample Bark 1 (16 welk)
£1 Sample Bark 2 (18 wels)
F1 Sample Bank 3 (8 wells]
G1
H1
A2
B2 Cancel oK
cz
Dz
E2
F2
G2
HZ -

3. Scan the sample or reaction IDs. IDs will automatically be added to the “Barcode Entry” table.

4. To add samples or reactions directly to a sample bank, select Add to sample bank, named, in the “Sample Bank Name”

panel.

5. Select either New Bank or Existing Bank. If New Bank is selected, enter a sample bank name. If Existing Bank is selected,

left-click on a sample bank to select it.

6. Click on the OK button to return to the main software window.
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Importing sample and reaction data from a file

All sample and reaction data can be imported and exported from a variety of spreadsheets and text-based files. To import data

from Excel files, save the spreadsheet as a CSV (Comma Delimited) file type.

1. Leftclick on a “Sample” or “Reaction” plate to view the right-hand pane.

2. Click on the Import button. The “Import Well Data” dialog box will appear.

x
Inmport Fil -~ File Conten
“amme\amgmty\nana\\mpmts.amp\es et [ well, SamplelD, Conc, Testd, TestB, TestC
SAMPLE DATA STARTS HERE
~ Text Piocessing———————————————) é} JFred, EB ER
Column Separator. 1 Tom, 7. . &
 Tah D1, Lisa, 9, x, »
& Comma

coastithr [f [

I~ Remave fiom fislds. separate with [

1~ Import Optians:

Start impotting FROM row: |2—E|
Stat impoting TO wel a1 <] | ot Previ

g L s s |32—E| 2 EW [Tess  [Test
(Ol SemEb e e et IW—E
7 LoadlD fomeokmn: [ ]
(] ) B framm e IB—E

~Sample Bank Options—————————————
[% Add fitered rows to sample bankfs}
€ New Bank

€ Existing Bank

£ Banks specifid in column: [1 E

% Banks named fram membership columns
45

~Riow Filtr
I~ Spesiy conceniration rangs [Min, Max]

Min Concentration:
Max Concentratior:

4= sz seleoted wells INBIDE range.
£ sz selested wells AUTSIDE range

[¥ Members of selected bank columns ol Cancel Impert

3. Click on the |2
button.

button. Select the file type to import [i.e., *.csv, *.ixt, or *.*), select the file, and then click on the Open

4. Select the Column Separator. Comma is the default when selecting a CSV File. Other separators (e.g., tab) can be used. If

needed, the ASCII code for any character can be specified, making the import function universal.

Tab The tab character will be used as a separator.
Comma The comma character will be used as a separator.
ASCII Char The specified ASCll value (e.g., 9 (tab), 44 (comma), 32 (space), 58 (colon)) will be used

as a column separator.

5. Some text-based spreadsheets contain strings of $, “, or # symbols. If these are not required as part of the sample names,
select Remove from fields, separate with. Enter the symbol to be removed. Multiple character sequences can be removed

by separating them with “;".
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6. In the “Import Options” panel, select the starting import row and well in the “Start importing FROM row” and “Start

importing TO well” fields.
Start importing FROM

row

Start importing TO

well

Defines the first row in the file from which the data will be imported.

Defines the first well in the “Sample” or “Reaction” plate to which the data will be

imported.

7. Select the remaining options in the “Import Options” panel as desired, and select the column from which this information

will be imported.

Note: The software will automatically limit the number of rows imported to prevent overrunning the end of the import file

and to prevent exceeding the available wells on the plate.

Limit sample count to

Sample name from

column
Load ID from column

Load Conc. from

column

Defines the maximum number of rows of data that can be imported from the file.

Instructs the software to import the sample name from a specific column in the file.

Instructs the software to import an ID from a specific column in the file.

Instructs the software to import a concentration value from a specific column in the file.

8. The “Sample Bank Options” panel of the form describes how data is to be imported to one or more sample banks in the

run. To activate these options, select Add filtered rows to sample bank(s). Only one option may be activated at a time. The

options are:

New Bank

Existing Bank

Bank specified in

column

Banks named from

membership columns

Defines the name of a new sample bank.

During the import, the new sample bank is created and the wells to which data are

imported are used to populate the new sample bank.

Presents a drop-down list of existing sample banks already configured in the target plate

or segment of the run.

During the import, the wells to which data are imported are added to the selected sample

bank. Existing members of the sample bank prior to the import are retained unchanged.

Defines a column that indicates for each row the name of a sample bank containing the
well. At most one sample name per well (row) is permitted (and a blank name indicates

the well is not a member of any bank).

During the import, the software ensures that for the data set imported each sample bank

name in the column is created or updated to include the corresponding member well.

Defines a list of column indices where each referenced column represents the name and
contents of a sample bank. For each such column, the name of the sample bank is in the
first (header) row of the file and any non-blank value in subsequent rows of the column

represents membership of the well in the sample bank.

During the import, the software ensures that for each column in the list the corresponding
sample bank is created or updated to include the member wells of that column in the data

set imported.

See Sections 5.8.1 and 5.9.5 for more information about how to manage sample banks.

QlAgility Version 4.18 User Manual

06/2023 122



9. The Row Filter function allows the user to filter the imported data, limiting the selection of rows prior to import. During

10.

import, only filtered rows presented in the “Import Preview” pane are included in the imported data set. Two filters may be

used. When used together, only rows matching both filtering criteria are included in the selected data set.

The first filter is based on a concentration range. If desired, select the Specify concentration range [Min, Max] function and
then define the options as required. Filtering is based on the concentration values present in the column selected in the Load
Conc. from column configuration option. When active, the “Import Preview” pane shows only those rows where the

concentration filter criteria are met.

Min Concentration Defines the minimum concentration of the concentration range.

Max Concentration Defines the maximum concentration of the concentration rage.

Use selected wells Instructs the software to select rows where the concentration value is within the defined
INSIDE range concentration range.

Use selected wells Instructs the software to select rows where the concentration value is outside the defined
OUTSIDE range concentration range.

The second filter is based on membership in at least one sample bank selected from the file. This function, Members of
selected bank columns only, is available when Bank from column or Banks named from membership columns is selected.
When the filter is activated, the “Import Preview” pane shows only rows with a non-blank value in the selected “Bank from

column” or with a non-blank value in any one of the columns listed at “Banks named from membership columns”.

The “Import Preview” panel displays the samples to be imported. Click the Import button to import the data. The imported
data will be displayed in the righthand pane.

Note: No data are imported from a row in which all fields are empty.
Note: Existing data will be overwritten by any imported data that is located in the same well.

Note: Multiple sample banks simultaneously imported using the Banks named from membership columns function. Alternate
strategies allow multiple sample banks to be successively populated from the same import file. For example this can be
done using the Bank from column function, where several columns, one per sample bank, are present in the file and each
row includes the bank name in the corresponding column to indicate its membership in that bank. Set the Bank from
column and activate the Members of selected bank columns only filter. Click on the Import button. Repeat for each sample
bank column in the file. It can also be done using the concentration filter function. Arrange the import file so that it has a
column representing each sample bank. Populate the rows in each column with a concentration value (e.g., O) to indicate
membership of that sample in that bank. Set the “Row Filter” to include rows with concentrations in the range (0, 0). Set the
“Load Conc.” from column and choose the sample bank name as a New Bank or Existing Bank. Click on the Import button.

Repeat for each sample bank column in the file.

Exporting sample and reaction data

Sample and reaction data, which is listed in the “Sample” and “Reaction” righthand pane, can be exported in a number of

formats. This can be used to transfer data to the Rotor-Gene Q, or other data storage systems (e.g., LIMS environments).
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To export sample or reaction data:

1. Leftclick on a “Sample” or “Reaction” plate to view the righthand pane.

2. Click on the Export button. The “Export Samples” or “Export Reaction Info” dialog box will appear.

- Output

| AR R R e

| Standag Labet & None € Name

£ Name# Concertration |

[ Diem Lbes € Naone CNTC

& Water

‘ Export Range:

@ SelecledPlate ¢ Selected Segment \

- Dutput

[Format speifiers

=

CSV File (Excel

compatible)

Rotorgene v4.4

Rotorgene v4.6 or

later

Custom, comma

separated

Custom, tab
separated
Export directly into

Excel 97 or later

Tube Map CSV file
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3. Select an “Export Mode” from the drop-down menu.

A *.csv text file with comma separators between columns. The data is fixed and contains
the number, location, sample name, reagent name, sample type, concentration, and target
volume.

A *_.sam sample file which is compatible with the Rotor-Gene 2000/3000 software
version 4.6-5.x. The data is fixed and contains location, sample name, and sample type.
A *.smp sample file which is compatible with the Rotor-Gene Q software version 4.6 or
later. The data contains the sample concentration and a user selectable sample identifier

which can be either sample name or sample ID.

A *.csv text file with comma separators between columns. The data can be user-defined.
A *.ixt file with tab separation between columns. The data can be user-defined.

Creates an .xls spreadsheet file and if Excel is installed on the computer, automatically
launches Excel with the imported data. The data can be user-defined.

A *.csv file with format fixed as “well-location, plate identifier, sample identifier” (using
the substitution pattern %2%0%P%0%l|, as described in “Data fields” in this section). This

describes the mapping of a tube/well location (plate and well label) to its contents

(sample identification).
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Rotor-Gene Q v1.x, A *_.smp sample file which is compatible with the Rotor-Gene Q, Rotor-Gene 6000, and

6000 v1.x & 3000 late revisions of the Rotor-Gene 3000 software. The data for each reaction contains a user

vé.x selectable sample identifier and a user selectable concentration. Data can be grouped into
“pages” according fo the master mix and/or reaction identification. See Appendix A —
ABI 7000/7500 SDS master mix naming conventions.

ABI 7000/ 7500 SDS A ‘Setup Table Format' file which can be used with the ABI 7000/7500 SDS software

absolute quantification v1.2.3 for absolute quantification. Master mixes must be named in the QlAgility software
according to special conventions which allow the identification of Detector, Reporter,
Quencher entities required by the ABI SDS software. See Appendix A — ABI 7000/7500

SDS master mix naming conventions.

ABI 7000/ 7500 SDS A ‘Setup Table Format' file which can be used with the ABI 7000/7500 SDS software
allelic discrimination v1.2.3 for allelic discrimination. Master mixes must be named in the QlAgility software
according to special
conventions which allow the identification of Marker entities required by the ABI SDS
software. See Appendix A — ABI 7000/7500 SDS master mix naming conventions.

QlAxcel® BioCal 3.2 A *.csv ‘Sample Info Text’ file which can be imported info the QlAxcel software. The data

(8x12 well grid) is organized in a 8 x 12 grid that contains a user-selectable identifier for each well of the
96-well plate.

QlAxcel ScreenGel® A * xml file which can be imported to the QlAxcel ScreenGel software. This format

(XML) requires a 96 well plate.

Generic XML A * xml file following the schema defined in ...\Integration\xsd\GenericXMLFormat.xsd It

is also possible to select a XSL transformation file that will transform the generic XML
format into another format that is required for your lab system. See Appendix A -

Description of the Generic XML Format.

4. Choose an output format. The output formats available depend on the “Export Mode” that was selected.

Sample Label Determines how the sample is to be named when the data is imported into the Rotor-Gene
software.
Concentration Option Determines the concentration value to be associated with the reaction for import into the

Rotor-Gene software.

Page Option Determines how the reaction data is to be grouped for analysis purposes after import info

the Rotor-Gene software.

Empty Label Determines how unpopulated reaction wells are named during export to the QlAxcel

Sample Import Text file format.

Sample Label
Full ID Comprises the identifier of the reaction well (Reaction ID) and all identifiers of contained
samples (Sample ID).
Sample ID A list of sample identifiers present in the reaction well.
Reaction ID The user-assigned label associated with the reaction well.
Sample Name A list of sample names present in the reaction well.
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Concentration Option

Sample/Source

Final Reaction

Page Option
Master Mix

Reaction ID

Both

None
Empty Label
None
Label
Label Number
Well Number
Export range

Selected Plate

Selected Segment

Uses the initial concentration value. This is associated with the source sample or standard

well.

Uses the final concentration value of the sample or standard after dilution with other

ingredients. This is associated with the reaction well.

Reactions are segregated according to the master mix present in the well, with one page

created for (and named after) each master mix.

Reactions are segregated according to the reaction ID (user-assigned label) associated

with the well, with 1 page created for (and named after) each reaction ID.

Reactions are segregated according to the combination of master mix and reaction ID,
with 1 page created for (and named after) each unique grouping of master mix name and

reaction ID.

All reactions are placed into a single page called ‘Page 1'.

No identification is used (blank).
The well label is used as the identifier.
The index of the well in the pipetting sequence is used as the identifier.

The index of the well in the (horizontal) sequenced grid export is used as the identifier.

All reactions on the selected reaction plate will be exported, even if the plate has more

than one segment.

Only the reactions in the selected segment of the reaction plate will be exported.

Well numbers (This option is only available if “Export Range” is set to “Selected Segment”.)

Relative to Segment

Relative to Plate

5. Click on the Export button.

The well numbers start with 1 at the beginning of the selected segment and proceed in the

selected display order (label or pipet) within the segment.

The well numbering starts at the beginning of the plate and proceeds in the selected

display order (label or pipet) over the whole plate.

6. Enter a file name and select the location to which the data will be exported.

7. Click on the Save button to continue.
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Data fields

Data fields, which are available for export, and their export string designators, are as follows.

Substitution

symbol Sample export Reaction export

%0 Separator (comma, tab) Separator (comma, tab)

%1 Well number in selected display order (label or pipetting sequence, Destination well number in selected display order (label or pipetting
e.g., 10) sequence, e.g., 10)

%2 Well location (address label, e.g., G3) Destination well location (address label, e.g., G3)

%3 Sample type (none, unknown, standard) Sample type (none, unknown, standard)

%l Concentration (if known) Source concentration (if known)

%5 Sample name Final contents, including full names and volumes

%7 Target volume

%8 Name (sample), including volume

%9 Name (reagents), including volume

%A Final contents including full names, excluding volumes

%S Name (sample), excluding volume

%R Name (reagents), excluding volume

%V Sample volume

%F Final concentration (if known)

%P Plate ID Destination plate ID

%p Source plate ID

%l Sample ID Total ID, including tube/reaction ID and constituent IDs of contained

samples

%C Constituent IDs of contained samples

%T Tube/reaction ID

%W Source well location (address label, e.g., B4)

%B Sample type (ABI) Possible values: “UNKWN", “NTC", “Standard”

In the export modes where the data can be freely defined, the user must specify the data content by writing an export string.
During export these designators are substituted with actual corresponding data. For example, to generate a *.csv file from a
sample plate which contains the sample number, the sample location and the sample ID, a valid format string would be:

%1 %0 %2 %0 %l

The %0 between the individual data fields indicates that a separator is to be inserted. A separator will result in a comma in the

case of a *.csv file. In an Excel spreadsheet, a column break would be inserted.
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5.9.8 Progress report

When a run is in progress, the status of the run is summarized in the righthand pane.

— Progr
Stark time: 1:03 P
Current time: 1:04 P
E stimated time of completion: 1:44 PR

40 minutes remaining

Adding 6,5 pl Enzyme to MM GAPDH

Adding 52 pl Primer for GAPDH to Mk GAPDH
Adding 52 pl Primer rev GAPDH to MW GAPDH
Adding 3035 pl Diluent to M TAF 11 100

Adding 130 pl Prebd aster Mix to Mk TAF 1100
&dding 26 pl dNTF's to MM TAF 11100

Adding 6.5 pl Enzyme to Mk TAF 11 700

Adding 52 pl Primer for TAF 11100 to MM TAF 11100
Adding 52 pl Priomer rev TAF 11100 ta MK TAF 11100
Adding 9035 pl Diluent to MM Alpha Catenin
Adding 130 pl Prebd aster Mix to MM Alpha Catenin

Addivn P00l ANT Dz be bk dilelea T o,

r Task:

Task Progress -
Adding 3025 pl Diluert to kMM RAN-BP2 COMPLETE
Adding 130 pl Prebd aster Mix to MM RAN-BPZ2 COMPLETE
&dding 26 pl dNTF's to MM R&N-BP2 COMPLETE
Adding .5 pl Enzyme to bk RAN-BF2 COMPLETE
&dding 52 pl Primer for RAN-BP2 to M RAN-BPZ  COMPLETE
Adding 52 pl Primer rev RAM-BPZ to Mt RAM-EFZ | COMPLETE
&dding 903.5 pl Diluent to M GAPDH COMPLETE
Adding 130 pl Prebd aster Mix to MM GAPDH COMPLETE
Adding 26 pl dNTF's to MM GAPDH “ACTIVE"
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5.10 Programming run files
5.10.1 PCR Setup Wizard

The “PCR Setup Wizard” enables typical PCR reactions, with samples, standards, and master mixes, to be set up. The wizard
allows the user to set up reagents, and then use these to prepare master mixes. The wizard can also be used to set up master

mixes without setting up reactions.

This section outlines the “PCR Setup Wizard” screens that will guide the user through the setup. Instructions are displayed on

each screen.
Note: Depending on the type of run being set up, only some of the screens will be used.
To set up a PCR reaction, using the “PCR Setup Wizard”:

1. Select Wizard/PCR Setup Wizard, or select PCR Setup Wizard from the splash screen that appears when the software is

started.

2. The QlAgility Setup Wizard will appear.
Frcr o zl

PCR setup wizard

This Wizard will take pou thiough each of the simpl steps in configuring reactions with samples and & Master Mix. This wizard guides you thiough creating
aMaster Mix, standard, sample and final reaction.

[ What would you like the wizard to take care of

 Just set up reagents and master mis - | want to set up the rest of the un myself

& want to set up the wholz run from inside the wzard

—Opt

I | pant to set up only asinle master i [<Donit use a preset |
I | want to use standards in this run.

¥ Lutomatically name semple barks

Cancel Hext

QlAgility Version 4.18 User Manual  06/2023 129



3. Select the desired options and then click on the Next button.
Brabecen |
Table P

Confiqure each plale type and function [isagent, sample. reaction. tp) for each posiion. Left click on a plate ta select that plate then change configuration by
either aright click or use bultans at top right. Set plate type before selecting function.

AZ: Tip (50y] Tecantip)—————————— Set Plate
1z34568

ERERCI T,

e e e e s e e e e SelFuelon
. .

Af: Tip (200p! Tecan tip)
‘Tzasseiesmnm

(M1 (Mix plate (5 tul % %

O O - s |

o

o = /B1: Tip (5001 Tecan tin) B2: Reaction (20004] deep well, CR)
R (Reagent block | s 4 monosoooooon

o : c caosasosazaoa

%o 0 g B BEEaRAERAEEE

i 0 : 7 BE3EEEEEEa4EE

=

o o KO

:g @ D /C1: Sample {200yl PCR tube, Generic) |C2: Reaction (2001 PCR tube, Generic)

"o G D

1o 1010 § BooBosaeEska |Ild BopBEoBEREEE

0 E o0OoOO00OQO0OQO0OO0O00 E 000002000 O0O0O0

wo oD @ 5 8238838988888 P 8888852228888

e 7 BEBREEHREREE || @ EBBEEBEREREE

o w3 eO

Back Hest
Set Plate Opens the “Plate Configuration” dialog box, which provides options to change the plate
type. See Section 5.7.1 for more details about how to change the plate type using the
“Plate Configuration” dialog box.
Set Function Opens a submenu which provides options to change the plate function. See Section 5.7.1

for more details about the available plate functions.
. Leftclick on a plate to select it. Click on the Set Plate button.
. The “Plate Configuration” dialog box will open. Change the plate type as outlined in Section 5.7.1.

. Repeat steps 4-5 for all plates on the worktable.

N O 00 M

. Leftclick on a plate to select it. Click on the Set Function button. A submenu will appear. To update the plate function, select

Sample, Reaction, Reagent, Standard, or Mix.

00}

. Repeat step 7 for all plates on the worktable.

9. Click on the Next button to continue.
i et o -pemgert iy ﬂ

Reagent

Setup reagents that are going bo be used in the Master Mix. All locations configured as reagents in the previous screen are avalable here to have their contents
st up. To setup wour rzagents click on the plate holding the reagents, Click Mext to confinue.

A1:Tip (200 Tecantip) | [AZ:Tip (50p Tecan tip)

(M (Mix plate (5 tube

(B1: Tip (50pl Tecantip) | B2 Reaction (2000l deep well, CR}

[R1 (Reagent block (st

&
O

/€1: Sample {200yl PCR tube, Generic)

/C2: Reaction (200p] PCR tube, Generic}

&
oo &0 ddod

Back Hent
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10. Left<click on a plate which has Reagent function. The following dialog box will appear.

B Please enter reagent details... x|

wel [Reagent [iiscaus? oK

A 10x Buffer Mo
B aClz No ﬂl
C dNTP No
D Frimer(fved) No
E Primerlrev) Mo
F Probe 1 No
G Frobe 2 No
H Taq Yes

Clear &l

Clear all Clears all information in the “Reagent” column and updates all cells in the “Viscous?” column
to No.

11. To change the reagent name, leftclick on a cell in the “Reagent” column, and then enter a new name. To change a reagent
from viscous to non-viscous, left-click on a cell in the “Viscous2” column, check the box, and then click on the OK tab.

Repeat this procedure to change a reagent from non-viscous to viscous.

12. Click on the OK button to continue.
x

Reagent
Setup reagents that are going to be used in the Master Mix. Alllocations configured as reagents in the previous screen are available here to have their contents
setup. To setup your isagents click on the plate holding the reagents. Click Nest to continue

A1: Tip (20041 Conductive tip, QIAGEH) A2: Tip (50ul Conductive tip, QIAGEH)

(M1 (Mix plate (5 tube

/B1: Tip (50 Gondustive tip, ) (B2: (Empty)

/R1 (Reagenit block (st

Yo} [€1: Sample (200ul PCR tube, ABgene} [€2: Reaction (200ul PCR tube, ABI}

{le]

LTI

Back Hest

Repeat this step until all reagent segments you want to use are defined.
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13. Click Next to continue.

B Pplate/well Selector

x

‘ Please select the location of your master mix.

A1:Tip (200pi Tecantipy | (A2 Tip (50pl Tecan tip)
M1 (Mix plate (5 tube
0 B
Ciel
' =0 (BY: Tip (50wl Tecantip)—| (B2 Reaction (2000ul deep well, CR)-—

/R1 (Reagent block (st

[C1: Sample (2004l PCR tube, Generic)

[C2: Reaction (200l PCR tube, Generic)

14. Leftclick on a well in the Master Mix Block to select the location of the master mix. The “Master Mix Component Selection”

dialog box will appear.

B Master Mix Component Selection x|

Make: mis up ta this volume [not including sample/NTC volumel: |20 El u

Diefaulk sample volume for this mi: 0 E u

How muich reagent to manually inseit per reaction? lu—El W Pause robot to manualy load reagents after final ingredient added,
€ Aol ingredients  preloaed before the 1
Default reaction volume: lzg—
~Componert
Select reagents (and their volumes)] to use i this s, (water volume is automaticaly caiulale] Use il Use Nane
Plate Tube Loation | Name Juser vl perReaction
water = E]
Risagent block (stand. 1.5mi tapered hinged | 10% Bulfer Na 25
Rieagen block (stands. 1.5m tapered hinged i MaCI2 Na 15
Fizagent block (stands. 1.5mi tapered hinged K TP Na 2
Rieagen block (stands. 1.5m tapered hinged L Prime(fwd] Na 1
Fizagent block (stand. 1.5mi tapered hinged M Frimer(es) No 1
Rieagen block (stands. 1.5m tapered hinged N Probe 1 Na 05
Fizagent block [standa. 1.5 tapered hinged . o Frobe 2 No 05
Rieagen block (stands. 1.5m tapered hinged P Tag

15. Configure the components of the master mix, as outlined in Section 5.9.4.

16. Click on the OK button to continue.

17. The “Standards Editor” screen will appear. (steps 17 to 21 will only appear if you selected “l want to use standards in this

run” on the first page of the wizard.)
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B8 pCR setup wizard - Standards editor

[~ Standards Edi

Configure each of the standards. To activate a standard check the bostta the far left, after you have speciied reagent volumes, ysu can name the standard and

also edit the standards concentration. Click Next to continue.

- \F'i;e;‘;:?th\unk[slandaldZEIEI,HaI,Iapered]@R1, lm m || e | e || T 5

I~ Aeagor lck tonda 200t eped) © . W Edt | Load | Save | Show

Back Hewt

Edit Opens the “Edit Standard” dialog box, which enables a standard to be configured.
Load Enables a predefined standard dilution series configuration to be loaded from a file.
Save Enables the current standard dilution series configuration to be saved in a file.
Show lllustrates the location of the standard dilution series on the worktable.

18. Select a standard from the list. The following dialog box will appear.

B edit Standard

Drtail

Mumber of diution concentrations
[including first undiluted standard]

Cancentration of undiluted standard

IW_EI Cancel '
— | e |

Dilution ratio 1 I1 0 E

Number of dilution

concentrations

Concentration of
undiluted standard

Dilution ratio

Defines the total number of wells in the dilution series, including the initial undiluted (stock)
well of the standard.

Defines the concentration of the starting undiluted (stock) well of the standard dilution
series.

Defines the dilution ratio for successive wells in the standard dilution series. Concentrations
of successive wells in the series are determined by multiplying the concentration of the

preceding well in the series by the dilution ratio.

19. Define the “Number of dilution concentrations”, the “Concentration of undiluted standard”, and the “Dilution ratio”.

20. Click on the OK button to continue.

21. Repeat steps 18-20 for any remaining standards.

22. Click on the Next button to continue.
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23. The “Sample Editor” screen will appear.

BB PCR setup wizard - Sample editor

~Sample Ed

This page is used to et up sample banks

Click on Nest to continue.

~Ta add & new sample bank click on the piate you would lke to add 2 sample bank ta and follow the prompts.
- To edit an xisting bank, highliaht the bank vou wish to edt and cick an Edit Bark.

~To rename a bank. hiohlight the bank you vwish to rename and dlick on Rename Bark

- To delete a bank. highlight the bank you wish to delete and click on Delste: Bank.

A1 Tip (2004 Tecan tip) | (A2: Tip (50pl Tecan tip) 7]

1 (Mix pla
u B1: Tip (50l Tecan tip)— B2: Reaction (2000, deep

11 (Reagen

CRtub [C2: Reaction (200pl PCR tu

(PR
aoeoo600 N
soooo0on

DeletoBark | RenameBenk | NewBank |  EdtBank | Back Hest
Delete Bank Deletes selected sample bank.

Rename Bank

New Bank

Edit Bank

24. Existing sample banks will be listed on the left side of the dialog box. Use the buttons beneath the list to manage the sample

Opens a dialog box from where the sample bank name can be changed. Click on the OK

button o continue.

Displays the “Update Sample Bank” dialog box, which enables a new sample bank to be

created. See Section 5.8.1.

Displays the “Update Sample Bank” dialog box, which enables an existing sample bank to

be modified. See Section 5.8.1.

bank list. Alternatively, leftclick on a plate with Sample or Reaction function. The “Update Sample Bank” dialog box will

appear. Create sample banks as outlined in Section 5.8.1.

25. Click on the Next button to continue.

26. The “Reaction Editor” screen will appear.

B PCR setup wizard - Reaction editor

%

Reaction
To complete the wizard, combine the sample and standard qroups with the master mives. To add a reaction select a master i, select a standard of sample to
add o this i and select the plate in which you would like the reaction ta take place.

~ Enter mix
Master mi Standards fsamples Target plate
i B v+ [water NTCLT wel =] » [GeneDisc [F2lloadng stz (1-72) @ B1 Add
= [ E\levahun[s]
LCopy
Delete
Up| Dn
Back. Mext
Master mix

Standards/-samples

QlAgility Version 4.18 User Manual

Defines the master mix that will be used in a reaction.

Defines the standard or sample that will be used in a reaction.
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iteration(s) Defines the number of reaction replicates that will be performed.
Target plate Defines the target plate that the reaction will be pipetted into.

Opens the “Plate/well Selector” screen, which enables selection of the target reaction plate.
Add Adds a reaction fo the “Reactions” list.

Copy Enables a selected reaction to be copied within the “Reactions” list. Options to Copy in-

place?, Copy to end of list?, or Cancel will appear.

Delete Deletes a selected reaction in the “Reactions” list.
Up Moves a selected reaction in the “Reactions” list 1 position up the list.
Dn Moves a selected reaction in the “Reactions” list 1 position down the list.

27. Select a master mix from the drop-down menu.

28. Select a standard or sample from the second drop-down menu and define the number of replicates in the field below.
29. Click on the == button to define the “Target plate”.

30. Click on the Add button. The reaction will now be added to the “Reactions” list.

31. Repeat steps 26-29 for all required reactions.

32. Click on the Next button.

33. The following message will appear.

‘Wizard completed! You can enter this wizard again from the Wizards menu and
make changes if necessary.,

34. Click on the OK button to return to the main software window.

5.10.2 Optimisation Wizard

The Optimisation Wizard enables matrix combinations of reactions, based on different concentrations of reagents, to be set up.
For example, to optimize a probe and primer (forward and reverse combined), a reaction could be set up with 3 different
concentrations of the probe and with 3 different concentrations of primer (i.e., a total of 9 reactions). Several optimizations are
possible using the Optimisation Wizard.

Note: The user must provide all required concentrations of all the variables that are to be optimized.

This section outlines the Optimisation Wizard screens that will guide the user through the setup. Instructions are displayed on

each screen.

Note: The Optimisation Wizard only provides steps to set up an optimized matrix, it does not provide steps for preparation of a

master mix.
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To set up a PCR reaction using the Optimisation Wizard:

1. Select Wizard/Optimisation Wizard, or select Optimisation Wizard from the splash screen that appears when the software
is started.

2. The “Optimisation Wizard” will appear.

[B® optimisation Wizard

Qptimisation wizard

This ‘Wizard will kake you through each of the simple steps in setting up an optimization. Select the type of aptimization you would like to
perform. I you would fike to use a non-premized Master Mix please ensure you have alieady created one:

[ Please select a type of optimisation to continue:

1 Single wariable optimisation. This creates one reagent ko optimise.
[ie Magnesivm or Dye.)

Two variable optimisation. This creates two reagents to optimise.
8 (i2 Probe wih combined Forward and Reverse Primers.)

Thiee variable optiisation. This creates thiee reagerts to optimise.
3 (ie Probe with bioth Farward and Reverse Primers |

Lancel et

3. Select option 1, 2, or 3. These options define the number of variables to be optimized.

4. Click on the Next button to continue.

B optimisation wizard - Optimised Reagents = x

Reagent

Eniter the name of this reagent. Select the amount of the reagert ta use and the number of different concentiations o optimise.

- Optior

Reagent name: Reagent 1

How much of this reagent would you lke ta use in the
final reaction?

o many diferen concentaions woxidyou et use? [ | El

Reagent

[ Cancentation

1 | 0k

Set Locations Back Mext

Reagent name Defines the name of the reagent.

How much of this Defines the volume of reagent to be used in the reaction.
reagent would you
like to use in the final

reaction?

How many different Defines the number of different concentrations of reagent to be optimized.

concentrations would

you like to use?
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Set Locations Opens the “Reagent selector” window, which enables selection of the location of reagents

on the software worktable.

5. Define the reagent name.

6. Define the volume of reagent to use in the final reaction.

7. Define the number of different concentrations to use. The number of rows in the “Reagents” table will be adjusted

accordingly.

8. Enter the concentrations directly into the “Reagents” table.

9. Click on the

Next button.

10. The “Reagent selector” window will open. The reagents are listed in the “Reagents” panel in white boxes.
[rcagent seiector =

Select locations for these reagents

/M1 (Mix plate (5 1

/R1 (Reagent bloc

A O

683683680
36800680

At Tip (2004 Tecan tip) A2: Tip (50p1 Tecan tip)

o

Drag to destination,

double-ciick fo resst
Fieagent 1 51

Feagent 1 (10)

Fieagent 1 (16)

B1: Tip (50l Tecan tip) /B2: Reaction (2000pI deep well, CR)—

/€1: Sample (2001 PCR tube, Generic) | | C2: Reaction (200l PCR tube, Genericy

Back Neat

11. Each reagent must be assigned a location, otherwise the reagent import will be canceled. To do this, leftclick on a reagent

and drag it to the desired well on a reagent plate. Do this for all the reagents. If the reagent locations do not matter, click

and drag the “Auto” white box to the desired reagent segment. Reagents will automatically be assigned to a location.

Selected wells will be highlighted red.

Note: Some

reagent locations may already be in use by previously defined reagents. If the name of the reagent used in the

saved master mix setup is identical fo reagents already set up, these will automatically be allocated to those positions.

12. To reset the

location of any reagent, double-click on a reagent in the list, then leftclick and drag again. Alternatively, click

on the Reset All button to clear all reagent locations, other than those that were defined upon entering the screen.

13. Click on the

Next button.

14. If only one reagent will be optimized (i.e., if option 1 was selected in step 3), proceed to step 15. If more than one reagent

will be optimized (i.e., option 2 or 3 was selected in step 3), repeat steps 7-13, and then proceed to step 15.
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15. The “Optimisation Wizard — Replicates” dialog box will appear.

BB 0ptimisation Wizard - Replicates

96 well piate [vertical) @ B2

How many replicates Defines the number of replicates for each reaction.

would you like to

produce?

Master mix Defines the master mix to be used.

Create Premixed MM Opens the “Plate/well Selector” window, which enables a premixed master mix to be set up.
Target plate Defines the target plate that the reactions will be pipetted into.

. Opens the “Plate/well Selector” screen, which enables selection of the target reaction plate.
Clear existing When selected, the wizard deletes all existing reactions in the run before generating the
reactions? optimization reactions. When this option is not selected, the wizard appends the

optimization reactions to the existing reaction list.
16. Define the number of replicates for each reaction.
17. Define the master mix to be used in the reaction.

18. Click on the Create Premixed MM button. The “Plate/well Selector” window will appear.

B Plate/well Selector

19. Leftclick on a well in the Master Mix Block to select the location of the master mix.
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20. The following message box will appear.

I x

Wolurme per sample? [hot including additional reagernts

added by this wizard)
Cancel

21. Enter the volume of master mix to be used per reaction.

22. Click on the OK button.

oracen
.
1) wizard complete!

23. Click on the OK button to return to the main software window.
5.10.3 Using “Empty Project”

1. Select the ' icon from the toolbar. The following splash screen will appear. This splash screen will also appear when

starting the software, and can also be accessed by selecting “File/New”.

QlAgility — Pure Precision  $s3ss

| Becent' Erntncn\sl

EEEEE Empty project. [last uged layout] I&I
Cancel
EEEEE Empty project. [default layout) &I

" PCR Setup ‘wizard.

?')? Optimization *w/izard

2. Select either Empty Project (last used layout) to use the layout from the most recent run, or Empty Project (default layout) to

use a conventional layout as presented immediately after initial installation. Then click on the Open button.

3. Select the correct plate type in the software for each position on the worktable. The plate types selected in the software must

match the actual worktable setup. See Section 5.7.1 for details about how to change plate types.

4. Select the correct plate function for each plate on the worktable (i.e., “Diluent”, “Reaction”, “Reagent”, “Standard”, “Mix”"

or “Tip"). See Section 5.7.1 for details of how to change plate function.
Note: Ensure that only plates that have been position and height calibrated are used.
5. Set the tip availability for every plate that has Tip function. See Section 5.7.2 for details about setting tip availability.

6. Configure the samples, diluent, standards, reagents and master mix. See Section 5.9.
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7. Set up the reaction list. See Section 5.9.6 for details about how to do this. In addition, see Section 5.10.4 for examples of

how to set up typical reactions.
8. To save the run file, select File > Save As. Enter a name for the run file and select a location in which to save it.

9. Click on the Save button.

5.10.4 Example reactions

This section outlines the protocols for setting up a number of typical reactions.

Open the “Reaction” righthand pane, as outlined in Section 5.9.6, and then use one of the following example reactions:

Master mix with no sample

Master mix with sample bank

Sample bank with no master mix

Sample bank with reagents not used in master mix

Sample bank with master mix and reagents not used in a master mix
No template control with master mix

Alternate samples or standards with no template control

Empty wells
Master mix with no sample

1. Select No samples (empty wells) from the “Samples” panel.
2. Select the master mix.

3. Enter the number of replicates in the “Target wells” panel. The number of replicates will equal the number of wells in the

reaction plate.

4. Click on the OK button.
Master mix with standard

1. Select the dilution series from the “Samples” panel.
2. Select the master mix.

3. Enter the number of replicates in the “Target wells” panel.

4. Click on the OK button.
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Master mix with sample bank

1. Select the sample bank from the “Samples” panel.
2. Select the master mix.
3. Enter the number of replicates in the “Target wells” panel.

4. Click on the OK button.
Sample bank with no master mix

1. Select the sample bank from the “Samples” panel.
2. Set the sample volume in the “Volume” panel.
3. Enter the number of replicates in the “Target wells” panel.

4. Click on the OK button.
Sample bank with reagents not used in master mix

1. Select the sample bank from the “Samples” panel.
2. Select the reagents from the “Unmixed reagents” panel.
3. Enter the number of replicates in the “Target wells” panel.

4. Click on the OK button.
Sample bank with master mix and reagents not used in a master mix

1. Select the sample bank from the “Samples” panel.

2. Select the master mix.

3. Select the reagents from the “Unmixed reagents” panel.
4. Enter the number of replicates in the “Target wells panel”.

5. Click on the OK button.
No template control with master mix

1. Select “Diluent” from the “Samples” panel.
2. Select the master mix.
3. Enter the number of replicates in the “Target wells panel”.

4. Click on the OK button.
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Alternate samples or standards with no template control

1. Select the sample bank from the “Samples” panel.
2. Select the master mix.

3. Check the Alternate sample wells with diluent? box.
4. Click on the OK button.

Empty wells

1. Select No samples (empty wells) from the “Samples” panel.
2. Enter the number of empty wells in the “Target wells panel”.

3. Click on the OK button.
5.10.5 Checking the reaction setup
A reaction setup can be checked in 2 ways:

® Run a simulation of the reaction setup in “Virtual Mode”. See Sections 5.1 and 5.2 for more information about “Virtual
Mode” operation.

® Place the cursor over a source well to check the destination well(s) of the source well. The destination wells will be
highlighted. For instance, if the cursor is placed over a master mix well, the wells on the reaction plate that will contain that

master mix are highlighted.
5.10.6 Required volumes for reaction setup

The software automatically calculates the volume of standard, diluent, reagents, and master mix required for a reaction setup.
To view the volume of liquid required, generate the pre-run report. This report will list the required volumes. See Section 6.7.1

for more information about the pre-run report.

Alternatively, position the cursor above a source well (i.e., diluent, reagent, master mix, or standard). A hover box will appear
that reports the volume required. This volume includes an extra volume, to account for the dead volume, that is dependent on the

tube type.

= |“ Ty VewyTwwew ||“
ll K. in Reagent block (standard 200 Hat tapered] & R1
@ 1.5ml tapered hinged tube [Reagent]
Eiefore run, manually load:
@ || [NTP 30+ 20 =E0 L

TS B 7§ 9 WIT ||

| T
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5.11 Selecting the COM port

1. Select Options > Robot Setup > Select COM port.

2. The “Configure Serial Interface” dialog box will open.

nfigure Serial Interface

LCancel |

Fuort Selection
Serial Pot: [ oppgg = ﬂ
COM1

|COM3

3. Select the desired COM port from the drop-down menu and then click on the OK button.

Note: The software lists only eligible COM ports and marks the mostly likely port on which the instrument can be found with

an asterisk (*). For correct communication of the laptop (supplied with the QIAgility) with the instrument:

4. The following message will appear.
aseer |

2 Software must be restarted for the change of serial port selection to take
effect. Shukdown software now?

5. Click on the Yes button to shut down the software.

6. Restart the software.

5.12 Service register

The service register describes the current status of maintenance alert notification records that are associated with the instrument.

The software maintains a schedule of required service activities in the service register.

Maintenance activities that are scheduled for future dates are displayed as green records. When a scheduled maintenance

activity is due, the record is displayed in red, and a service alert notification is generated.

If the system has any unacknowledged service alert notifications, the % icon in the toolbar is marked with a red exclamation

mark.
Service alert nofifications can be acknowledged by an operator, using the “Service Register” dialog box.
To view the “Service Register” dialog box:

1. Select Options > Robot Setup > Service register.
2. The “Service Register” dialog box will appear.

3. The component that requires a service most urgently will be preselected (i.e., Pippettor or Hepa Filter). Components that are

colored red are due for a service, and components that are colored green are due for a service at a future date.
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M cervice Register x|

Item Due Date Acknowledged By | Acknowledge Date

Hepa Filter

Companent Fipettor DueDate 21-0ct-2009 14:40:45

Reason Period betwesn services: 12M
Last service date: 21-0ct-2008 04:40:45 {from Installation)
Dperations between services: 300000
Dperations at last service: 0 [from Instalation]
Cuirent operations: 365013 [usage count exceeded)

Acknowledge Date  [17.Nav-2008 02:53:35 Acknowledged By [Qagiity User

s
-
[
it S |
Component Defines the selected component to be serviced — “Pipettor” or “Hepa Filter”.
Due Date Defines the date that a service is required.
Acknowledgment Date Displays the current date and time.
Acknowledged by Displays the current user name.
Comment Allows the user to enfer and save comments with the acknowledgment of a service.
Acknowledge Service Confirms that the selected service has been completed.
Exit Closes the “Service Register” dialog box.

To acknowledge a service:

1. Select the component that has been serviced.

2. Enter your user name in the Acknowledged By field.

3. If desired, enter further details about the service in the Comment field.
4. Click on the Acknowledge Service button.

5. A message will appear which summarizes the service acknowledgment.
wacen =

9y Service notification will be acknowledged as completed with the Following details:
N, )

ITtem: Pipettor

Due Deakbe: 21-Cock-2009 04:40:45

Period between services: 12M

Last service date! 21-Oct-2005 04:40:45 (From Installation)
Operations bebween services: 300000

Operations at |ast service: 0 {from Installation)

Current operations: 366013 (usage count exceeded)

Acknowledge Date: 17-Mow-2008 03:10:50
Acknowledged By: QLagility User

Saving this service acknowledgement resets any service alert notification
associabed with the Pipettor and restarts the service schedule For this item,

Do you wish to save this service acknowledgement?

i Cancel

6. Click on the Save button to save the service acknowledgment.

7. The service that has been acknowledged will now be colored black in the “Service Register” dialog box. In addition, the

component will be colored in green, as a reminder of a future service.

Note: Once a service has been acknowledged and saved, it cannot be edited.
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Note: A component can be serviced at anytime — it does not need to be colored red in the “Service Register” dialog box

for a service to be performed.

Note: After acknowledgment of a pipettor service, volume calibration must be done before the start of the first run. An error is

shown at the start of a run if no volume calibration has been done.

Flease acknowledge the following messages and hit QK. to cantinue.

Blue messages are warnings and must be checked to continue,
Red meszages are erors and prevent the run from starting.

Messages I
|M[Volume calibration must be done before run.
[ Flease make sure the tip sjector is present. the tip discard chute is clear and open and the tip disposal box is empty.

[ Plzase corfim that tpe, bubes, plates and liquids have been setup comectly as per the Pre-Fun Report.

O (cannot start wn)

CRITICAL

Volume calibration must be done before run.

Pre-Run Beport

Cancel | [ Check Al
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6  Operating Procedures

This section describes how to operate the QlAgility.

Before proceeding, we recommend that you familiarize yourself with the features of the QIAgility by referring to Sections 3.2

and 3.2.10.

The QlAgility lid must remain closed during operation of the instrument. Only open the lid when the instrument is not operating

or when instructed to do so by the software.

Note: Opening the lid during operation of the QIAgility will cause the system to pause. The instrument will complete the current

movement, which may take up to 10 seconds.

WARNING/ | Risk of personal injury and material damage
CAUTION Do not attempt to move the QlAgility during operation.

JAN

WARNING Moving parts
To avoid contact with moving parts during operation of the QlAgility, the instrument must be operated
A with the lid closed.

If the in-built lid sensor is not functioning correctly, contact QIAGEN Technical Services.

6.1  Starting the software

Note: Before starting the software, ensure that the instrument lid is closed and that the QlAgility is switched on.

e

ﬂ. AE
CiIAgility

1. Double<lick on the QlAgility icon on the desktop.

2. If the instrument is connected to the computer, the software will proceed automatically to “Normal Mode” operation. If the
instrument is not connected to the computer, or if the instrument is switched off, the software will run in “Virtual Mode”. See

Section 5.2 for more details about “Virtual Mode” operation.
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QlAgility — Pure Precision 33358

CHAGItyY Veraon 4.18.1
Busild 03 (1.6.77)

Flease vt - Erumerstrg tables

Updates and addiional resources avalsbls st
hitpe. wm. Qragen, comm

‘wianing: This comguler peogram it proteched
by copright L and intemational neaties
Unauthoemed regeoducton of the: progra, o
ey portan ol &, inay résul n sevese cnal and
crennal penales, and vl be piosecubed 1o
the msamum extent posoble under the Ly

S

Fouce Vitual Mode

3. The welcome dialog will open.

QlAgility — Pure Precision  sssss

"N‘EW | ﬁecentl Eroloco\sl

EEEEE Empty project. [last used layout] ﬂl
Cancel
EEEEE Empty project. [default lapout] g

* PCR Setup wizard

P Optimization Wizard

To create a new run file, select Empty project (last used layout), Empty project (default layout), PCR Setup Wizard, or Optimisation
Wizard, and then click on the Open button to continue. See Sections 5.10.1, 5.10.2, and 5.10.3 for more details about these

options.

To use a saved run file, or to modify a saved run file, click on the Recent tab. A list of saved run files will be displayed. Leftclick

on a run file to select it, and then click on the Open button.

To use a Q Protocol, click on the Protocols tab. A list of Q Protocols will be displayed, leftclick on a run file to select it, and then

click on the Open button. Alternatively, double-click on the run file to open it directly.

1. The main software window will open. See Section 5.3 for a description of the features of the main software window.
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6.2 Using the UV lamp

Warning: An electronic interlock ensures that the instrument lid is closed during UV lamp operation. Under no circumstances

should this interlock be disabled.
Before operating the UV lamp, remove all worktable accessories. This ensures that the worktable has maximum exposure.
To operate the UV lamp:

1. Remove all plates and accessories from the worktable.
Note: The tip ejector must be present.

2. Close the instrument lid.

3. Click on the @ icon on the toolbar.

4. The “UV Lamp Control” dialog box will appear.
— Statu Clase |

Lid status: Clased or naot installed

Lamp status: Inactive [OFF]

i~ Timed Control

Activate LY lamp for: IUD:1 500 E

I Cloze software when U finishes?

~ Manual Control

B |

Lid status Indicates whether the instrument lid is Closed or not installed or Open.

Lamp status Indicates whether the lamp is Inactive (OFF) or Active (ON].

Activate lamp for Enables the user to set UV lamp exposure times of between 1 second and 30 minutes, using
the arrows.

Start Initiates UV lamp operation.

Close software when Shuts down the QlAgility Software when UV lamp operation is complefe.

UV finishes?

Enable Lamp Switches the UV lamp on.

Disable Lamp Switches the UV lamp off.

Close Closes the “UV Lamp Control” dialog box.

5. The UV lamp can be enabled using timed control or manual control. Under manual control the instrument arm does not

move and shadowing will result. Under timed control, the instrument arm moves between 2 locations in 5 s intervals.

6. If using timed control, define the exposure time and click on the Start button. If using manual control, click on the Enable

Lamp button.

7. A message box will appear. Read it carefully.
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8. Click on the Yes button to start operation of the UV lamp.
Note: To switch the UV lamp off, click on the Stop button.

6.3  Operating the HEPA filter
When the HEPA filter is switched off, the HEPA filter icon in the toolbar appears red.
To operate the HEPA filter:

1. Click on the # icon in the toolbar.
2. The HEPA filter will switch on and the HEPA filter icon in the toolbar will appear green.
3. To switch the HEPA filter off, click on the ‘# icon in the toolbar.

6.4  Executing a run

6.4.1 Q Protocols

Q Protocols are run files which have been developed to directly facilitate specific PCR applications. Q Protocols are installed
within the QProtocols subfolder. To access this folder, select Installation directory of QlAgility Software\QIAgility\QProtocols
(e.g., C:\Program Files\QIAgility\QProtocols).

Q Protocols are locked. Edit access is only permitted to update the lab notebook, set tip availability, modify sample banks and

assign plate IDs/barcodes and well IDs/barcodes to sample/reaction wells defined in the run.

A loaded Q Protocol cannot be saved as a Q Protocol. It can be saved as a locked “User-Developed Protocol” or an unlocked

normal run file. If further adjustments are required, the Q Protocol must be unlocked and saved as a normal run file.

If the user attempts to overwrite an existing Q Protocol, the following message will appear.

1 CiiProgram Files\QlAglitylQProtocolsiHot StarTagl _signed3.QAsS is a QIAGEN
[ Pratocol run and cannot be overaritten,

Using a Q Protocol

1. Start the QlAgility software, as outlined in Section 5.1.
Note: If the QlAgility software is already operating, press the 11 icon in the toolbar.

2. The following screen will appear.
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QlAgility — Pure Precision 33358

QUAGItY Version 4.18.1
Build 03 {1.6.77)

Flease vt - Erumerstrg tables

Updates and addiional resources avalsbls st
hitpe. wm. Qragen, comm

‘wianing: This comgader peogram is protecied
by copright L and intemational neaties
Unauthoemed regeoducton of the: progra, o
ary portaon: ol &, ey esul n sevese cnal nd
crennal penales, and vl be piosecubed 1o
the msamum extent posoble under the Ly

Fouce Yihsal Mode

3. The welcome dialog will open.

QlAgility — Pure Precision

] 1]

L]
L]
IAGEN

"N‘EW | ﬁecentl Eroloco\sl

EEEEE Empty project. [last used layout] ﬂl
Cancel
EEEEE Empty project. [default lapout] g

* PCR Setup wizard

P Optimization Wizard

4. Select the Protocols tab. All Q Protocols that are saved in the appropriate folder (i.e., QProtocols) will be displayed.

QlAgility — Pure Precision  sssse

Hew | Recent { Protocols |

.
@ Rotor-Gene SYBR Green PCR_V1 l&l
Cancel

5. Select the desired Q Protocol.

QlAgility Version 4.18 User Manual  06/2023 150



6. Click on the Open button.
7. A description of the Q Protocol will appear.

Rotor-Gene SYBR Green PCR

QlAgility assay setup protocol using the Rotor-Gene SYBR Green PCR Kit
Q Protocol description

+ Tests 4 DNA targets using 4 diferent primer sets

« Upto 5 different samples

« Primer starting concentration = 10 uM

« Primer final concentration = 1y

Assay Setup

Liquid | Volume (ul)

Master mix | 20

Sample |5

Reaction | 9% |

8. Review the description and then click on the Close button.

9. If necessary, modify the Q Protocol according to your needs. The user can adjust the lab notebook, set tip availability (see
Section 5.7.2), modify sample banks (see Section 5.8.1), assign plate IDs/barcodes (see Sections 5.9.5, 5.9.6,
and 5.9.7) and assign well IDs/barcodes to sample/reaction wells (see Sections 5.9.5, 5.9.6, and 5.9.7).

6.4.2 Selecting a saved run file

To open a saved run file:

. . =
1. Select File > Open, or click on the "= icon.

21|
Lookir: [ Dala - «e@mckE-
|=itogs
|iReports
|5 SupportPackages
File rame: | = o |
Files of type: [Bltgity Document [ 345) & Cancel

i

2. Select a file and then click on the Open button.
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To open a recently used run file using the toolbar:

1. Click on the I icon on the toolbar.

2. Select the Recent tab.

"'ty_ s e eseoe
QlAgili Pure Precision ~ sssss
Mew | Becent | Protozols |

% T_MM_MisDigp &I
é PCRO30 _ s |
é NORM100

@ MX0ES

é PCR1OT

% PCROSD

é PCROM3

é FCRO4T

3. Select a run file from the list and then click on the Open button.

To open a recently used file from the File menu:

1. Select “File” from the menu bar. Recently used run files are listed in the “File” menu.

File Conbrol ‘\Wizards Options Help

New Chrl+h
Cpen, .. ChrO
Save As.,. Chr+5

Lab notebook...

1 HokStarTagl.Qas
2 QuankiFAST-SYBR-Y7.QAS
3 BWDV-8.045

Exit Chr+Q

2. Select one of these files.

6.4.3 Creating a new run file

There are 2 wizards, “PCR Setup Wizard” and “Optimisation Wizard”, which can be used to create a new run file. Alternatively,
a new file can be created by selecting Empty Project (last used layout) or Empty Project (default layout) when the software is

started.

Note: Once a run file has been created, it can be checked using “Virtual Mode” operation. See Sections 5.1 and 5.2 for more

details about “Virtual Mode” operation.

See Sections 5.10.1, 5.10.2, and 5.10.3 for information about how to create a new run file, either using a wizard, or using the

Empty Project” (last used layout) or Empty Project (default layout) function.
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6.4.4 Preparing the worktable

After loading the desired run file, the worktable must be prepared. The pre-run report provides details about the location and
amount/volume of consumables and liquids that are required on the worktable for completion of the loaded run file. To view the

pre-run report, select “Wizards/Generate report”. See Section 6.7.1 for more details about the pre-run report.

Note: Before preparing the worktable, ensure that the tip disposal box has sufficient space to accommodate additional used tips

that will be produced from the run.

1. Prepare the reagents and samples.
2. Open the instrument lid.

3. If tips are available on the worktable, check whether these are the correct tip types and whether sufficient tips are
available. If not, add more tips to the worktable and make these available in the software. See Section 5.7.2 for more

details about how to do this. The following picture outlines how to insert tips info Tip Rack Holders.

1

-

1

-
-'--—-

l .

4. Place the correct plates on the worktable.

5. Lload the correct plate height and plate position calibrations for each plate and Tip Rack Holder. See Sections 5.5.2, 7.1.2,

and 7.1.3 for more details about how to do this.
6. Place the correct tubes in each plate on the worktable.

7. Add the correct volumes of reagent, diluent, standard, samples, and, if used, premixed master mix into the correct tubes on

the worktable.

Note: To view the required volume of liquid, place the cursor over the source well. A hover box will appear which displays
the required volume of liquid that the software has calculated. This volume includes the extra volume which allows for liquid

recovery limitations and losses due to evaporation and tip contact during pipetting. Alternatively, view the pre-run report.
- |" Tevwvwvwvvwvwwwwwew ||“

el K. in Reagent block (standard 200 flat tapered) @ R1
@ 1.5ml tapered hinged tube [Reagent]

Eiefore mn, manually load:
@ || |dMTP, 30 pl+ 20 pl =50 pl.
I e

TE T T ||

8. Close the instrument lid.
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6.4.5 Starting a run

1. Click on the @ icon on the toolbar, or select Control > Start.

2. The “Save as” dialog box will appear. To save the run file, enter a name for the run file and click on the Save button. If the

run file has already been saved, click on the Cancel button to continue.

3. The pre-run “Checklist” dialog box will appear.
B Checldist ~loj x|

Please acknowledge the fallowing messagss and hit OK. ta continue.

Blue messages ais wainings and must be checked ta continue.
Fled messages are errars and prevent the run fram starting,

Messages

[m}Fi he tip d the tip ¢ pty

[ Please canfim that fps, tubes, plates and liquids have bezn setup cortecty as per the Pre-lun Repor,
O Tips. During this run, the rabot will mn out of 50 p tips.

Check all boses and hit OK. to continve.

K — | |
Flease make suie the tip discard chute is open and the tip disposal bos is empty. =1
Cancel Freiun Bieport oK

4. If the run has been set up correctly, the checklist will not list any warnings or errors other than those listed above. If errors

are listed, user intervention is required before the run can be started. Select the boxes next to the warnings to continue.
5. Click on the Pre-Run Report button to view the pre-run report. Check the worktable setup.
6. Click on the OK button to start the run.

7. The location of the pipetting head will be highlighted on the software worktable in real time, and a summary of the
progress of the run will be displayed in the righthand pane. See Section 5.3.4.

6.5  Pausing/aborting a run
A run can be paused and aborted at any time.

Pauses will be logged in the postrun report. If the run is aborted, the instrument will discard the tip and return to its resting

position.
To pause a run:

1. Click on the & icon in the toolbar, or select Pause/Abort from the File menu.

2. The instrument will complete the current operation and will then pause. The following dialog box will appear.

aracen |

\?/ Operation paused at 07,11,2005 13:52:59, Continue?

3. Click on the Continue Run button to continue the run, or click on the Abort Run button to abort the run.
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4. The instrument lid must be closed to abort the run.
Note: A run will also be paused when the instrument lid is opened.

Note: The instrument does not stop immediately when the lid is opened. Therefore, wait until the Y-arm has stopped moving

and the warning screen is displayed before continuing.

Note: An aborted run cannot be restarted from the point at which it was aborted.

6.6  Exception handling
If an exception (i.e., an error or warning) occurs during a run, an alarm will sound for 60 seconds, and then at 30 second
infervals. A dialog box which contains information about the error will appear. This box has 4 buttons — Abort run, Retry
operation, Ignore error, and Skip step. See Section 9.3 for more information about specific warnings and errors.

Abort run Click this button to abort the run.

Retry operation The instrument will discard the current tip. The Y-arm will move to its resting position. This provides

access to the worktable, allowing the error to be resolved. Click on the OK button to continue with

the run.
Ignore error The instrument will continue with the run as normal.
Skip step The instrument will skip the step and continue with the run.

Exhausting tip supply during a run

If the tip supply is exhausted during a run, the instrument will pause to allow the user to replenish the tips. The “Replace Tips”

dialog box will appear.

G E x|
i |
t 16:31:53 [04.11.2008] the machine has run out of 50 lips. Please ieplace the tips on one of - 4
the avalable tip locations for that type, then select the location from the diagram on the screen.
Make sure you use the right variety of lips! Cancel

[]500 I T=can tip, 56 well plate (vt
] 50l Tecan tip, 56 well plate [ver

To replace the tips:

1. Add the correct tips to one of the available tip locations on the worktable.
2. Select the Tip plate where the tips have been replaced by checking the box next to the correct plate.
3. Click on the OK button to continue the run.

Note: If the Cancel button is selected, the run will be aborted.
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6.7  Reports/log files
6.7.1 Pre-run report
The pre-run report is automatically generated before starting a run file. It contains the following information:
Run file
Software version

Instrument details

Run time (estimate)

Protocol information

" ou "nou

In addition, the pre-run report also contains detailed information about “Assay Setup”, “Robot table setup”, “Reaction steps/Task

list”, and “Program Seftings”.

The following options are available from the toolbar at the top of the pre-run report.

=y Prints the pre-run report.

Fririt

| Saves the pre-run report. Assign a file name, select a location, and then click on the Save button.

Save

-4 Opens a new e-mail message, which enables the pre-run report to be e-mailed.

E il

Saves the pre-run report as a Word document. Assign a file name, select a location, and then click on
MShiord the Save button.

Close Closes the pre-run report.

Generating the pre-run report
To generate a pre-run report:

1. Open the run file for which the pre-run report will be generated.
2. If necessary, adjust the run file according to your needs.

3. Select Wizards/Generate report. The pre-run report will be displayed.
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Alternatively, the pre-run report can be generated when starting a run. To do this:

1. Select the @ icon from the toolbar.
2. The “Save file” dialog box will open.

3. Select a location in which to save the run file, and then click on the Save button. Alternatively, if no changes have been

made, click on the Cancel button.

4. The pre-run “Checklist” dialog box will appear.
e

Plezse acknowledge the following messages and hit OK to continue.

Blue messages are warnings and must be checked to continue.
Fed messages are ernors and prevent the rn fiom staring

Messages

uids have been set the Pre-Run Repart
[ Tips. During this run, the robot willrun cut af 50l tips.
Check all bowes and hit OK ta continue.

| 0|
Flease make sure the tip discard chute is open and the tin disposal box it emply =]
Cancel Pre-Riun Beport o

5. Click on the Pre-Run Report button. The pre-run report will be displayed.

6.7.2  Postrun report

Upon completion of a run, a “Post-run” report will appear. This report contains the same information as the “Pre-run report”, but

also contains the following information:
Duration:
Date

Start time

Comepletion time

Run duration

Exceptions:

e Date and time of exception

® Instrument activity at time of exception
® Details of the exception

® User response

Note: Any exceptions are highlighted in the post-run report.
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Reaction plate details

Well number

Well location

Programmed final well contents
Actual final well contents

Volume pipetted (total to well)

Final concentration

Maximum working volume achieved
Status (OK or Error)

Options to Print, Save, E-mail, or Export the report into a Word document are available via the toolbar at the top of the Post-run

Report.

The “Postrun report” is automatically saved in a subdirectory called “Reports” in the current run file save directory. The default
directory is C:\Program Files\QIAgility\Data.

6.7.3 Log files and support packages
Log files

A new log file is generated when the software starts, when a run starts, or when a log file reaches 16 MB in size. The 8 most

recent logs are stored.
Log files are saved under “selected installation directory”/Data/Logs (e.g., C:\Program Files\QIAgility\Data\Logs).
To view a log file:

1. Select Help/Display log file or press F11.
2. The log file will be displayed.

3. ltems listed in red indicate an error. ltems listed in green indicate the start/shutdown of the software and the start/end of a

log file.

QlAgility Version 4.18 User Manual  06/2023 158



QIAGEN QlAgility Version 4.14.1 (Build 5) Log
0 1C

Hide Debug Messages || Hide Machine nstucions || Hide Serial Logging;

100138

10:40:35 | Lacale: Deutsch (Deutschiand) | DEU
10:40:38 | Username:

1020135 o045

10:40:38 | Robot Haroware Revision: 11

10:40:35 | QiAgiity Series Haroware Reviston 11 V2.x Firmware, v2:22 Conpled 10/08 Rabat can find dstanc to hame:

hccPort[32]: Rabatic Axis V2,4 AccPart ) hecPortod] W

104039 | Lamp status: Absents Ontoard HEPA iter status: Not avatabe

10:20:38 | 05t Windows X6 ver. 5.1(2600)

2 Processor Type 5 Tover o

09 | s s, 15 g 15 P S 1995

0403 | RaM: 40% used; Totel 20100 Avaiebl 1 153403 TotalVirtual 2 0460 Free Virtua 19070

10:40:35_| Drive C:\HOD, Tota Space: 930b, Free Spece: 120

10403 | SetAbort-False

10:40:38 | SetAbort=False

10039 | StartWermie: b cjestor s present, = o dspo o

10:40:39 | StartWarning: , Pease confirm that tos, asper

10:90:09 | LidOpen Startiob] checking..

10:40:39 | LdOpen Startiobl . ciosed

10405 0 take 377 secands, Estmated to inish at: 1911:2010 10:47:02

10:20:45 | Setabort=False

70740145 | LidOpen PauselLidopenl: checkine

10:20:45 | LigOpenPauselLigOpen: -cosed

10:40:45 | LidOpen pauselLidopen checkine

10:40:45_| LidOpen PouselLidOpen . .cosed

Reaction List

1:Kip wells n 96 wel lte (horizontal) @ C2. (1 wels)
1

96 el i verticallabels) @82

10190145 | 3. Pipette 10l of Control + Final Master M ta 96 well piate (ortzontal) © C2. (2
4 Ppetts 10l of ik (0-1) « Final Master i to 96 wel plate (horizontal) @ C2. Norm. t0 0,1 (8 wells)
5:Pette s sster i to © vels)
Run Action Lt
1 Inserting 15 i Final aster Hix
2:Skipping 1 vells
LR | S 1.0ition (1-20) toconco,1
4 Preserve wels, nserting 10 il Control
©1) ) toconc0,1

10:40:45 | Homing all axes
10:20:46_| Homedis 2
10046 | Wavex: Low

Support packages

On completion of a run, a support package (zip file) is constructed and saved. This support package contains the log file for the

run. The system saves the 50 most recent support packages.

Note: On completion of each run, the software automatically saves a support package. However, for problems that occur outside
the context of a run it is important to manually create the support package immediately affer a suspected error has occurred.

Support packages are important when reporting a problem to QIAGEN Technical Services.
To create a support package:

1. Select Help > Save support package.
2. The “Browse for Folder” dialog box will open.
3. Select a location in which to save the support package.

4. Click on the OK button.
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To select the correct support package:

1. Select Help > Choose support package.

2. The “Support Package Chooser” dialog box will appear.

B support Package Choaser =lolx|

“You can use this famm to browse the available support packages, and save them to another location if necessary. You can view the avaiable support packages by date

o by conelaled exception(s)

Choose by Date | Chaose by Exception |

The table below shows all exceptions generated for the current robet, and the support packages determined to match the runs in which these exceptions occurred

The available data can also be fitered to a specific exception type by selecting an item fiom

the b ko the right,

Onlp show:  [All Exceptions v

Exception

S upport Package

Choose by Date
Choose by Exception
All Exceptions

User paused job
User aborted job

3. The support packages can be sorted by selecting Choose by Date and Choose by Exception tab. In addition, support

packages can be viewed based on the type of exception. To do this, select All Exceptions, User paused job, or User

Save oK

Sorts listed support packages by date.

Sorts listed support packages by exception.

Displays all support packages which contain an exception.
Displays all support packages in which the user paused the run file.

Displays all support packages in which the user aborted the run file.

aborted job from the drop-down menu.

6.8  Importing and exporting reaction/sample data

Sample and reaction data can be imported and exported. See Section 5.9.7. Extraction data from earlier purifications can be

imported and used as sample data. In addition, data can be exported for use in downstream applications, for example with the

Rotor-Gene Q.
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6.9  Shutting down the software and the instrument

1. Click Xl in the top right corner of the screen, or select File > Exit, to shut down the software.

2. If a run is still active, the software will display a warning message.
OIAGEN

A run is currently ackive, Are you sure you want o cancel the run and shutdown
the software?

Shutdown

3. Select Return to Run if you want to cancel the shutdown process and finish the run.
4. Select Shutdown if you really want to stop the run immediately and proceed with the shutdown process.

5. If the current run file has already been saved, proceed to Step 8. If the current run file has not been saved, the following
message will appear.

acen .

P | Doyouwant ta save the changes wou made ko CiPragram
\'/ FilesiQlagiity GProtocolsiHokSkarTagl _signeds, Qas?

Yes Mo | Cancel |

6. Select the Yes or No button.
7. If Yes is selected, the “Save File” dialog box will appear. Select a file location and then click on the Save button.

8. If the current run file has already been saved, the following message will appear.
oaGen |

? ) Doyouwish to quit QlAgiity?
Ho

9. Click on the Yes button.

10. The following dialog box will appear.

(Quitting QIAgility...

Move to 5 afety Position [recammended) Stop Immediately

11. Select Move to Safety Position (recommended) or Stop Immediately. See below for details about these options.

12. If Stop Immediately was selected, the software will shut down without discarding the tip. If Move to Safety Position
(recommended) was selected, the robot will discard the tip, and the pipetting head will now move to a safe location. The
following message will appear.

\v The robot can now be safely turned of f,

13. Click on the OK button.
14. Set the power switch of the QIAgility to the off position.
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Moving to a safety position

This is the recommended method of shutting down the instrument. The instrument will discard the tip, complete its homing routine,
and then the pipetting head will be lowered to a known safe location. The user is prompted when it is safe to switch the instrument
off. All the instrument axes are disengaged and can be moved freely. As the instrument is switched off a small click is heard as

the pipetting head drops 1-2 mm further.
Shutting down immediately
This is a faster way of shutting down. The instrument axes remain engaged and the pipetting head remains in an upward position.

If the head holds a tip it will not be discarded. As the instrument is switched off, the pipetting head will drop approximately

70 mm. This will not damage the instrument but may result in a pipet tip being picked up.
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7 Instrument Setup and Calibration

Before starting any runs, the QlAgility must be calibrated. This section outlines the calibrations that must be performed.

If the QIAgility is moved, we recommend recalibrating the plate positions. Unless the pipetting mechanism has been serviced, or

pipetted volumes are found to be inaccurate, there is no need to recalibrate the volume.

Note: If pipetted volumes are found to be inaccurate, please contact QIAGEN Technical Services.
7.1.1  Setup tip ejector

Before starting, ensure that the worktable is clear, except for the tip ejector.

Procedure

1. Select Options > Robot setup > Set up tip ejector. Alternatively, if tip ejector calibration is being performed for the first time,

click on the OK button in the following dialog box.
oacen . |

\ 1 You'll need ko configure the bip sjector location before continuing, Hik CK ko
start: the procedure.

2. Review the following message.

The Incation of the tip sjector must be calbrated ko ensure proper operation of the instrument.
T\ This misck b done carefully ko aveid damags to the instrument,

Wiarning: the process for calibrating the location of the tip ejector tempararily disables the instrument lid interlock.
This allows the robat arm and pipsttor ko move when the lid is open.
Exercise caution to ensure your personal safety and avaid injury.

Are you sure you want ko continue?

3. Click on the Yes button to continue with tip ejector calibration.

4. The “Tip Ejector Calibration” dialog box will appear.

Tip Ejector Calibration

~Automated Tip Ejector Calibration

This function automatically determines the tip ejector location,
During the process, the body of the: pipeting head is touched
apainst the tip ejector. Pleass clear the pipsttor hub, remave al
items from the worktabie, and ensre the tp ejector is seoued.
Keep the lid open. Warning: beware personal safety.

Locats Ejector -aris Pasiton |7° El
X-ais Postion |°
Tip Ejector Height |/ °* E

Cancel Locating Test Frished
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5. Click on the Locate Ejector button.
I ]

9 wW/arning: To avoid causing damage ta the instrument, please:
. )
1. Ensure that al plates, tubes, accessories, adaptors and tip racks have been remaved from the robot workeable,
2, Ensure that the pipettor hub is not holding any Hp,
3. Ensure that the tip ejector is securely mounted to the workkable,
4, Ensure that the lid is open For the duration of the calibration pracedure, Beware personal safety,

Continue?

6. Open the instrument lid and ensure that the worktable has been cleared.
7. Click on the Yes button. The automated calibration procedure will start.

8. Once the X- and Y-axis positions have been located, the following message will appear.
oracen x]

\ ? ) Is the pipettor hub above the slot of the ejectar?
|

9. Check the pipetting hub position. If it is located correctly, click on the Yes button to continue. The Z-axis position will now

be located. The “Tip Ejector Calibration” dialog box will reappear. Proceed to step 14.

Tip Ejector Calibration

[~ Autamated Tip Ejector Calibration

This function automaticaly detemines the lip siecter lacation
During the: pracess, the bady of the pipetting head is touched
against the tip ejector. Please clear the pipettor hub, remave &l
itenns from the worktable, and ensure the tip ejiectar is secured,
Reep the lid open. Wamning: beware personal safety.

Locate Ejector vausPostion |2 ]
-axis Position |1 m
Tip Ejector Height | 134 El

Locating'Y asis - found, ¥ as =53
Locating % asis - found, ¥ as = 11
Locating 2 avis - found, Z ards =134
Tip sjectar location calbration complete. -

Cancel Cancel Lacating Test

10. If the pipetting hub is not correctly located, click on the No button. The following dialog box will appear.

Tip Ejector Calibration

- Auternated Tip Ejectar Callbratian

This function automatically determines the tip sjector location.
During the process, the body of the pipelling head is touched
against the lip ejector. Please clear the pipettor hub. remave 3l
items from the worktable, and ensure the fio ejector is secured.
Keep the lid open. Warning: beware peisansl saely

Locatz Ejstor -asis Position |3 El
Reanis Position |11 [D
Tip Ejectar Height |* B

Tip eifzctor location calibralion incomplete.

Carefully adjust the .Y position of the pipettor manuallyto a
Iacalion abave the slot, then Lacate Z Asis' or adjust the
height mandaly)

Cancel Cancel Locating Test Finished

11. Manually adjust the X- and Y-axis positions, using the arrows, and then click on the Locate Z Axis button.

12. The following message box will appear.

]

mo |
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13. Click on the Yes button. The instrument will now locate the Z-axis position.

14. Click on the Test button. The following message box will appear.

QIAGEN x|

[} Are you ready to kest the bip sjection?
The arm will move bo the right, walt For confirmation, then move inko the ejector,

-
15. Click on the OK button.

Ix

\ ? J Please manually place a tip on the head of the robat and hit OK ta continue.

Ok l Cancel I

16. Place a tip onto the pipetting head, and then click on the OK button to continue.
17. The instrument will now locate the tip ejector and will eject the tip.
18. Click on the Finished button.

19. The following message box will appear.

racen
A ? ) Save the tip ejector location?
| coes |

20. Click on the OK button to save the tip ejector calibration.

7.1.2  Calibrate plate positions

Before using a plate on the worktable, a position calibration must be performed. Plate position calibrations can be saved and

reused.
Important: Tip Rack Holder calibrations must be performed before any other plate type can be calibrated.

Caution: The Y-arm will move during position calibration when the lid is raised. Do not click on any software buttons while parts

of your body are within the instrument worktable.
Before starting the procedure:
e Open the instrument lid.

o Place plates to be calibrated onto the worktable.

® Ensure that 200 pl tips are available in at least one Tip Rack Holder.

QlAgility Version 4.18 User Manual  06/2023 165



1. Select Options > Robot Setup > Calibrate plate positions.
2. The “Set Alignment” dialog box will appear.

x|
Ciose
96 el tical] @ Al (no brated
56 el plate [vericall © A2 [nol calbrated) At T Conductive fip, BIAGEN
96 el plate [verical] @ BT [not caibrated) e S e [
sg wellplate [vettica] @ B2 [not calbrated) B
96 well plate (vertical] @ C1 [not calbrated) - 00000000000 =
95 el plate [verics] @ C2 [not cabrated) coocooco0co0c000
M pla (5 fube pasdions] @ M1 [not calbrated) © 000000000000
Reagent block [standard 200 flat tapered) @ A1 [not calibrated) & C 00O 06000000
® 000000000000
¢t 060000000000
° 000000000000
L 0000000006000
i Tip Cor Home Z Avis
i i LN |
o
= 2l B e | Getblen To |
Save Bevert to saved ]El E EiectTio I

Plate Selection

X-position

Y-position

Save

Revert to saved
Raise tip
Lower tip
Home Z Axis
Check Pos.

Get New Tip
Eject Tip

Lists the plates that are located on the instrument worktable.

Indicates the position of the pipetting head on the X-axis. During calibration, the objective is to

set this to match the center position of the calibration well.

Indicates the position of the pipetting head on the Y-axis. During calibration, the objective is to

set this to match the center position of the calibration well.

Saves the current X- and Y-positions as the calibration location for the plate.
Restores the X- and Y-positions from the most recently saved values.
Raises the tip.

Lowers the tip.

Raises the pipetting head to the top (home) position.

Moves the pipetting head to the defined X- and Y-position to enable the user to visually inspect

whether this corresponds to the center of the calibration well.
Collects a new (200 pl) tip.

Discards the tip that is currently on the pipetting head.

3. Select a plate from the “Plate Selection” list.

Note: Tip Rack Holders are listed as 96-well plates.

. A schematic diagram of the selected plate is displayed on the right. Position calibration is performed using a calibration

well. This well is highlighted red.

. Use the Lower Tip and “Raise Tip” buttons in the “Tip Control” panel to move the pipetting head so that it is just above the

plate surface. Ensure that the tip is not in contact with the plate.

Note: If there is no tip attached, the pipetting head can only move to a limited Z-height (680). To obtain lower Z-height

positions the instrument must pick up a tip. To do this, click on the Get New Tip button.

. Adjust the “X-position” and “Y-position” in the “Plate Origin” panel so that the pipetting head is directly above the center of

the calibration well. View the pipetting head from the front and from the side to ensure correct alignment.

. Click on the Save button. The current position is now saved as the calibrated value. If desired, click on the Check Pos button

to confirm that the correct position has been saved.

8. To perform position calibrations on other plates, repeat steps 3-7.

QlAgility Version 4.18 User Manual

. When position calibrations are complete, click on the Close button.
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7.1.3  Calibrate plate heights

Plate height calibration should be performed after plate position calibration. It can be performed automatically or manually.

Automatic plate height calibration

Before starting the procedure:

® Ensure that 50 pl tips are available, that the Tip Rack Holder is calibrated, and that the correct tips are set as available.

® Ensure that empty tubes are placed in the first 4 wells of each plate.

1. Select Options > Robot Setup > Calibrate plate height.

2. The “Configure Plate Heights” dialog box will appear.

H tul
Mix plate: [5 tube positions) b Oml IAGEN Qldgiity lapered ube @ M1

Mix plate [3 tube positions] 1.5ml tapered screw cap tube @ M1

Reagent block [standard 200 flat tapered) 200p1 PCR tube @ R1

Fieagent block [standard 200 flat tapered) 2.0l self standing screw cap tube @ R1
Fieagent block [standard 200 flat tapered) 1.5ml tapered hinged tube @& A1

Select Al Ceatl |

[~ Setftings
W Require confimation from user?

Take average of how many wells? 4 El

r~ Control

Autodetect [checked items) | Cancel | Manual Setup [highlighted item)

Aulodstect applies to plates with licked checkboses. Manual setup spplies ta the currently
highlighted plate

Plates to Calibrate
Select All
Clear All

Require confirmation

from user?

Take average of how

many wells2
Autodetect (checked
items)

Abort

Manual Setup
(highlighted items)

QlAgility Version 4.18 User Manual

Lists the plates that are currently located on the worktable.
Selects all of the plates in the “Plates to Calibrate” list.
Deselects all of the plates in the “Plates to Calibrate” list.

Instructs the software to present a message to the user after automatic plate height
calibration is performed. This enables the user to confirm the value to be recorded as the

auto-detected height.

Defines the number of wells from which to take an average.

Initiates the automatic plate height calibration operation. Automatic plate height calibration

is performed only for the selected plates.
Aborts the current calibration activity.

Initiates the manual plate height calibration operation. Manual plate height calibration is

performed only for the selected plate.
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. Check the boxes next to the plates to be calibrated in the “Plates to Calibrate” list. Alternatively, click on the “Select All”

button to select all of the plates.

Note: Plates which have multiple segments (e.g., Reagent Blocks) are listed more than once, but with different tube types.

. Define the number of wells from which to take an average. It is recommended that 4 wells are used to calculate the

average.

. Click on the Autodetect (checked items) button to initiate calibration.

ocer

<@ Ready to auto-detect wel heights? Please ensure plate position are Fully
2 calibrated and empty tubes placed in the first 4 wells for each plate,

.

. Review the message and click on the Yes button to continue.

O

1 2 Aukocalibrating heights Fior 96 well plate (vertical) @ C1, tube type 2000 PCR.
‘-qf tube

:

. Click on the OK button to continue.

8. If Require confirmation from user? was selected, the following message will appear.

10.

11.

oacen .
9P Battom of well detected at 648, based off the average of 4 samples. Values
\g, )

read: 648 648 645 648, After compensation For this plate bype, the height wil
be set to 628, Save these settings?

o

. Click on the Yes button to accept the calibration if the averages for a plate are within 10 units of each other. If the

averages are not within 10 units of each other, click on the No button to reject the current calibration and then repeat steps
5-8.

Note: Before repeating the calibration, ensure that all tubes are sitting correctly and that the tips are not bent.

Note: If there is significant variation across the 4 samples, the following message box will appear. Click on the OK or the

Cancel button.
5

tolerance of 15 {1,5mm). Tt is possible that not o tubes are seated property on the plate

9 iation in height of 52 (3, 2mm) i
\') ar a bip missad going into & tube properly.
< or i & 00Ul PCR tube on plate Reagent block (standard 200,flat,tapered) @ R17

o ] cow |

If more than one plate was selected in the “Plates to Calibrate” list, the instrument will calibrate each plate in turn. Repeat

steps 6-9 for each plate.

When all calibrations are complete, click on the Close button.
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Manual plate height calibration

1. Complete steps 1-4 of “Automatic plate height calibration”.
. Click on the Manual Setup (highlighted item) button.

. A dialog box will appear, click on the Yes button to continue.

AN W N

. If the plate had a previous calibration, a dialog box will appear, asking whether to reset the Z-axis height. Click on the Yes

button to reset the height, or click on the No button to retain the current setting. The “Adjust Height” dialog box will appear.

Caution: If the current setting is retained and the plate position is too high, the tip may jam into the plate and bend the tip.

B adjust Height x|

~ Tip Cantral — Tip Location oK. |

Lancel |
Lower tip ta current setpaint |
Home Z-axis |

—Adjust Height

Level at bottorn |51 il El
of well:

Do not send lip to exact bottam of well - if the tip iz touching the exact
bottam of the well during ejection, this may cause blockages in the tip.

Raise tip to Lifts the pipetting head to the current “0” position.

IIOII

Lower tip fo Places the pipetting head at the height that corresponds to the displayed “Level at bottom of well”.
current

setpoint

Home Z-axis Lifts the pipetting head to the top (home) position and resets the “0" position.

Level at Indicates the proposed manual plate height calibration value — a Z distance measured from the
bottom of well “0" or home position. The goal of manual plate height calibration is to set this so that the tip is just

above the base of the tube/well.
5. Adjust the height of the tip in the “Adjust Height” panel.
6. Use the up/down arrow buttons in the manual height calibration window to raise and lower the pipetting head.

7. To adjust the height correctly, the distance between the tip and the tube base must be adjusted as described above. In most
cases it is not possible to see the distance between the tip and the base, the distance must be ‘felt’ by manually lifting the

tube from its support plate.

8. If the tip makes forceful contact with the base of the tube/well, the “Level at bottom of well” does not reflect the true
distance of the base of the tip from the home position. Use the Home Z-axis” button to reset the “0” position and repeat

steps 5-7, starting with a lower “Level at bottom of well” value to avoid driving the tip forcefully into the base of the well.
9. Click on the OK button when the correct height calibration has been set.

10. Click on the Cancel button when all calibrations are complete.
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7.1.4 Optimal height calibration

For optimal height calibration, please refer to “Optimal plate height calibration” in Appendix A — Advanced settings.

7.1.5 Calibrate tip offsets

It is recommended that this calibration is performed upon initial installation and when the user starts a new lot number of tips.

The collar size of 50 plL and 200 pl tips should be equal, but small variations sometimes exist.

Although both
tips are the
same length, a
slight
enlargernent in
collar size
makes the
200ul tip sit
higher. This
makes the
2000l tip
appear shorter
on the robot

The length
offget accounts
ot this.

Length offset

The tip offset calibration enables the software to automatically determine the correct height calibration for the 200 pl tips, based

on the height calibration that was performed with 50 pL tips.

Before starting the procedure:

® Ensure that a plate with Reaction or Mix function, with well sizes large enough to accommodate 50 pL and 200 pl tips, is
available — this plate must be position and height calibrated.

e Place a tube in the first well of the reaction plate.

® Ensure that 50 pl and 200 pl tips are available, that Tip Rack Holders are calibrated and that correct tips are set as

available.
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1. Select Options > Robot setup > Calibrate tip offsets.
2. The “Configure tip offsets” dialog box will appear.

B Configure tip offsets x|

 Tip Offzet Close
Tip offset calibration measures the apparent lengths of the

selected tip types sa that variations can be accommodated
when pipetting.

Plate height calibrations are twpically carmied out with 50
tips. “When pipetting wsing other bip types, such as 200 pl tips,
poor performance may occur due to differences in the
‘on-robot’ lengths of these tips relative ta those used during
height calibration.

—Select plate to test in
Plate: function Mix -

IMix plate (5 tube positions) @t 1 I

~ Select tip types to profile

e —
st | Coed | Resatan |
Plate function Defines the function of the plate in which tip offset calibration will be performed.
Opens the “Plate/well Selector” screen, which enables selection of the location of the plate in which tip
offset calibration will be performed.
Select tip types Lists the tip types to be calibrated — 200 pl conductive tips are selected by default.
to profile
Test how many Defines the number of replicates that will be performed for the calibration of the selected tip type.
tips per tiptype
Start Starts the tip offset calibration.
Abort Aborts the current tip offset calibration.
Reset All Resets the tip offset calibration settings to the factory default values.

3. Select the correct plate function, from the drop-down menu, of the plate in which tip offset calibration will be performed.

4. Click on the "% button. The “Plate/well Selector” screen will open. Leftclick on a plate to select the location of the plate in

which tip offset calibration will be performed.
5. Ensure that the correct tip type is selected in the “Select tip types to profile” panel.
6. Define the number of tips to be used to calculate the average offset.

7. Click on the Start button to start tip offset calibration.
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7.1.6 Cadlibrate volumes

There is a direct relationship between the rotation of the motor shaft and the vertical movement of the pipet piston. Volume

calibration defines the number of units that the P-axis motor must move to accurately deliver a given volume of liquid.

Volume calibration is performed using the “Volume Calibration Wizard”. During installation of the QlAgility, the user should

perform “Option 1" from the “Volume Calibration Wizard”.

Note: Volume calibration must be done before the start of the first run on a newly installed QlAgility. An error is shown at the

start of the run if no volume calibration has been done.

=1ol x|

Flease acknowledge the following messages and hit O, to continue.

Blue messages are warnings and must be checked ta continue.
Red meszages are ermors and prevent the run from starting.

Messages I
W Volume colibration must be done beforerun, |
[ Please make sure the tip ejsctor iz pressnt, the tip discard chute is clear and open and the tip dispozal bow is empty
[ Please corfim that tips, tubes, plates and liquids have been setup comectly 33 per the Pre-Fun Report.
O izannot start run)

CRITICAL =

Volume calibration must be done before run.

LCancel [~ Check Al Pre-Run Beport K |

Opening the “Volume Calibration Wizard”

1. Open an “Empty Project (last used layout)” or “Empty Project (default layout)”, as outlined in steps 1-2 of Section 5.10.3.
2. Select Options > Robot Setup > Calibrate Volumes.

3. The “Volume Calibration Wizard” dialog box will appear. Options 1-3 will be displayed.

P volume Calibration Wizard X

 Intraduction

Wolume calibration sstablishes the accuracy of the robet pipetting mechanism Speciisall, |t defines the number of
urits the P-asis motor must move to sccuratel deliver s given volume of lquid

Please choose one of the following aptions.

(- Dptiors

Calibrate manualy. Robot perfoims no pipetting, User enters P axis units directly far
each calibration valume,

2 Wiew cument calibration settings and revisw calibration history

= Reset to default calibration settings.

Cancel

4. See the following sections for detailed information about Options 1-3.
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Option 1

Use Option 1 to manually adjust the P-axis unit value for specific volumes. This method is used to enter the values supplied on
the factory volume calibration report. Increasing the P-axis value increases the volume aspirated or dispensed. Conversely,

decreasing the P-axis value decreases the volume aspirated or dispensed.

1. Select Option 1 from the “Volume Calibration Wizard” dialog box.

2. The “Volume Calibration Wizard — Manual Calibration” dialog box will appear.

B volume Calibration Wizard - Manual Calibration - x|
- Enter calibration values manuall
MNaminal Yolume [pl] |Value [P axis unit] [hominally 26/ .
I [e385 B ok
2yl 7452
Gyl 162,38
10 2845
20 552 53
50 136319
100 2687.75
150 401953
200 53227

Save | Back | MNext |

3. Click in the appropriate cell in the “Value (P axis units)” column to manually change the P-axis units.

4. Click on the Next button.
aracen |
\?) Settings changed - save?
v

5. Click on the Yes button to continue.

aincen T

-
1 ) Settings Saved

6. Click on the OK button.
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7. The “Volume Calibration Wizard — History of Calibration Data” dialog box will appear.

gvnlume Calibration Wizard - History of Calibration Data _5 x|

r— History of calibration data
ICurrsﬂl Settings j
Mominal Yolume [pl) Measured Volume () Walue [P axis units]
1 1 43,85
2 2 7452
5 5 162,38
10 10 2845
20 20 55253
50 50 1363,19
100 100 2B87.75
150 150 401953
200 200 53227

Uze displayed settings as new calibration | Back | FEinish |
Generate Report Opens a report which summarizes the displayed calibration settings.
Use displayed Updates the default volume calibration with the displayed calibration settings.

settings as new

calibration

8. “Current Settings” are displayed by default. Saved calibration settings (up to 9) can be accessed via the drop-down menu.

Select one of these calibrations to display the associated calibration data in the table.

9. To update the default volume calibration with the displayed calibration settings, click on the Use displayed settings as new

calibration button.

10. If desired, click on the Generate Report button to open a window that displays the current calibration seftings in a table

format.

B Preview E =] ]
= 5| £
Frint Save Email MSwWard

n Data - QlAgility Series

Calibration Settings: Current settings

Target Vol (ul) Calibration Value

1l 1385

24 7452

sl 152,38

10 2BLE

204l 55253

04l 136313
100 2667 75

=l

11. Click on the Close button to return to the “Volume Calibration Wizard — History of Calibration Data” dialog box.

12. Click on the Finish button to return to the main software window.
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Option 2

Use Option 2 to view current calibration settings and to replace the current default calibration settings with previously saved

calibration seftings.

1. Select Option 2 from the “Volume Calibration” dialog box.
2. The “Volume Calibration Wizard — History of Calibration Data” dialog box will open.
3. Proceed as for steps 8-12 of “0.

Option 3

Use Option 3 to reset the volume calibration to the factory default calibration settings. Current calibrations are automatically

saved in the volume calibration history.

1. Select Option 3 from the “Volume Calibration” dialog box.

2. The following message will appear.

\‘.\‘:) Reset volume calibration to Factory defaults?

fes Mo |

3. Click on the Yes button.

4. Click on the Cancel button in the “Volume Calibration” dialog box. The volume calibrations will now be updated with the

factory default calibration settings.
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8  Maintenance Procedures

The following procedures must be carried out to ensure reliable operation of the QlAgility:

e Cleaning the QlAgility

® Minor corrective maintenance

Following these procedures ensures that the QlAgility is free of dust and liquid spills.

Important: Switch the instrument off and disconnect the line power cord from the power outlet before servicing.

WARNING/ Risk of electric shock
CAUTION Do not open any panels on the QlAgility.
A Risk of personal injury and material damage
Only perform maintenance that is specifically described in this user manual.
Servicing

The QlAgility is supplied with a warranty that lasts for 1 year, beginning on the date of shipment. The warranty includes all

repairs due to mechanical breakdown. Application development, software upgrades, accessories, and disposable items are not

included in the warranty.

QIAGEN offers comprehensive Service Support Agreements, including Warranty Extensions, Full Cover Support Agreements,
and instrument/application training, including on-site installation. Service Support Agreements maximize productivity and ensure

high performance from your instrument. In addition, service histories are fully documented and all parts are certified and

guaranteed.

Contact your local QIAGEN Field Service Specialist or your local distributor for more information about flexible Service Support

Agreements from QIAGEN.
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8.1  Regular maintenance procedures

8.1.1 Cleaning the QlAgility

A\

CAUTION Damage to the instrument
2 Do not use solvents, or reagents containing acids, alkalis, or abrasives to clean the QlAgility.
WARNING Risk of electric shock

Do not open any panels on the QlAgility.

Risk of personal injury and material damage
Only perform maintenance that is specifically described in this user manual.

A\

CAUTION Damage to the QlAgility lid
Do not use alcohol, solvents, reagents containing acids, alkalis, or abrasives to clean the instrument lid.
A Alcohol will damage the lid. To clean the lid, use distilled water only.
CAUTION Damage to the QlAgility side panels

Never clean the instrument side panels with alcohol or alcohol-based solutions.

Important: We recommend wiping the QlAgility with a damp cloth only.

The following cleaning agents have been tested successfully:

o Mikrozid® Liquid (Schilke & Mayr GmbH)
® Mikrozid Wipes (Schilke & Mayr GmbH)
e DECON-QUAT® 100 (Veltek Associates, Inc.) (identical to Microcide SQ™; Global Biotechnologies, Inc.)

Important: The worktable inside the instrument should be cleaned using a moist, soft cloth.

The following cleaning agents have been tested successfully:

® Lysetol® AF (Schilke & Mayr GmbH)
e Gigasept® Instru AF (Schilke & Mayr GmbH)
e DECON-QUAT 100 (Veltek Associates, Inc.) (identical to Microcide SQ; Global Biotechnologies, Inc.).

Note: Do not wipe the rails. These rails support the pipetting head and allow it to slide backwards and forwards easily. Wiping

the rails will remove the grease and make them more susceptible to rust.
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8.2  Periodic maintenance
8.2.1 Decontaminating the QlAgility

To remove DNA/RNA from the worktable and to eliminate cross-contamination, the QIAgility must be routinely decontaminated.

Proceed as follows:

1. Remove all loading blocks and the tip ejector chute from the worktable. Wash these in detergent and rinse with clean

water.

2. Soak these components in TriGene (Medichem International; for more information, see www.medi-mark.co.uk), or one of

the tested cleaning agents listed in Section 8.1.1 above, for 15-30 min.
3. Thoroughly rinse the components in nucleic acid-free water.

4. Briefly rinse with absolute ethanol and dry with a soft paper towel.

(6]

. Spray the instrument worktable with TriGene, or one of the tested worktable cleaning agents listed above, and allow to

stand for 15-30 min. Wipe away with clean paper towels.
. Spray the worktable the nucleic acid-free water and dry with clean paper towels. Repeat this 3 times.
. Spray the worktable with TriGene, or one of the tested worktable cleaning agents listed above, and allow to air dry.

. Return all components to the worktable and close the hood.

O © N O

. If fitted, switch on the optional UV lamp for 15 min.
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8.2.2 Removing and replacing the tip ejector chute
Removing the tip ejector chute

1. Open the lid.

2. Grasp the chain connected to the tip ejector chute.

3. Using the chain, pull out the sliding security bolt.

/

A

4. Remove the tip ejector/tip ejector chute.
Replacing the tip ejector chute

1. Open the lid.

2. Replace the tip ejector chute.

3. Press the sliding security bolt into the side slot opening.
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8.2.3 Replacing the HEPA filter

1. Lift the HEPA filter lid section.

’{ = i

. Remove the lid.
. Unscrew the 4 thumb screws.
. Remove the “"H” Frame.

. Remove the HEPA filters.

[ N, T NGO A ]

. Replace the HEPA filters and reassemble.
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9  Troubleshooting Guide
9.1 System setup

Comments and suggestions

Instrument does not turn on
a) Power cord not connected Check the power connection.

b) Fuse blown Replace the fuse.

Computer software cannot communicate with system
a) System is connect via RS-232 Under Windows 10 the RS232 port is not working

b) Incorrect COM port settings Check the COM port setting. If the instrument is connected to the
incorrect COM port the software will start in “Virtual Mode”. See
Sections 4.5 and 5.11.

QlAgility Software does not launch
a) QlAgility Software not installed Install the QlAgility Software. See Section 4.6.

b) Old version of Microsoft Windows The QlAgility Software operates with Windows XP Professional or
Windows 7. See Section 3.4.

9.2 Operation

Comments and suggestions

Running out of master mix

a) Master mix remains in the tube after Ensure that the height calibration of the master mix tube is set correctly.
completion of the run, but insufficient Use manual height calibration to get a setting closer to the tube base
volume of master mix was delivered to without touching.

the last reactions aliquoted

b) Correct initial volume was supplied or The pipettor may be aspirating larger volumes than expected. Ensure
made but all master mix is consumed that the volume calibration data are correct and have been configured
before all reactions are made properly.

Tip reuse causes greater liquid losses on the insides of tips due to
capillary and surface tension effects. Disable tip reuse.

Master mix may be viscous and build up on the outside of tips, causing
larger losses. Increase the master mix extra volume configuration. See

Section 5.6.3.

c) Source reagent remains in the tube affer ~ Ensure that the height calibration of all reagent wells used for
completion of the run, but the master mix  construction of the master mix is set correctly. Use manual height
has run out before all reactions aliquoted  calibration to get a setting closer to the tube base without touching.
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Comments and suggestions

QlAgility Version 4.18 User Manual

Uneven levels in reaction tubes

a) Air bubbles trapped in sample tubes or
master mix tubes

b) Air bubbles appear in reaction tubes

c) Liquid droplets appear on reaction tubes
above the liquid surface

d) None of the above

Software locks or crashes

Screen savers and power save modes not
disabled on the computer

The liquid-level sensor functions equally well on air bubbles or the liquid
surface. Centrifuge the sample plate to remove air bubbles.

Air volumes for dispense are too high. Reduce tip air intake volumes.

The tip is colliding with the base of the tube causing liquid ejected under
pressure to spray when the tip is retracted. Height calibration needs to
be raised to prevent tip contact with the tube base during dispense.

Pipettor is operating erratically and may be clogged. Organize a service
for the pipettor.

Disable screen savers and power save modes on the computer.

Z-axis not rising after power has been switched on

a) Power cords not securely plugged in

b) An internal fault on the instrument has
occurred

Replicates do not provide high reproducibility

a) Incorrect volumes entered for each
reagent

b) Master mix insufficiently mixed

c) Llessthan 5 pL DNA template used in
reactions

d) Air bubbles trapped in sample tubes
Software is very slow

a) Virus scanners running on the computer
b) Long reaction list

Instrument pipets in mid-air or pipets no liquid

Level sensor malfunction

06/2023

Ensure that all power cords are securely plugged in, then try switching
the instrument on again.

Contact QIAGEN Technical Services.

Insert the correct volumes for each reagent.

Increase the number of mixes or use the “Wait for confirmation after
creating mix” option and manually mix the master mix.

It is recommended to use at least 5 pL DNA template is used in
reactions.

Centrifuge the sample plate to remove air bubbles.

Disable virus scanners on the computer.

A long reaction list will cause the software to significantly slow down.

Static electricity on the plasticware may be interfering with operation of
the liquid-level sensor. Generate a support package and contact
QIAGEN Technical Services.
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Comments and suggestions

Liquid in source well, but received “Insufficient Liquid” error message

a) Incorrect tip configuration The instrument may have been configured to pick up tips that were not
present in the Tip Rack Holder. Ensure that tip configuration is correct.

b) Incorrect plate height calibration If the plate height calibration is too high, the tip cannot reach low
enough info the tube to aspirate all the fluid. Ensure that plate height
calibration is correct.

c) Physical plate does not match model Software uses models of tubes and wells to translate the detected liquid
selected in software surface height into a volume. When the wells or tubes are physically
different than the model chosen, the volume calculated may be much
lower than the actual volume present, causing aspiration steps to fail.
Ensure the plate chosen in the software matches the physical plate.
Consider disabling the “Detect insufficient volume on aspirate”
advanced setting (see Section 10).

Error messages recorded in post-run report, but the run was completed

Volumes of reagents or samples below the If liquid was not detected, an error is recorded in the postrun report.
minimum volume which is required for liquid-  Add an extra 20 pl volume as required. Alternatively, dilute samples
level sensing function. and reagents and pipet larger volumes rather than pipetting smaill

volumes of concentrated solutions.
A non-readable error message is received when the software is started
Correct plate definitions not installed Uninstall and then reinstall the software. See Section 4.6.
Software does not start and the “A required library file is not correctly installed or registered” error message is displayed

Present version of the software conflicts with Reinstall the most recent version of the QlAgility software.
an older version of the software

Software running incorrectly with a “Software error: aborting” error message

Communications channel to the instrument Ensure that no other devices (e.g., modems) are attempting fo use the
being interrupted same serial port as the instrument.

Alternatively, configure the instrument to use to a different serial port.
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9.3 Warnings and errors
This section describes software and instrument errors.
9.3.1  Warning and error messages

Warnings and errors are indicated by the & symbol in the toolbar. In addition, warning (blue) or error (red) messages are listed

in the pre-start checklist.

Click on the @ icon to view a message describing the error or warning.

BT B _|of x|

Blue messages are wamnings.
Fed messages are enors and will prevent the run friom starting,

Mesages
Prablem detected at plate: 96 well plate (horizontal) @ C2, 388 wells required with only 96 available in <

| |

[CRITICAL =

Problem detected at plate: 96 well plate (horizontal) @ C2. 388 wells required with only 96 available
in segment starting from well A1. There are not enough wells in the output plate to proceed. Reduce
the number of samples o reconfigure the reaction list to reduce the number of required output plates
lor wells. =l

Lancel Pre-Run Bepart O

The run can commence with active warning messages, but this may lead to erroneous results.

Note: Warnings and errors are logged in the post-run report and in any support packages.
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Warnings

Warning

Description

Not enough small tips
Not enough large tips
Well too full

Well too small

Eject volume too low
Will contaminate
Volume too small
Multi eject

Master mix extra volume too small

Standards volume too high
Speed not set
Air intake limits

More than one sample added

Errors

Warning

There is an insufficient supply of 50 pL tips.

There is an insufficient supply of 200 pL tips.

Too much liquid will be ejected into a well.

A well cannot contain sufficient liquid to supply the run.

A volume of less than 5 pL is programmed to be ejected into a dry well.

The run contains reaction elements that will contaminate sample wells.

The run requires a volume of less than1 pL to be pipetted.

The run is set up with multi-eject functionality which can lead to reduced precision.

The master mix extra volume is set to prepare a total extra volume that is lower than the extra volume
recommended to avoid shortages.

An instrument-prepared standard well has a volume that is too large for a 200 pL tip to mix effectively.

A speed parameter has not been set. Default settings will be used.
The maximum volume that can be pipetted is limited by the amount of preaspirated air.

Two or more different samples are added to a single reaction well.

Description

Not enough output wells

Too many standards

Invalid sample config
Operation impossible
Dilution out of range
Bad plate config
Reagent name

Non-unique tip type for volume

Volume calibration must be done before run

QlAgility Version 4.18 User Manual

06/2023

There are not enough output wells in the reaction plate.

The number of programmed standards exceeds the maximum number of standards. The software can
accommodate a maximum of 16 dilution series.

Sample banks are incorrectly configured.

A reaction in the “Reaction List” cannot be performed.

The sample and target concentration are set to values that are not achievable.
A plate configuration is not usable.

Problems with reagent naming in the “Optimisation Wizard” have occurred.
The correct tips for the required volume are not available.

Volume calibration must be done before a run can be started in these situations:
New installation of instrument
After pipettor service
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9.3.2 Instrument error codes

All instrument errors are associated with an error number. All error numbers start with 40000. If an instrument error occurs,
immediately save a support package and contact QIAGEN Technical Services. See Section 6.7.3 for details about how to save

a support package.

Instrument error errors
Code Error
1 FIFO over run error

3 Bad axis number used when an axis number is not supported by command.

5 Vacuum sensor cannot sense vacuum.

7 Tip sensor did not defect liquid.

9 Home switch could not be found within limit.

11 An error has occurred in SPI coms.

129 An invalid axis was specified.

131 The instrument did not respond with a second reply.

133 The micro firmware is mismatched.

135 An attempt was made to move an axis beyond its limit.

137 An incorrect checksum was encountered in a received packet.

139 The second reply was corrupt.

141 An incorrect number of replies was received.

143 A specified accessory port number does not exist.

145 An unknown accessory was detected.

147 A bad packet length was received.
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9.4  Self-diagnostic tools
These tests are designed to collect information to help with troubleshooting.
Note: These tests should only be performed by experienced users.

Warning: Before conducting self-diagnostic tests, remove all plates, loading blocks and the tip ejector from the worktable. Failure

to do this may result in permanent damage to the pipetting head.

1. Select Help > Self-diagnostic tools.

2. The “Robot Self Diagnostic Tools” dialog box will appear.

ERnhnt Self Diagnostic Tools
— Meszag

GoHome |

LI Clear Messages |

r Mechanical T Electrical T

Check Home-0pta Alignment Check Communications |

Check for Loss of Steps Liquid Sensor Test |

Cycle Fipettor Head Check Home- 0 pta Stability |

Hail Smoothness B ating

Check Home-Opto See Section 9.4.1 for more details.

Alignment

Check for Loss of See Section 9.4.1 for more defails.

Steps

Cycle Pipettor Head See Section 9.4.1 for more defails.

Check Commun- See Section 9.4.2 for more details.

ications

Liquid Sensor Test See Section 9.4.2 for more defails.

Close Closes the dialog box.

Go Home Homes all axes and resets the positional reference for the instrument for subsequent

movements including tip ejection.

Clear Messages Clears the content of the messages text box.
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9.4.1 Mechanical tests
Check Home-Opto Alignment

This test ensures that the optical homes in X-, Y- and possibly Z-axes in QlAgility instruments are 3, 4, and 5 steps away from

their L297 software home, respectively.

Check for loss of steps

This test establishes whether the instrument has reliable movement. The default iteration setting of 5 will take approximately 20-
25 minutes to complete. Reported loss of steps on the P-axis can be ignored. Reported loss of steps on the Z-axis of +/- 8 steps
is acceptable. If there are errors on the X- or Y-axis, save a support package and contact QIAGEN Technical Services. See
Section 6.7.3 for details about how to save a support package.

Cycle Pipettor Head

After calibration, or if the instrument has been unused for a long period of time, it is recommended to cycle the pipetting head.

This helps to distribute the grease evenly. An iteration of 400 is recommended.
9.4.2 Electrical tests
Check Communications

USB cable bridge communication between the computer and the main controller of the instrument. SPI bridges communication

between the main controller and slave controllers (i.e., accessories and axes controllers).

This test checks the integrity of both types of communications links in the system, exercising the channel to 4 internal axes and

any accessories (if connected).

During this test, a SPIERROR(#11) error message is generated if the SPI link is unstable, or a BADRXCHKSUM(#137) error
message appears if there is an unstable computer to instrument link. If no error message appears during the test, there is no
problem with the communications links.

Liquid Sensor Test

This test checks that the liquid sensor circuitry is functioning correctly, so that it only triggers when the conductive tip touches the

liquid.
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10 Technical Specifications

10.1 Environmental conditions

10.1.1 Operating conditions

Power 100-240 V AC, 50-60 Hz, 250 VA
Mains supply voltage fluctuations are not to exceed 10% of the nominal supply voltages.
Fuse F5A 250 V fuse
Overvoltage 1
category
Air femperature 15-30°C (59-86°F)
Relative humidity* 40-70%
Altitude* Up to 2000 m (6500 ft.)
Place of operation For indoor use only
Pollution level 2

10.1.2 Transportation conditions

Air temperature -25°C to 60°C (-13°F to 140°F) in manufacturer’s packaging
Relative humidity Max. 75% (noncondensing)

10.1.3 Storage conditions

Air temperature 15-30°C (59-86°F) in manufacturer’s packaging
Relative humidity Max. 75% (noncondensing)

* Conditions under which equipment is electrically safe to operate.
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10.2 Mechanical data and hardware features

Dimensions Width: 54 cm (21.3in.)
Depth: 63 cm (24.8 in.) without cables
72 cm (28.3 in.) with cables
Height: 45 cm (17.7 in.) lid closed
86 cm (33.9 in) lid open

Mass 41 kg (90.2 Ib.) standard configuration
Capacity Up to 96 samples per run
Software QlAgility Software is supplied with the QlAgility System. Default protocols are available for use with the

QlAgility Software and can be downloaded from www.giagen.com/goto/QlAgility.
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11 Glossary

Term Description

Diluent Diluent is used to dilute the master mix, dilute samples, and create standard dilution series. It is assumed to be PCR-grade water. A diluent
can only be assigned fo a single well segment. Only 1 diluent tube can be assigned in a run file.

Lid The instrument lid isolates the worktable, maintaining sample integrity, and acting as a safety mechanism.

Master mix A master mix is a pooled group of reagents that can be added to a reaction plate. Master mix is always added to a reaction first because
it normally constitutes the largest volume of the reaction.

Master Mix Block The Master Mix Block is intended to hold diluent and master mix on the instrument worktable.

Menu bar The menu bar contains 5 menus — “File”, “Control”, “Wizards”, “Options”, and “Help”. All software functions can be controlled from

Mode indicator

Normal mode

Power switch

Q Protocol

Reaction

Reagent

Reagent Block

Righthand pane

Run file

Tip

Tip chute

Tip Rack Holder
Tip disposal box
Toolbar

Sample

Software worktable

Standard
Virtual Mode

Worktable

these menus.
Indicates whether the instrument is operating in “Normal Mode” or “Virtual Mode”.

For “Normal Mode” operation the instrument must be switched on and connected fo the computer. In “Normal Mode” operation, run files
can be executed.

A button located at the back of the QIAgility. It allows the user to switch the QIAgility on and off.

Q Protocols are run files which have been developed by QIAGEN to directly facilitate specific PCR applications. Q Protocols are installed
in the “QProtocols” subfolder

A reaction is the destination for the samples, master mixes, and reagents. Reactions can be assigned to a sample bank — this enables a
reaction to be a component of a different reaction. A reaction that is a component of another reaction is an ‘Intermediate’ reaction.

A reagent can be combined with other reagents to make a master mix, or added individually to a reaction. Reagents are always
dispensed to reaction wells before samples.

The Reagent Block is intended to hold reagents and standards on the instrument worktable.

The righthand pane refers to the area at the right side of the software workspace. It provides access to options which relate to different
plate functions. When a run is in progress, a progress report is displayed in the righthand pane.

A run file defines the reaction setup.

Defines the function of a plate as a Tip Rack Holder. Tips in the Tip Rack Holder must be set to available or unavailable.

Used tips are ejected through the tip chute into a tip disposal box at the side of the instrument.

A Tip Rack Holder supports tips on the instrument worktable.

The tip disposal box collects used tips at the side of the instrument.

The toolbar consists of a series of icons, from which a range of software functions can be accessed.

A sample is always added to a reaction last. Samples must be assigned to a sample bank before they can be used in a reaction setup.

The software worktable visually simulates the instrument worktable. The 6 plate positions are labeled A1, A2, B1, B2, C1, and C2.
Positions for the Master Mix Block and Reagent Block are labeled M1 and R1. When a run is in progress, the location of the pipetting
head is highlighted on the software worktable.

A standard is a dilution series with known concentrations. Standards are treated like samples.

“Virtual Mode” enables run files to be developed and simulated, without actually performing the pipetting operations on the instrument.
This is particularly useful for checking new run files. In “Virtual Mode” all software functions are enabled.

The instrument worktable supports tips racks, plates/tubes, the Master Mix Block, and the Reagent Block.
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Appendix A

ABI 7000/7500 SDS master mix naming conventions
Absolute Quantification

For absolute quantification, the ABI software requires each reaction to be associated with a detector, reporter and quencher. To

achieve this, master mixes used in the exported reactions must be named in the QlAgility software according to the convention:

[2:]D_R_Q{:D_R_Q}

u.n

2 Indicates a string of characters, which excludes “:".

Is a separator.

D Is a placeholder for detector.

R Is a placeholder for reporter.

Q s a placeholder for quencher.

1 Indicates an optional component.
{} Indicates O or more items.

For example, “Mix C:EBV_FAM_TAMRA" specifies a mix with detector for EBV, using FAM reporter, and TAMRA quencher. The
“Mix C" portion of the name is unused by the SDS software.

The absolute quantification function exports a single file, “XXX.TXT”, where “XXX" is the filename.

Allelic Discrimination

For allelic discrimination, the ABI software requires each reaction to be associated with a marker, identifying a pair of
detector/reporter/quencher sets. To achieve this, master mixes used in the exported reactions must be named in the QlAgility
software according to the convention:

M:D_R_Q:D_R_Q

“M" is the marker name. All other items are the same as for “Absolute Quantification”.

For example, “Mix D:CMV_FAM_TAMRA:EBV_JOE_TAMRA" specifies a mix with detector for CMV using FAM reporter and
TAMRA quencher, and detector for EBV using JOE reporter and TAMRA quencher. “Mix D" represents the marker name in the

SDS software.

The allelic discrimination function exports 2 files, “XXX.TXT” and “XXXend.TXT” (for endpoint analysis), where “XXX" is the

filename.
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Note: The “Absolute Quantification” and “Allelic Discrimination” export modes ignore reactions where the master mix name
does not match the required format. In the resultant files, wells are only listed where their master mix contents are named, so that
they can match the required format.

Advanced settings

Advanced run settings are available to adjust specific applications on the QlAgility. These functions should be modified only
under direct instructions from QIAGEN.

Tip pickup mode

This defines the strategy used for collecting tips from the Tip Rack Holder. Normal (single stage) or Three Stage can be selected.
Normal (single stage) Instructs the instrument to collect tips using a single downward movement. This is the default setting.
Three Stage Instructs the instrument to collect tips in 3 separate downward movements:

1. The pipetting head is brought into the tip collar.
2. The pipetting head is gently pressed against the tip collar.
3. The pipetting head is forced against the tip collar.

Detect tip absence

When activated, a tick is visible. This function automatically detects when the instrument has failed to pick up a tip. This is caused
when a tip is absent from the pick-up position. A message is presented with options to ignore (and proceed as if the pickup
succeeded), retry (attempt to pickup at the same location), abort (terminate the run), or skip (to the next available tip position and
retry).

Automatically skip to next if detect tip absence

This function is disabled until “Detect tip absence” is enabled to be activated. When activated a tick is visible. This function

automatically skips to the next available tip position and retries the tip pickup if a tip pickup fails due to tip absence.
By default, this function is not activated.
Compensate for liquid loss

This function sets a depth in millimeters by which the tip should be further lowered into the wells below the determined (or

calculated) liquid surface position for pipetting operations. The default value is O.

This function is intended for applications which use liquids that evaporate rapidly. In addition, this function can be used to

address a variety of situations where the tip would otherwise be placed too high in the well for pipetting operations.
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Note: Using this function may increase the amount of liquid carried on the exterior of tips.
Allow volumes > tip capacity (special operations)

A tick is displayed when this function is activated. By default, all of the liquid handling functions available via the Special button,
presented in the “Reaction” righthand pane, work only with volumes up to the largest capacity tip supported on the QlAgility

(i.e., 200 pl). Activating this option allows those functions to work with volumes larger than 200 pL.
This function is activated by default.
Reactions are mixed by default

A tick is displayed when this function is activated. This function sets the default setting of the Mix on ejection? option displayed
in the Mix Settings section of the “Reaction Configuration” dialog box (displayed using the Add button of the Reaction right-hand
pane). When activated, the Mix on ejection? option is checked by default; when deactivated, this option is unchecked by default.

This function is activated by default.
Allow use of multiple reagent volumes

When activated a tick is visible. This function affects the options listed in the Target Wells section of the “Reaction Configuration”
dialog box shown when editing PCR setup liquid handling operations (displayed using the Add button of the “Reaction” right-

hand pane). When activated, the Preserve source well indices option is presented; when deactivated, this option is not presented.

The Preserve source well indices function changes the reaction well allocation strategy used by the software for the corresponding
liquid handling operation. Normally, this function is disabled and the software allocates reaction wells sequentially from the first
available well in the target plate not used by previous reaction setup operations in the run. When activated, the software attempts
to use the well index in the reaction plate corresponding to the well index of the sample in the source plate for the reaction made

using that sample.

The software applies special rules to allow reactions which “Preserve source well indices” and those which do not to coexist in
the same run. In short, for each reaction plate the software defermines the highest index reaction well required by a “Preserve
source well indices” liquid handling operation and treats the next well as the first available for all other reaction construction

operations which do not “Preserve source well indices” in that plate.

By default, this function is activated.
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Require extra volume in intermediate wells

When activated a tick is visible. By defining sample banks in reaction plates, it is possible to construct new reactions from others
previously constructed. The wells in such sample banks are considered to be intermediate reaction wells. By default, the software
does not account for dead volumes of the intermediate wells when checking for underflow conditions. In practice this can result
in shortages when aspirating from intermediate reaction wells. When this function is activated, the software will generate
warnings if aspirates from intermediate wells would cause the well volume to fall below its dead volume.

By default, this function is not activated.

Advance Z-axis whilst aspirating

When activated a tick is visible. This function modifies the aspirate operation to reduce contact between liquid and the exterior
of the tip. When activated, aspirates are performed by advancing the tip downwards into the well while aspirating, thereby
approximately tracking the liquid surface during the operation.

By default, this function is not activated.

Retract Z-axis whilst dispensing

When activated a tick is visible. This function modifies the eject operation to reduce contact between liquid and the exterior of
the tip. When activated, dispenses are performed by retracting the tip upwards from the well while ejecting, thereby
approximately tracking the liquid surface during the operation.

By default, this function is activated.

Detect insufficient volume on aspirate

When activated a tick is visible. When using the level sensor during aspirate operations, the software calculates the volume
present in the well based on the position of the liquid surface, and generates an error warning if the volume detected is less than
the volume to be aspirated. When activated, this function suppresses this warning, allowing the operation to proceed regardless.
By default, this function is activated.

Level sensor false trigger handling options (aspirate)

False triggering occurs when the level sensor spuriously reports that it has found the liquid surface when it hasn't actually reached
the liquid during its downward probe. The software considers all liquid surface levels found between the tube base and the top
of tube to be valid, and reports false triggering errors when the level found by the sensor is above the top of the tube. Such

conditions can occur when static electricity is present on the plasticware, as this may cause an apparent change in capacitance

similar to that caused when the tip makes contact with liquid. False triggering which occurs within the tube is undetectable.
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False triggering of the level sensor which occurs during aspirate operations usually causes insufficient volume to be aspirated

and hence a deficiency in volume transferred to the target well.

This function presents options to reduce the impact of false triggering caused by static electricity. Recommended settings cause
the pipettor to probe the surface at least twice looking for successive level detections which are within a small tolerance before
proceeding with the aspirate.

By default, recommended settings to multiprobe the surface are activated.

Level sensor false trigger handling options (eject)

False triggering of the level sensor which occurs during eject operations may cause insufficient volume to be delivered to the

target well.

This function presents options to reduce the impact of false triggering caused by static electricity. Recommended settings cause
the pipettor to probe the surface at least twice looking for successive level detections which are within a small tolerance before
proceeding with dispensing.

By default, recommended settings to multiprobe the surface are activated.

Use optimal height calibration where possible

As the mechanism used for automatic height calibration (Section 7.1.3) must account for several sources of measurement error,
the software implements a compensation factor to ensure that tips do not contact the tube/well base during normal operation.
As a consequence, the dead volumes for some tubes can be larger than is desirable.

This function activates an alternate height calibration mechanism which tries to optimize the calibrated tube/well height more
closely to the true internal base of the vessel. Details are described below. While this may reduce the wasted dead volume, it
also increases the risk that liquid may not be found during aspirate operations. Consequently, this function is offered only for
selected vessels.

By default, this function is not activated.

Optimal plate height calibration

This function is activated by the ‘use optimal height calibration where possible’ advanced setting.

Before starting the procedure:

® Ensure that 50 pl tips are available, that the Tip Rack Holder is calibrated, and that the correct tips are set as available.
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1. Select Options > Robot Setup > Calibrate plate height.
2. The “Configure Plate Heights” dialog box will appear.

Configure Plate Heights |

i~ Plates To Calibrate

plate | 200p! PCR tube & C1
Mix plate (5 tube positions] 5.0ml QIAGEN Qlagility tapered tube & M1 =
Mix plate [5 tube positions] 1.5ml tapered screw cap tube @ M1 =
[[] Reagent block [standard 200 flat tapered) 200p] PCR tube & A1
Fieagent block [standard 200 flat tapered] 2.0ml zelf standing screw cap tube @ R1
Reagent block [standard 200 flat tapered] 1.5ml tapered hinged tube @ R1 =

Select Al Cear &l |

~ Seftings
¥ Require confimation from user?

Take average of how many wells? I4 E

i~ Cantrol

Autodetect [checked items) | Cancel | tanual Setup [highlighted item|

Autodetect applies ta plates with ticked checkboxes. Manual setup applies ta the currently
highlighted plate.

MOTE: Plates marked with ** will uge Optimal Height Calibration

Plates to Calibrate Lists the plates that are currently located on the worktable.

Select Al Selects all of the plates in the “Plates to Calibrate” list.

Clear All Deselects all of the plates in the “Plates to Calibrate” list.

Require confirmation Instructs the software to present a message to the user affer automatic plate height

from user? calibration is performed. This enables the user to confirm the value to be recorded as the

auto-detected height.

Take average of how Defines the number of wells from which to take an average.

many wells2

Autodetect (checked Initiates the automatic plate height calibration operation. Automatic plate height calibration
items) is performed only for the selected plates.

Abort Aborts the current calibration activity.

Manual Setup Initiates the manual plate height calibration operation. Manual plate height calibration is
(highlighted items) performed only for the selected plate.

Ex Y

A note indicates that workspace segments marked with a symbol in the list of “Plates to Calibrate” are processed

using optimal height calibration.

3. Check the boxes next to the plates to be calibrated in the “Plates to Calibrate” list. Alternatively, click on the Select All

button to select all of the plates.
Note: Plates which have multiple segments (e.g., Reagent Blocks) are listed more than once, but with different tube types.

4. If user confirmation is required before saving the determined height calibration values, check the “Require user confirmation

from user2” box.
5. Set the number of wells to measure in the Take average of how many wells? box. By default, this value is 4.

6. Click on the Autodetect (checked items) button to initiate calibration.
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7. The “Optimal Height Autocalibration” form is presented. This displays a graphic of the first segment to be calibrated based
on the selected checkboxes. It also indicates the wells to be calibrated, according to the selected number of wells to

average. Ensure that empty tubes are present in the indicated well locations.

imal Height Autocalibraton

O ptimal Height Calibration

8. When ready, click the Start button to commence automatic height calibration. Where the segment contains vessels eligible
for optimal calibration, the system uses a tip to probe the base of the vessel, discards it, then uses a second tip to probe
again, cycling to tune the measured value. This process is repeated for each vessel to be measured. Where the segment is
not eligible for optimal height calibration, a single tip is used to probe the base of the vessel and the process proceeds as

described in Section 7.1.3, “Automatic plate height calibration”.
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9. If Require confirmation from user? was selected, the Status region of the form shows the measured values, the calculated
average, and the value determined as the height calibration. This value can be saved using the Save button, or the process
at step 8 can be performed again by selecting Retry. If Require confirmation from user? was not selected, the determined

height calibration value is automatically saved.

timal Height Autocalibraton

Optimal Height Calibration

Testing well 1: B35
Testing well 2 : B27
Testing well 3 : B27
Testing well 4 : B27

Test average : 629
binus optimal offzet : 4
Height to be set at : B25

Save these settings?

10. If more than one plate was selected in the “Plates to Calibrate” list, the instrument will calibrate each plate in turn. Repeat

steps 8 and 9 for each plate.

11. When all calibrations are complete, click the Close button.
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Description of the Generic XML Format

The XML file exported in Generic XML mode follows the schema defined in

The main structure is:

<Root>

<ReactionData>
<Socket>
<Name>C1</Name>
<PlatelD/>
<PlateType>Std96</PlateType>
<Size>96</Size>
<Wells>

QlAgility Version 4.18 User Manual

<Well>
<label>A1</Label>
<WelllD/>
<WellNo>1</WellNo>

...\Integration\xsd\GenericXMLFormat.xsd.

<StandardWellName>A:1</StandardWellName>

<Color>5775359</Color>
<TubeType>BioSprint_250</TubeType>
<Concentration>37</Concentration>
<FinalWellVol>80</FinalWellVol>
<EventOccurred>0</EventOccurred>

<Contents>

06/2023

<Diluent>
<SocketName>M1</SocketName>
<Welllabel>A</Welllabel>
<Vol>40</Vol>
</Diluent>
<Mix>
<SocketName>M1</SocketName>
<Welllabel>B</WellLabel>
<Vol>10</Vol>
<Name>Mix B</Name>
</Mix>
<Reagent>
<SocketName>R1</SocketName>
<Welllabel>l</WellLabel>
<Vol>2.5</Vol>
<Name> 10X Buffer</Name>
</Reagent>
<Sample>
<SocketName>C1</SocketName>
<PlatelD/>
<Welllabel>A1</Welllabel>
<Vol>20</Vol>
<Name/>
<SamplelD/>
<Concentration>0</Concentration>
</Sample>
<Reaction>
<SocketName>R1</SocketName>
<Welllabel>l</WellLabel>
<Vol>40</Vol>
<Concentration>74</Concentration>
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<ReactionlD/>
<SourceContent/>
</Reaction>
</Contents>
</Well>

For each reaction well a <well> tag is exported, that contains information of all contents of the well. The <reaction> tag contains

recursive information, if a reaction was added to the exported well (e.g. when using “Create sample banks from target wells”).

As the XML export can be used to export more than one plate, the <Socket> tag might be repeated for every exported plate
data.

It is possible to create XSL transformation files to transform this generic XML format to the format you might need for your lab
environment. This XS| file should be stored in the folder ...\integration\xsl. It can then be selected by the user during the XML

export dialog.
To make the user’s selection for empty wells and sample labels evaluable, two parameters are passed to the XSL transformation:

e SamplelabelType Possible values:
SL_FulllD =0
SL_SamplelD =1
SL_ReactionID = 2
SL_SampleName = 3

e EmptylabelType Possible values:
EL Empty =0
EL_WelllD = 1
EL_WellOrder = 2
EL_WellNumber = 3

They can be evaluated during the transformation.
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Packing the QlAgility

WARNING/ | Risk of personal injury and material damage
CAUTION The QlAgility is too heavy to be lifted by one person. To avoid personal injury or damage to the

’: instrument, do not lift the instrument alone.

If you need to transport the QlAgility, package the instrument as follows:

1. Open the hood and remove all plates and tips from the worktable.

. Shut down the QlAgility Software and switch off the QIAgility, as outlined in Section 6.9.
. I installed, disconnect the UV lamp and HEPA filter from the instrument.

. Reinstall the transport locks, see Section 4.5.

. Disconnect the USB cable from the instrument to the computer and remove the AC power cord.

[0 NG, BN NS S

. Place the QlAgility into the packaging in which it was originally shipped.
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Appendix B

Declaration of Conformity

Name and address of the company

QIAGEN GmbH
QIAGEN Strasse 1
40724 Hilden
Germany

An up-to-date Declaration of Conformity can be requested from QIAGEN Technical Support.
Waste Electrical and Electronic Equipment (WEEE)
This section provides information about disposal of waste electrical and electronic equipment by users.

The crossed-out wheeled bin symbol (see below) indicates that this product must not be disposed of with other waste; it must be

taken to an approved treatment facility or to a designated collection point for recycling, according to local laws and regulations.

The separate collection and recycling of waste electronic equipment at the time of disposal helps to conserve natural resources

and ensures that the product is recycled in a manner that protects human health and the environment.

Recycling can be provided by QIAGEN upon request at additional cost. In the European Union, in accordance with the specific
WEEE recycling requirements and where a replacement product is being supplied by QIAGEN, free recycling of its WEEE-

marked electronic equipment is provided.
To recycle electronic equipment, contact your local QIAGEN sales office for the required return form. Once the form is submitted,

you will be contacted by QIAGEN either to request follow-up information for scheduling collection of the electronic waste or to

provide you with an individual quote.
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FCC declaration

The ""United States Federal Communications Commission’’ (USFCC) (in 47 CRF 15. 105) declared that the users of this product

must be informed of the following facts and circumstances.
"This device complies with part 15 of the FCC:

Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must

accept any inferference received, including interference that may cause undesired operation.”
“This Class A digital apparatus complies with Canadian ICES-0003."

The following statement applies to the products covered in this manual, unless otherwise specified herein. The statement for other

products will appear in the accompanying documentation.

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation
of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the

interference at his own expense.

QIAGEN GmbH Germany is not responsible for any radio television interference caused by unauthorized modifications of this
equipment or the substitution or attachment of connection cables and equipment other than those specified by QIAGEN GmbH,
Germany. The correction of interference caused by such unauthorized modification, substitution or attachment will be the

responsibility of the user.
Liability clause

QIAGEN shall be released from all obligations under its warranty in the event repairs or modifications are made by persons
other than its own personnel, except in cases where the Company has given its written consent to perform such repairs or

modifications.

All materials replaced under this warranty will be warranted only for the duration of the original warranty period, and in no case
beyond the original expiration date of original warranty unless authorized in writing by an officer of the Company. Read-out
devices, interfacing devices and associated software will be warranted only for the period offered by the original manufacturer
of these products. Representations and warranties made by any person, including representatives of QIAGEN, which are
inconsistent or in conflict with the conditions in this warranty shall not be binding upon the Company unless produced in writing
and approved by an officer of QIAGEN.
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Appendix C — Ordering Information

Product

Contents

Cat. no.

QlAgility HEPA/UV (w/o PC) System*

QlAgility System HEPA/UV (incl. PC)*

50 pL Conductive Filtered Tips

200 pL Conductive Filtered Tips

5 ml Tube; Graduated, Flat-Base

Tip Disposal Box

Tip Disposal Box Holder

QIAcuity® Nanoplate Adapter

Adapter, 96 x 0.2 mL PCR Tubes

Adapter, Generic 384-Well Plate

Adapter, Flip-Cap 32 x 1.5 mlL Tapered-
Base
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Robotic workstation for automated PCR setup (with
UV light and HEPA filter); comes with QlAgility
software; includes installation, application training,
and 1 year warranty on labor, travel, and parts.
Does not include a laptop.

Robotic workstation for automated PCR setup (with
UV light and HEPA filter); comes with notebook
computer and QlAgility software; includes installation
and application training. One year warranty on
labor, travel, and parts.

Carbon-impregnated conductive tips (960 tips) for
use with liquid-level sensing; tips contain high-set

filters; for use with Tip Rack Holder (cat. no.
9018949)

Carbon-impregnated conductive tips (960 tips) for
use with liquid-level sensing; tips contain high-set
filters; for use with Tip Rack Holder (cat. no.
9018949)

Bag of 50; suitable for holding diluent and master
mix on the instrument worktable; graduated, flatbase
design with a tapered internal profile for minimum
dead volume; screw cap included

Box of 10; plastic waste collection box with secure-
fitting lid to fit tip ejector chute

Holds the tip disposal box in place and ensures
correct positioning under the tip chute

For holding 1x QlAcuity Nanoplate; for use with the
QlAgility to automate nanoplate set up before digital
PCR reaction on the QlAcuity Digital PCR System

For holding 96 x 0.2 mL PCR tubes
For use with generic 384-well plate

For holding 32 x 1.5 mL Tapered-Base Tubes; caps
held vertically to enable access by the instrument;
can be used in combination with the Flip-Cap Tube
Liffer 32 x 1.5mL Tapered (cat. no. 9018950)

9001908

9001532

990512

990522

990552

990550

9243592

9027242

9018919

9019491
9018927
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Flip-Cap Tube Lifter 32 x 1.5 mL
Tapered

Adapter, 72 x 0.1 mL Strip Tubes

Adapter, Light Cycler 480 96-Well Plate

Adapter, 24 x 5 mL Flat-Base Tubes

Adapter, 33 x 1.8 mL Screwtop Flat-
Base Cryo Vials

Adapter, 33 x 1.5 ml, Tapered-Base
Tubes
Adapter, 36 x 0.2 mL PCR Tubes

Adapter, 36 x 0.5 mL PCR Tubes

Adapter, 48 x 0.5 ml Tubes

Cooling Block, Housing

Cooling Block, Insert

Reagent Block, 16 x 0.2 mL/1.5 mlL
Tapered-Base Tubes

Reagent Block, 24 x 1.5 mL Tapered-
Base Tubes

Master Mix Block, 1 x5 mL/4 x 1.5 mL
Tubes

Reagent Block, 16 x 0.2 mL/2 mL Flat-
Base Tubes

QlAgility Version 4.18 User Manual  06/2023

For quick and easy removal and resealing of tubes

from an Adapter, Flip-Cap 32 x 1.5 mL Tapered-Base

(cat. no. 9018927)

For holding 72 x 0.1 mL Strip Tubes; tubes will fill a
72-Well Rotor (cat. no. 9018903

For use with the Roche® LightCycler® 480; 96-well

plate; wells hold 10-100 pL; plate has an orientation

pin and a “front” indicator
For holding 24 x 5 mL Flat-Base Tubes

For holding 33 x 1.8 mL Nalgene or Corning
Cryogenic Vials

For holding 33 x 1.5 mL Tapered-Base Tubes

For holding 36 x 0.2 mL PCR tubes; tubes will fill a
36-Well Rotor (cat. no. 9018907)

For holding 36 x 0.5 mL PCR Tubes; tubes are offset
to make space for caps

For holding 48 x 0.5 mL Tubes

Cooling Block; Housing for use in combination with

Cooling Block Insert (cat. no. 9020284)

Cooling Block; for cooling SBS plates; add water to
cooling block and allow to freeze; fits in housing
(cat. no. 9020285)

Reagent Block; intended to hold reagents and
standards on the instrument worktable; holds

16 x 0.2 mL PCR tubes and 16 x 1.5 mL Tapered-
Base Tubes

Reagent Block; intended to hold reagents and
standards on the instrument worktable; holds
24 x 1.5 ml Tapered-Base Tubes

Master Mix Block; intended to hold diluent and
master mix on the instrument worktable; holds

1 x 5 mL FlatBase Tube and 4 x 1.5 mL Tapered-
Base Tubes

Reagent Block; intended to hold reagents and
standards on the instrument worktable; holds
16 x 0.2 mL PCR tubes and 16 x 2 mL Flat-Base
Tubes

9018950

9018917

9018937

9018934

9018929

9018925

9018918

9018920

9018921
9020285

9020284

9018952

9018955

9018958

9018953
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Master Mix Block, 1 x 5 mL/4 x 2 mL Master Mix Block; intended to hold diluent and 9020130
Tubes master mix on the instrument worktable; holds
1 x 5 mL FlatBase Tube and 4 x 2 ml FlatBase
Tubes
Reagent Block, 24 x 2 mL Flat-Base Reagent Block; intended to hold reagents and 9018956
Tubes standards on the instrument worktable; holds
24 x 2 ml Flat-Base Tubes
Master Mix Block, 5 x 5 mL Tubes Master Mix Block; intended to hold diluent and 9018959
master mix on the instrument worktable; holds
5 x 5 mlL FlatBase Tubes
Reagent Block, 16 x 0.2 mL/2 mL Reagent Block; intended to hold reagents and 9018951
Flat/1.5 mL Tapered Tubes standards on the instrument worktable; holds
16 x 200 pL PCR tubes, 8 x 2 mlL Flat-Base Tubes,
and 8 x 1.5 mL Tapered-Base Tubes
Reagent Block, 8 x 1.5 mL/2 mL Reagent Block; intended to hold reagents and 9019499
Flat/1.5 mL Tapered Tubes standards on the instrument worktable; holds
8 x 1.5 ml Tapered-Base Tubes, 8 x 2 mL FlatBase
Tubes, and 8 x 1.5 mL Tapered-Base Tubes
Reagent Block, 17 x 5 mL Flat-Base Reagent Block; intended to hold reagents and 9018957
Tubes standards on the instrument worktable; holds
17 x 5 mL Flat-Base Tubes
Loading Block, Rotor-Disc 100 Easylift Aluminium block for manual and automated reaction 9020287
setup in Rotor-Disc 100 discs. The block covers
2 standard SBS positions in a vertical orientation on
the QlAgility instrument worktable; ejection of the
Rotor-Disc 100 is made convenient by using the
Easylift ejector (cat. no. 9020286)
Loading Block, Rotor-Disc 100 Easylift Ejector to be used in combination with Loading 9020286
Ejector Block, Rotor-Disc 100 Easylift (cat. no. 9020287)
Rotor-Disc 72 Loading Block Aluminium block for manual and automated reaction 9018910
setup in Rotor-Disc 72 discs
Tip Rack Holder for 96-Tip Rack Aluminum frame for disposable Tip Racks; includes 9018949
spring-loaded locators for accurate alignment on the
instrument worktable
HEPA filter Replacement cartridge (one filter) 9019486

* Additional instrument and Service bundles are available.

For up-to-date licensing and product-specific disclaimers, see the respective QIAGEN kit handbook or user manual. QIAGEN kit
handbooks and user manuals are available at www.qiagen.com or can be requested from QIAGEN Technical Services or your

local distributor.
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Appendix D — Consignes de sécurité

Avant d'utiliser le QlAgility, il est impératif de lire attentivement ce manuel et de porter une attention particuliére aux consignes

de sécurité. Afin de garantir un fonctionnement de |'appareil en toute sécurité et de maintenir I'appareil en bon état de marche,

il est impératif de suivre les instructions et consignes de sécurité fournies dans le présent manuel d'utilisation.

Les types d'informations de sécurité suivants sont fournis tout au long du manuel.

AVERTISSEMENT | Le terme AVERTISSEMENT signale des situations risquant d’entrainer des accidents corporels dont
I'utilisateur, ou d’autres personnes, pourraient étre victime.
A Les détails concernant ces circonstances sont donnés dans un encadré identique & celuici.
ATTENTION Le terme ATTENTION signale des situations risquant d’entrainer des détériorations de I'appareil ou de
tout autre matériel.
A Les détails concernant ces circonstances sont donnés dans un encadré identique & celui-ci.

Les conseils donnés dans ce manuel ont pour but de venir compléter les exigences de sécurité habituelles en vigueur dans le

pays de |'utilisateur et non de s’y substituer.

Utilisation appropriée

AVERTISSEMENT
/ATTENTION

VAN

Risque d’accident corporel et de détérioration du matériel
L'utilisation inappropriée du QIAgility peut entrainer des accidents corporels ou une détérioration de
I'appareil.

L'utilisation du QlAgility est exclusivement réservée au personnel qualifié ayant été convenablement
formé.

La maintenance du QlAgility doit uniquement étre effectuée par des spécialistes du Service Aprés-Vente

QIAGEN.

VAN

AVERTISSEMENT | Risque de surchauffe
/ATTENTION | Afin de garantir une bonne ventilation, laisser un dégagement d’au moins 10 cm sur les cotés et &
I'arriere du QlAgility. Les fentes et les ouvertures qui assurent la ventilation de I'appareil ne doivent pas
A étre obstruées.
AVERTISSEMENT | Risque d’accident corporel et de détérioration du matériel
/ATTENTION | Ne pas essayer de déplacer le QlAgility pendant qu'il est en marche.
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AVERTISSEMENT

>

Atmosphére explosive
Le QlAgility nest pas congu pour étre utilisé dans une atmosphére explosive.

AVERTISSEMENT

>

Risque d’explosion

Lle QlAgility a été congu pour I'utilisation des réactifs et substances fournis par les kits QIAGEN.
L'utilisation de réactifs et de substances autres que celles indiquées peut entrainer un risque d’incendie
ou d’explosion.

ATTENTION

>

Détérioration de |'appareil

La lumiére directe du soleil peut décolorer les piéces de I'appareil et abimer les éléments en plastique.

Tenir le QlAgility & I'abri de la lumiére directe du soleil.

ATTENTION

>

Détérioration de I'appareil
Eviter de renverser de I'eau ou des produits chimiques sur le QlAgility. La détérioration de I'appareil
di au déversement de liquides annule la garantie.

AVERTISSEMENT

>

Risque d’accident corporel

Pendant les étapes de calibration des positions, le bras robotisé se déplace alors que le capot de
I'appareil est relevé. Ne jamais actionner ou cliquer sur aucunes touches tant que des parties du corps
se trouvent dans I'enceinte de |'appareil.

En cas d'urgence, éteindre le QlAgility a I'aide de I'interrupteur d’alimentation situé & I'arriére de I'appareil et débrancher le

cordon d'alimentation de la prise de courant.

Sécurité électrique

Avant |'entretien, débrancher le cordon d'alimentation de la prise de courant.

AVERTISSEMENT

I\

Danger électrique

Toute interruption du conducteur de protfection (conducteur de terre/de masse) & I'intérieur ou &
I'extérieur de I'appareil ou toute déconnexion de la borne du conducteur de protection est susceptible
de rendre |'appareil dangereux.

Toute interruption intentionnelle est interdite.
Tensions mortelles & I'intérieur de I'appareil

Lorsque I'appareil est relié & I'alimentation, les bornes peuvent étre sous tension et |'ouverture des capots
de l'instrument ou le retrait de piéces risque d’exposer des éléments sous fension.

AVERTISSEMENT

VAN

Danger d'irradiation UV
Un dispositif électronique de verrouillage empéche la lampe UV de fonctionner tant que le capot de
I'appareil est ouvert. Ce dispositif ne doit en aucun cas étre désactivé.
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Afin que le QlAgility fonctionne de maniére satisfaisante et en toute sécurité, suivre les conseils suivants :

® le cordon d'alimentation de |"appareil doit étre branché sur une prise d'alimentation munie d’un conducteur de protection
(terre/masse).

e Ne pas régler ni remplacer les piéces internes a |'instrument.
Ne pas faire fonctionner I'appareil si des capots ou des piéces ont été retirés.

® En cas de déversement de liquides & I'intérieur de I'appareil, débrancher celui<i de la prise d’alimentation et contacter les
Services techniques de QIAGEN.

e Sil'appareil présente un danger électrique, empécher le reste du personnel de s’en servir et contacter les Services

Techniques de QIAGEN. L'appareil peut présenter un danger électrique dans les cas suivants:

O Le cordon d’alimentation présente des signes de détérioration.
O L'appareil a été stocké pendant une longue période dans des conditions non conformes & celles énoncées dans
partie 10.

O L'appareil a subi des chocs sévéres durant le transport.
Sécurité biologique

Les spécimens et les réactifs contenant des matiéres provenant d'étres humains doivent étre considérés comme potentiellement
infectieux. Utilisez des procédures de laboratoire sires comme décrit dans des publications telles que Biosafety in Microbiological

and Biomedical Laboratories, HHS (www.cdc.gov/biosafety/publications).

Echantillons

Les échantillons peuvent contenir des agents infectieux. Vous devez connaitre le risque que de tels agents représentent pour la

santé et devez utiliser, stocker et éliminer ces échantillons conformément aux régles de sécurité nécessaires.

AVERTISSEMENT | Echantillons contenant des agents infectieux
l Certains échantillons utilisés avec cet appareil peuvent contenir des agents infectieux. Manipulez ces

échantillons avec la plus grande précaution et conformément aux régles de sécurité nécessaires.

Portez toujours des lunettes de protection, deux paires de gants et une blouse de laboratoire. La
personne responsable (par exemple, le directeur du laboratoire) doit prendre les précautions
nécessaires afin de garantir que I'environnement de travail est sir, que les opérateurs de |"appareil sont
convenablement formés et ne sont pas exposés & des niveaux dangereux d’agents infectieux comme
cela est défini dans les fiches techniques santé-sécurité (FDS) ou dans les documents de 'OSHA*, de
I’ACGIHT ou du COSHH* applicables.

L'évacuation des vapeurs et I'élimination des déchets doivent s’effectuer conformément & toutes les régles
et lois nationales, régionales et locales relatives & la santé et & la sécurité.

* OSHA : Occupational Safety and Health Administration (Etats-Unis d’Amérique) (Administration pour la santé et la sécurité du travail).

t ACGIH : American Conference of Government Industrial Hygienists (Etats-Unis d’Amérique) (Conférence américaine des hygiénistes industriels
gouvernementaux).

# COSHH : Control of Substances Hazardous to Health (Royaume-Uni) (Contréle des substances dangereuses pour la santé).
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Produits chimiques

AVERTISSEMENT | Produits chimiques dangereux
Certains produits chimiques utilisés avec cet appareil peuvent étre dangereux ou le devenir aprés
A I'exécution du cycle du protocole.

Toujours porter des lunettes de protection, des gants et une blouse de laboratoire.

La personne responsable (par exemple, le directeur du laboratoire) doit prendre les précautions
nécessaires afin de garantir que le lieu de travail environnant est sir et que les opérateurs de I'appareil
ne sont pas exposés & des niveaux dangereux de substances (chimiques ou biologiques) toxiques
comme cela est défini dans les fiches de données de sécurité (FDS) ou dans les documents de I'OSHA*,
de I'ACGIHT ou du COSHH* applicables.

L'évacuation des vapeurs et la mise au rebut des déchets doivent s’effectuer conformément & toutes les
réglementations et lois nationales, régionales et locales relatives & la santé et & la sécurité.

* OSHA : Occupational Safety and Health Administration (Etats-Unis d’Amérique] (Administration pour la santé et la sécurité du travail).

t ACGIH : American Conference of Government Industrial Hygienists (Etats-Unis d’Amérique) (Conférence américaine des hygiénistes industriels
gouvernementaux).

# COSHH : Control of Substances Hazardous to Health (Royaume-Uni) (Contréle des substances dangereuses pour la santé).

Vapeurs foxiques

Si vous travaillez avec des solvants volatils ou des substances toxiques, vous devez disposer d'un systéme de ventilation de

laboratoire efficace afin d’évacuer les vapeurs qui peuvent étre générées.
Elimination des déchets

Le matériel en plastique usagé peut contenir des produits chimiques dangereux. Ces déchets doivent étre convenablement

collectés et éliminés conformément aux réglementations locales de sécurité.
Pour plus d'informations sur la mise au rebut du QlAgility, voir Section 10.

Dangers mécaniques

AVERTISSEMENT | Piéces mobiles
Eviter le contact avec les pieces en mouvement lorsque le QlAgility est en fonctionnement. Ne jamais
A placer les mains sous le bras robotisé lorsque celuici s'abaisse. Ne pas tenter de déplacer des plaques
ou des tubes lorsque le bras robotisé est en marche.

ATTENTION Détérioration de I'appareil
C N'appliquer aucune force manuelle sur le bras en Y (c'est-a-dire la téte de pipetage).

En cas de déplacement manuel accidentel du bras en Y, il est fortement recommandé de redémarrer le
systeme.
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Afin que le QlAgility fonctionne de maniére satisfaisante et en toute sécurité, suivre les conseils suivants:

Utiliser uniquement les tips et les supports de tips recommandés.
Dans la mesure du possible, maintenir le capot de I'appareil fermé.

Ne pas désactiver le dispositif de verrouillage du capot.

Lors de la calibration des plaques capot ouvertes, toujours se tenir & |'écart de |'appareil au moment des réglages. Le
dispositif de verrouillage est désactivé en mode de calibration. Par conséquent, ne pas cliquer avec la souris ni appuyer sur
une des touches du clavier lors de I'observation de I'inspection visuelle de la calibration des plaques. Attendre I'arrét
complet du bras robotisé pour déplacer une plaque ou un tube.

® Ne rien poser sur le bras robotisé.

Avant de retirer des plaques ou des tubes de la table de travail, sélectionner « Pause » dans la barre d’outils du logiciel
QlAgility pour metire I'appareil en mode de pause. Attendre I'arrét complet du bras robotisé. Cela peut prendre jusqu’a
10s.

Sécurité relative a la maintenance

Procéder & la maintenance comme décrit & la Section 8. QIAGEN facture les réparations rendues nécessaires suite a une

maintenance inadaptée.

AVERTISSEMENT | Risque d’accident corporel et de détérioration du matériel

Effectuer uniquement la maintenance spécifiquement décrite dans ce manuel.

>

AVERTISSEMENT | Risque de décharge électrique
Ne pas ouvrir les panneaux du QlAgility.

>

Risque d’accident corporel et de détérioration du matériel

Effectuer uniquement la maintenance spécifiquement décrite dans ce manuel.

ATTENTION Détérioration de I'appareil
Ne pas utiliser de solvants ni de réactifs contenant des acides, des bases ou des composés abrasifs
pour nettoyer le QlAgility.

>

ATTENTION Détérioration du capot du QlAgility
Ne pas utiliser de solvants ni de réactifs contenant des acides, des bases ou des composés abrasifs

>

pour nettoyer le capot de I'appareil. L'alcool peut endommager le capot. Employer uniquement de I'eau
distillée.

ATTENTION Détérioration des panneaux latéraux du QlAgility
Ne jamais netftoyer les panneaux latéraux de I'appareil & I'alcool ou avec une solution & base d'alcool.

>
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Symboles sur le QlAgility

Symbole

Emplacement

Description

Table de travail et prés de la plaque signalétique

Symbole de mise en garde

Table de travail et prés de la sortie pour I'éjection des

cones

Symbole de danger biologique

Table de travail

Symbole de risque d'écrasement

Plaque signalétique & I'arriére de I'appareil

Marquage CE pour la conformité européenne

Plaque signalétique & I'arriére de I'appareil

Marquage UKCA pour la conformité UK

Plaque signalétique & I'arriére de I'appareil

Label CSA pour le Canada et les Etats-Unis

Plaque signalétique & I'arriére de I'appareil

Fabricant légal

Plaque signalétique & I'arriére de I'appareil

Symbole DEEE

Plaque signalétique & I'arriére de I'appareil

Llabel FCC de la Federal Communications

Commission des Etats-Unis

Plaque signalétique & I'arriére de I'appareil

Marquage RCM (antérieurement marquage C-
Tick) pour I'Australie (identifiant du fournisseur
N17965)

Plaque signalétique & |'arriére de I'appareil

Label RoHS pour la Chine (restriction de
I'utilisation de certaines substances dangereuses

dans I'équipement électrique et électronique)

Plaque signalétique & I'arriére de I'appareil

Lire le manuel d'utilisation.
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Appendix E - Sicherheitshinweise

Llesen Sie dieses Handbuch sorgfdltig durch, bevor Sie den QIlAgility benutzen. Beachten Sie dabei insbesondere die

Sicherheitshinweise. Die Gebrauchsanweisungen und Sicherheitshinweise im Handbuch missen befolgt werden, um einen

sicheren Betrieb des Gerats zu gewdhrleisten und das Gerdt in einem sicheren Zustand zu erhalten.

In diesem Handbuch werden die folgenden Kategorien von Sicherheitshinweisen verwendet:

WARNUNG Der Begriff ,WARNUNG” (“WARNING”) weist Sie auf Situationen hin, in denen eine
Verletzungsgefahr fir Sie selbst oder andere Personen besteht.
A Nahere Einzelheiten iiber diese Situationen werden in einem Textfeld wie diesem beschrieben.
ACHTUNG Der Begriff ,ACHTUNG" (“CAUTION") weist Sie auf Situationen hin, in denen das Gerét oder andere
Gerdte beschadigt werden kdnnten.
A Ndhere Einzelheiten iiber diese Situationen werden in einem Textfeld wie diesem beschrieben.

Die in diesem Handbuch enthaltenen Hinweise stellen eine Ergénzung und keinen Ersatz der iblichen Sicherheitsanforderungen

dar, die im jeweiligen Land gelten.

Sachgemafie Handhabung

WARNUNG/
ACHTUNG

A\

Verletzungsgefahr und Beschadigung des Gerdts
Die unsachgeméfBe Bedienung des QlAgility kann zu einer Verletzung des Benutzers oder zur
Beschadigung des Gerdits fihren.

Der QlAgility darf nur durch qualifiziertes Personal, das entsprechend geschult wurde, bedient werden.

Die Instandhaltung des QlAgility darf nur durch einen AuBendienst-Mitarbeiter des QIAGEN Service
durch-gefihrt werden.

A\

WARNUNG/ | Uberhitzungsgefahr
ACHTUNG Vergewissern Sie sich, dass zwischen Wand und QIAgility (Rickseite und Seitenteile) ein
Mindestabstand von 10 cm eingehalten wird. Das gewdhrleistet eine ausreichende Beliftung des
A Gerdtes. Die Liftungsschlitze und Offnungen, die fir die Be- und Entliftung des QlAgility bestimmt sind,
dirfen nicht zugedeckt werden.
WARNUNG/ | Verletzungsgefahr und Beschadigung des Gerdts
ACHTUNG Der QlAgility ist zu schwer, um von einer einzelnen Person gehoben zu werden. Zur Vermeidung einer

Verletzung oder Beschadigung des Gerdtes heben sie das Gerdt nicht alleine an.
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WARNUNG/ | Verletzungsgefahr und Beschédigung des Gerdts
ACHTUNG Der QlAgility darf auf keinen Fall wahrend des Betriebs fortbewegt werden.

>

WARNUNG/ | Explosionsfiahige Atmosphéren
ACHTUNG Der QlAgility ist nicht fir den Gebrauch in explosionsfdhigen Atmosphéren vorgesehen.

>

WARNUNG/ | Explosionsgefahr
ACHTUNG Der QlAgility ist ausschlieBlich mit Reagenzien und Substanzen aus den QIAGEN Kits zu benutzen. Die
Benutzung von anderen Reagenzien oder Substanzen kann Feuer oder eine Explosion auslésen.

>

ACHTUNG Gerdteschaden
Direktes Sonnenlicht kann zum Ausbleichen von Gerdte-teilen fihren und Schéden an Kunststoffteilen
verursachen.

>

Der QlAgility darf nicht direkter Sonneneinstrahlung ausgeliefert werden.

ACHTUNG Beschadigung des Gerats

Vermeiden Sie es, Wasser oder Chemikalien auf der Oberflache des QIAgility zu verschitten. Durch
verschittete Chemikalien oder verschittetes Wasser verursachte Gerdateschaden sind nicht durch die
Garantie abgedeckt.

>

WARNUNG Verletzungsgefahr
Bei der Kalibrierung der Positionen bewegt sich der Roboterarm bei gedffneter Gerdtehaube. Klicken
Sie nicht auf die Maus und driicken Sie nicht auf eine Taste der Tastatur, wahrend sich Ihre Hénde oder

>

andere Kérperteile im Arbeitsbereich des Roboterarms befinden.

Schalten Sie im Notfall den QIAgility aus (der Netzschalter befindet sich auf der Gerdteriickseite), und ziehen Sie den Netzstecker

aus der Steckdose.
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Elektrische Sicherheit

Ziehen Sie das Netzanschlusskabel aus der Steckdose, bevor Sie Wartungsarbeiten am Gerét vornehmen.

WARNUNG | Gefahr durch Stromschlag
Jede Unterbrechung des Schutzleiters (Erdungs- bzw. Masseleiter) im Gerdt oder auBerhalb des Gerdats
A und jede Abtrennung des Schutzleiters am Anschluss der Netzleitung erhdht die Gefahr eines
Stromschlags.

Eine absichtliche Unterbrechung der Schutzleiter-verbindung ist verboten.

Gefdhrliche Spannung im Gerét

Wenn das Gerdt an die Stromversorgung angeschlossen ist, sind die Anschlussstellen
spannungsfihrend. Durch das Offnen der Abdeckungen oder das Entfernen von Gehduseteilen kénnen
spannungsfihrende Komponenten freigelegt werden.

WARNUNG | Gefahr durch UV-Strahlung
Ein elektronisch gesteuerter Sensor zeigt an, dass die Geratehaube geschlossen sein muss, bevor die
A UV-Llampe eingeschaltet werden kann. Der Hauben Sensor darf unter keinen Umstanden ausser Kraft
gesetzt werden.

Um einen zufriedenstellenden und sicheren Betrieb des QlAgility zu gewdhrleisten, befolgenden Sie bitte die nachstehenden

Richtlinien:

® Das Netzkabel muss an eine Wechselstrom-Steckdose mit Schutzleiter (Erdungs-/Masseleiter) angeschlossen werden.

e Nehmen Sie im Gerdteinneren keine Einstellungen an Teilen vor und wechseln Sie keine Teile aus.

e Nehmen Sie das Gerdt nicht in Betrieb, wenn Abdeckungen oder Teile entfernt worden sind.

e Falls Flussigkeit auf dem Gerdt verschittet wird und in das Gerét luft, dann schalten Sie es sofort aus, trennen Sie es von

der Netzspannung (Stecker ziehen!) und setzen Sie sich mit dem Technischen Service von QIAGEN in Verbindung.
e Falls die elekirische Sicherheit bei der Bedienung des Gerdéts nicht mehr gewdhrleistet werden kann, muss das Gerdt gegen
unbefugte oder unabsichtliche Benutzung gesichert werden. Kontaktieren Sie anschlieBend den Technischen Service von

QIAGEN. Die elekirische Sicherheit des Gerats ist nicht mehr gegeben, wenn:

O das Netzkabel beschadigt ist;
O das Gerét léngere Zeit unter ungiinstigen Bedingungen, d. h. unter anderen Bedingungen als in Anhang A angegeben,
gelagert wurde;

O das Gerét unsachgemaf transportiert worden ist.

Biologische Sicherheit
Bei Substanzen und Reagenzien, die humanes Untfersuchungsmaterial enthalten, sollte immer von einer mdglichen

Infektionsgefahr ausgegangen werden. Wenden Sie nur sichere Laborverfahren an, wie sie z. B. in Verdffentlichungen wie

Biosafety in Microbiological and Biomedical laboratories (HHS, www.cdc.gov/biosafety/publications) beschrieben werden.
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Proben

Proben kdnnen infektidse Erreger enthalten. Sie sollten sich der Gesundheitsgefahr bewusst sein, die von diesen Erregern ausgeht,

und derartige Proben gemdf3 den erforderlichen Sicherheitsbestimmungen handhaben, lagern und entsorgen.

WARNUNG Proben, die infektiose Erreger enthalten
Einige Proben, die mithilfe dieses Gerdts verarbeitet werden, kénnen infektidse Erreger enthalten. Gehen
Sie beim Umgang mit diesen Proben mit der gréBtméglichen Vorsicht und gemdf den erforderlichen
Sicherheitsbestimmungen vor.

Tragen Sie immer eine Schutzbrille, zwei Paar Laborhand-schuhe und einen Laborkittel.

Die verantwortliche Person (z. B. der Laborleiter) muss alle erforderlichen VorsichtsmaBBnahmen treffen,
um sicher-zustellen, dass die unmittelbare Umgebung des Arbeits-platzes sicher ist und die Bediener des
Gerdats ausreichend geschult sind. AufBerdem dirfen die Grenzwerte in Bezug auf infekticse Erreger,
die in den entsprechenden Sicherheitsdatenbléttern (SDS) oder den Vorschriften der OSHA,* ACGIH?
oder COSHH? festgelegt sind, nicht Gberschritten werden.

Beim Betrieb des Abzugs und bei der Entsorgung von Abfallstoffen missen alle Bestimmungen und
Gesetze zu Gesundheitsschutz und Sicherheit am Arbeitsplatz auf Gbernationaler, nationaler und
regionaler Ebene eingehalten werden.

* OSHA: Occupational Safety and Health Administration (Vereinigte Staaten von Amerika)
t ACGIH: American Conference of Government Industrial Hygienists (Vereinigte Staaten von Amerika)
# COSHH: Control of Substances Hazardous to Health (Vereinigtes Kénigreich)

Chemikalien

WARNUNG Gefdhrliche Chemikalien

Einige Chemikalien, die mit diesem Gerat verwendet werden, kdnnen gefdhrlich sein oder nach
A Beendigung eines Protokolllaufs gefahrlich werden.

Tragen Sie immer eine Schutzbrille, Laborhandschuhe und einen Laborkittel.

Die verantwortliche Person (z. B. der Laborleiter) muss alle erforderlichen VorsichtsmaBnahmen treffen,
um sicher-zustellen, dass die unmittelbare Umgebung des Arbeits-platzes sicher ist. Auch diirfen die
Grenzwerte in Bezug auf infektidse Erreger, die in den entsprechenden Sicherheits-datenblattern (SDS)
oder den Vorschriften der OSHA*, ACGIHT oder COSHH? festgelegt sind, nicht Gberschritten werden.

Beim Betrieb des Abzugs und bei der Entsorgung von Abfallstoffen missen alle Bestimmungen und
Gesetze zu Gesundheitsschutz und Sicherheit am Arbeitsplatz auf Gbernationaler, nationaler und
regionaler Ebene eingehalten werden.

* OSHA: Occupational Safety and Health Administration (Vereinigte Staaten von Amerika)
t ACGIH: American Conference of Government Industrial Hygienists (Vereinigte Staaten von Amerika)
# COSHH: Control of Substances Hazardous to Health (Vereinigtes Kénigreich)

Giftige Dampfe

Alle Arbeiten mit flichtigen Losungsmitteln oder toxischen Substanzen missen unter einem funktionierenden Laborabzugssystem

durchgefihrt werden, damit die méglicherweise entstehenden Démpfe abziehen kénnen.
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Abfallentsorgung

Benutzte Kunststoff-Laborartikel kénnen gefdhrliche Chemikalien enthalten. Derartige Abfélle missen gemaf3 den geltenden

regionalen Sicherheitsbestimmungen gesammelt und entsorgt werden.

Beachten Sie bei der Entsorgung des QlAgility die gesetzlichen Bestimmungen zur Entsorgung von Elekiro- und Elekironik-

Altgerdten (siehe Section 10).

Gefahren durch mechanische Teile

WARNUNG | Sich bewegende Gerateteile
Vermeiden Sie jeglichen Kontakt mit sich bewegenden Gerateteilen, wahrend der QlAgility in Betrieb
A ist. Auf gar keinen Fall dirfen sich lhre Hande unter dem Roboterarm befinden, wenn dieser
herunterfahrt. Versuchen Sie nicht, Reaktionsgeféfie oder Platten zu entnehmen oder zu bewegen,
wdhrend der Roboterarm arbeitet.

ACHTUNG Beschédigung des Gertits
2 Bewegen Sie den Y-Arm (den Pipettierkopf) nicht von Hand.

Wir empfehlen dringend, einen Neustart des Systems durchzufihren, falls der Y Arm versehentlich von
Hand bewegt wurde.

Um einen zufriedenstellenden und sicheren Betrieb des QlAgility zu gewdhrleisten, befolgen Sie bitte die nachstehenden

Richtlinien:

e Verwenden Sie nur die empfohlenen Pipettenspitzen und -Racks.

e Halten Sie die Gerdtehaube méglichst immer geschlossen.

e Deaktivieren Sie nicht die Verriegelung der Geratehaube.

® Wenn bei gedffneter Geréatehaube die Plattenpositionen kalibriert werden, achten Sie darauf, dass Sie nicht in den

Arbeitsbereich des Roboterarms kommen, wenn Sie Justierungen vornehmen. Im Kalibrier-Modus ist die Verriegelung der
Gerdtehaube deaktiviert. Achten Sie deshalb darauf, nicht mit der Maus zu klicken oder eine der Bedienungstasten auf der
Tastatur zu driicken, wenn Sie die Kalibrierungen der Plattenpositionen Gberpriffen. Warten Sie, bis die Bewegungsabléufe
des Roboterarms beendet sind, bevor Sie ReaktionsgefcfBe oder Platten entnehmen oder bewegen.
Stellen Sie keine Gegenstande auf den Roboterarm.

e Wabhlen Sie die Option “Pause” in der Werkzeugleiste der QIAgility Software, um das Gerét anzuhalten, bevor Sie
Reaktionsgefdfie oder Platten von der Arbeitsplatiform entfernen. Warten Sie, bis der Roboterarm die gerade ablaufende

Bewegung beendet hat — dies kann bis zu 10 Sekunden dauvern.

Sicherheitshinweise — Wartungsarbeiten

Fihren Sie alle Wartungsarbeiten gem&f den Anweisungen in Abschnitt 8 durch. QIAGEN stellt alle Reparaturen in Rechnung, die

nachweislich auf eine inkorrekte Wartung zuriickzufishren sind.
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WARNUNG

>

Verletzungsgefahr und Beschédigung des Geréits
Fihren Sie nur Wartungsarbeiten durch, die ausdriicklich in diesem Handbuch beschrieben werden.

WARNUNG

>

Gefahr durch Stromschlag
Offnen Sie keine Gehduseteile des QlAgility.

Verletzungsgefahr und Beschédigung des Geréits

Fihren Sie nur Wartungsarbeiten durch, die ausdricklich in dieser Gebrauchsanweisung beschrieben

sind.

ACHTUNG

>

Beschadigung des Gerats
Verwenden Sie weder Lésungsmittel noch Reagenzien, die Sduren, Laugen oder Abrasivstoffe enthalten,
um das QlAgility zu reinigen.

ACHTUNG

>

Beschadigung der QlAgility Gerétehaube

Verwenden Sie weder Alkohol noch Lésungsmittel oder Reagenzien, die S&uren, Laugen oder
Abrasivstoffe enthalten, um die QlAgility Haube zu reinigen. Alkohol schadigt die Gerdtehaube.
Verwenden Sie zum Reinigen der Gerdtehaube ausschlieBlich destilliertes Wasser.

ACHTUNG

>

Beschédigung der QlAgility Seitenwdnde
Reinigung sie niemals die Geratehaube und Seitenwdnde mit Alkohol oder alkoholhaltigen Lésungen.

ACHTUNG

>

Beschddigung des Plattentransfer-Gestells

Das Plattentransfer-Gestell darf auf keinen Fall autoklaviert werden.
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Symbole auf dem QlAgility

Symbol

Ort

Beschreibung

Arbeitsplattform und néhe Typenschild

Symbol ,Achtung”

Auf der Arbeitsplattform und néhe ,Tip chute” Ausgang

Symbol ,Biogefdhrdung”

Arbeitsplattform

Symbol ,Quetschgefahr”

Typenschild auf der Gerdteriickseite

CE-Kennzeichnung der EU-Konformitat

Typenschild auf der Gerdteriickseite

UKCA-Kennzeichnung der UK-Konformitét

Typenschild auf der Gerdteriickseite

Symbol der CSA-Zertifizierung in Kanada
und den USA

Typenschild auf der Gerateriickseite

Hersteller i. S. d. Gesetzes

Typenschild auf der Gerdteriickseite

WEEE-Kennzeichnung (gemaB
europdischer Richtlinien bzw. Elektro- und

Elekironik-Altgerate-Verordnung)

Typenschild auf der Gerdteriickseite

FCC-Kennzeichen der Federal
Communications Commission der

Vereinigten Staaten

Typenschild auf der Gerdteriickseite

RCM-Zeichen (ehemals C-Tick) fir Australien
(Anbieterkennzeichnung N17965)

Typenschild auf der Gerdteriickseite

Markierung gemdf3 RoHSRichtlinie fir
China (Beschrénkung der Verwendung
bestimmter gefdhrlicher Stoffe in Elektro-

und Elektronikgeraten)
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Document Revision History

Revision Description

June 2023 Included the UKCA symbol. Removed the environmental class.
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Trademarks: QIAGEN®, Sample fo Insights®, QlAcuity®, QIAgility®, QlAxcel®, QlAxtractor®, Rotor-Gene®, ScreenGel® (QIAGEN Group); Adobe®, Acrobat® (Adobe Systems Inc.); Carbon-Cap™, Polycap™ (GE Healthcare);
DECON-QUAT® (Veltek Associates Inc.); DNA-Exitus Plus™ (AppliChem GmbH); Excel®, Microsoft®, Windows®, Word® (Microsoft Corporation); Gigasept®, Mikrozid®, Lysetol® (Schiilke & Mayr GmbH); LightCycler®, Roche®
(Roche Group); MagNA Pure®, Roche® (Hoffman-La Roche, Inc.); Teflon® (E.I. du Pont de Nemours and Company).

Copyright Information

The QlAgility software uses an XSLT template for scientific number to decimal conversion provided by Ludek Vodicka under MIT license.

Copyright © 2010 Ludek Vodicka

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject fo the following conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE
AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

June-2023 HB-2798-003 © 2023 QIAGEN, all rights reserved
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